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1 Welcome
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The Living Image® software controls optical image acquisition on IVIS® Imaging 
Systems, and provides tools for optimizing image display and analyzing images.

1.1 What’s New In Living Image 4.2 Software

The following table provides a brief description of new or improved features in the Living 
Image software.

New or Improved Features See Page
Image Acquisition and Analysis

Living Image® acquisition and analysis sofware supports Windows® 7 operating system

Batch mode for sequence acquisition 39

Expanded selection of fluorescent probes in the Imaging Wizard, including: BoneProbe680, 
Integrin750, RJ-2-DG-750

Faster DLIT and FLIT algorithm speed. Dynamic voxel display during the DLIT or FLIT 
reconstruction process shows voxel size refinement during analysis.

Working With Images

Image Labels improvements:

�• Edit comments directly on image/sequence in the Info section

�• New toolbar button  for quick access to the Image Label dialog box for editing image 
labels

�• New Options/Labels menu allows flexible selection of labels for display

94

95

95

Add comments to images 95

Export well plate quantification results 190

View a 3D representation of intensity signals 106

ROI Tools

Apply measurement ROIs to all images in the Sequence View window 120

ROI tag includes the auto ROI threshold % 121

Sort auto ROI numbers 121, 125

Select multiple ROIs and move them together 126

DLIT or FLIT 3D Reconstructions

Longitudinal Study Browser quantitatively compare DLIT and/or FLIT analysis results 213

Voxel color scale with �“transparent�” as the minimum (or maximum in a reverse color table) 224

Measure voxels which have been copied from one surface and pasted to another using the 
3D Source tools. Enables you to view all voxels (�“original�” and pasted) using one color scale.

221

Working With Volumetric Data

Dedicated 3D Volumetric data browser with preview and playback capabilities. Enables 
loading of volumetric data without first loading an optical data set.

241

Save registration information for a particular volumetric and optical data set 246

Save a color-opacity map that can be applied to volumetric data 253
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1.2  About This Manual

This user manual explains how to acquire optical image data on an IVIS® Imaging System 
and analyze images using the Living Image® software. The manual provides detailed 
instructions and screenshots that depict the system response. 

NOTE
Sometimes the screenshots in the manual may not exactly match those displayed on your 
screen.

For more details on your IVIS Imaging System, please see the appropriate system manual.

Conventions Used In the Manual

Convention Example
Menu commands are bolded. To open image data, select File → Open Dataset on the 

main bar.

Toolbar button names are bolded. To open image data, click the Open Dataset button .

Numbered steps explain how to carry 
out a procedure.

1. To start the Living Image software, click the  icon on 
the desktop.

Document names are italicized. Living Image Software User’s Guide

Note information NOTE
A note presents pertinent details on a topic.

or 

Note: Notes may also appear in this format.

Caution information CAUTION!
CAUTION!  A caution note warns you that your 
actions may have nonreversible consequences or 
may cause loss of data.

Important information IMPORTANT!
ALERT!  Important information advises you of 
actions that are essential to the correct performance 
of the instrument or software.
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Living Image Help

There are several ways to obtain help on the software features:

�• To view a tooltip about a button function, put the mouse cursor over the button.

�• To view a brief description about an item in the user interface, click the  toolbar 
button, then click the item.

�• Press F1 or select Help → User Guide on the menu bar to display the Living Image 
Software User�’s Manual (.pdf).

1.3 Contacting Caliper Technical Support

If you need technical support, please contact Caliper at:

Telephone: 1.877.522.2447 Toll Free in the United States

1.508.435.9761 

E-mail: tech.support@caliperLS.com

Fax: 1.508.435.0950

Address: Caliper Life Sciences

68 Elm Street

Hopkinton, MA 01748

USA
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2 Overview of Imaging & Image Analysis

Workflow Overview   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 5
Imaging Modes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 7
About Image Sequences .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 10
Image Display & Analysis  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 11

This chapter provides a brief overview of imaging and image analysis. Images acquired 
on an IVIS® Imaging System are called optical data.

2.1 Workflow Overview

The Living Image® software provides image acquisition, viewing, and analysis functions 
for IVIS Imaging Systems. Figure 2.1 shows the steps to acquire an image. Figure 2.2 
shows an example sequence acquisition workflow.

Figure 2.1  Steps to acquire a luminescent or fluorescent image

! Start the Living Image software 
 and initialize the IVIS Imaging 

System.

" In the control panel:

�• Select the imaging modes (for example, 
luminescent and photograph)

�• Set the imaging parameters 

�• When you are ready to acquire the 
images, click Acquire

# The image window and Tool Palette 
appear when acquisition is finished.

$ Enter image label information (optional).
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Figure 2.2  Steps to acquire an image sequence

! Start the Living Image software  
and initialize the IVIS® Imaging System

" Click Imaging Wizard in the control panel.

$ In the Imaging Wizard, double-click Bioluminescence  or Fluorescence  and step 
through the wizard.

# In the control panel, click Acquire Sequence.

% Enter image label information (optional).

& The image window opens and 
displays the images as they 
are acquired. The Tool Palette 
is displayed.

Imaging WizardIVIS Acquisition Control Panel



Chapter 2 | Overview of Imaging & Image Analysis  7 

2.2  Imaging Modes

Table 2.1 shows the imaging modes that are available on IVIS® Imaging Systems. Table 
2.2 shows examples of the different types of images (optical data). 

You can acquire:

�• Single images, for example, a luminescent image and a photograph. After 
acquisition, the Living Image software automatically coregisters images to generate 
an overlay image.

�• An image sequence - a collection of images that are grouped together in a single 
folder (Figure 2.3).

NOTE
For details on your IVIS Imaging System, please see the imaging system hardware manual.

Table 2.1  IVIS Imaging Systems & imaging modes

Imaging Mode IVIS Imaging System
Lumina II Lumina XR 100 Series 200 Series Spectrum Kinetic

 Photograph

 Luminescent

 Fluorescent

 Structure

 X-ray

 Kinetics

Figure 2.3  Example image sequence (overlay images: luminescent image on photograph
Double-click an image in the Sequence View to open it in a separate window.
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Table 2.2  Image types (optical data) 

Imaging Mode Description Example

 Photograph A short exposure of the subject illuminated by 
the lights located in the ceiling of the imaging 
chamber. The photographic image is displayed 
as a grayscale image.

 Luminescent A longer exposure of the subject taken in 
darkness to capture low level luminescence 
emission. The luminescent image is displayed in 
pseudocolor that represents intensity. For more 
details on luminescent image data, see Appendix 
D, page 279.

Luminescent image

Overlay: Luminescent 
image on photograph

 Fluorescent An exposure of the subject illuminated by 
filtered light. The target fluorophore emission is 
captured and focused on the CCD camera. 
Fluorescent image data can be displayed in units 
of counts or photons (absolute, calibrated), or in 
terms of efficiency (calibrated, normalized). For 
more details on fluorescence image data, see 
Appendix F, page 291

Fluorescent image

Overlay: Fluorescent 
image on photograph



Chapter 2 | Overview of Imaging & Image Analysis  9 

 Structure A structured light image of parallel laser scanned 
across the subject. The surface topography of 
the subject is determined from the structured 
light image.

 X-ray An exposure of the subject using the X-ray 
energy source on the Lumina XR. The X-ray 
image is displayed as a grayscale image.

X-ray image

Overlay: Fluorescent 
image on X-ray image

Kinetic A series of images captured on the IVIS Kinetic 
Imaging System that enables visualization of 
luminescent or fluorescent signals in real time.

Play back kinetic data in 
real time or view a 
particular frame(s)

Table 2.2  Image types (optical data)  (continued)  

Imaging Mode Description Example
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2.3 About Image Sequences

A sequence is a collection of images that are grouped together in a single folder. A 
sequence may include images that are acquired during the same session and are intended 
to be grouped together. For example, images taken at different time points or an image 
sequence for DLIT or FLIT 3-D tomographic analysis.

Images that were acquired during different sessions can also be grouped together to form 
a sequence (for more details, see page 117). For example, a time series could be 
constructed from images acquired on different days following an experimental treatment. 

Some types of analyses are performed on an image sequence (see Table 2.3). The 
sequence requirements (number and type of images) depend on the type of analysis. 

Table 2.4 shows the types of analyses that are possible on the different IVIS® Imaging 
Systems. 

*Optional, requires premium filters

Table 2.3  Analyses that require an image sequence

Analysis Description Page
Planar spectral image Computes the total flux and average depth of a luminescent source 

below the surface.
10

Display multiple fluorescent or 
luminescent reporters

Uses the Image Overlay function to display multiple luminescent or 
fluorescent images on one photographic image.

110

Subtract tissue autofluorescence 
using blue-shifted background filters

Uses the image math feature to subtract a background image from 
the primary image.

151

Spectral unmixing Removes tissue autofluorescence from a fluorescence image. 165

DLIT Reconstructs the brightness and 3D location of luminescent 
sources.

193

FLIT Reconstructs the brightness and 3D location of fluorescent 
sources.

201

Table 2.4  IVIS® Imaging System capabilities 

Acquire a Sequence for... IVIS Imaging System
Lumina Lumina XR 100 Series 200 Series Spectrum Kinetic

Planar spectral image analysis optional* optional* optional* yes yes optional*

Displaying multiple fluorescent or 
luminescent reporters

yes yes yes yes yes yes

Subtracting tissue autofluorescence 
using blue-shifted background filters

yes yes yes yes yes yes

Spectral unmixing optional* optional* optional* yes yes optional*

DLIT Analysis �– 3D reconstruction of 
bioluminescent sources

no no no yes yes no

FLIT Analysis �– 3D reconstruction of 
fluorescent sources

no no no no yes no
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2.4  Image Display & Analysis

Most of the tools for adjusting image display and analyzing images are located in the Tool 
Palette. The Tool Palette automatically appears when acquisition is finished or when you 
open (load) image data. Its contents depend on the type of active image data. Figure 2.4 
shows the tools that are available for an image or a kinetic sequence. Figure 2.5 shows the 
Tool Palette for an example image sequence.

Figure 2.4  Tools available for a single image (luminescent, fluorescent, X-ray) or a kinetic sequence

Click a section of the Tool Palette 
to show or hide the tools.

Image Adjust Tools
(page 97)

�• Tune the photograph 
brightness, gamma 
(similar to contrast), 
or opacity

�• Set the image display 
color scale minimum 
and maximum

�• Select a color table 
for image display

Corrections/Filtering Tools 
(page 99)

�• Subtract dark background 
from the image data

�• Apply flat field correction 
to the image data

�• Specify pixel binning

�• Smooth the pixel signal

Image Information Tools
(page 101)

�• Display x,y coordinates 
and intensity data at a 
user-selected location 
on the image

�• Display a histogram of 
image pixel intensities

�• Plot the intensity (y-axis) 
at each pixel (x-axis) 
along a user-specified 
line in the image

�• 3D plot of intensity 
signals

�• Measure distance in an 
image

ROI Tools 
(page 119)

�• Measure counts or photons
in a user-specified region of
interest (ROI) and compute
measurement statistics (for
example, average, min, 
max, standard deviation)

�• Measure efficiency, radiant
efficiency, or NTF 
efficiency in the ROI and 
compute measurement 
statistics (for fluorescent 
images only)

 Overlay image Kinetic sequence
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NOTE
The 3D Multi-Modality tools require a separate license.

Figure 2.5  Tool palette for an example luminescent image sequence 

Planar Spectral 
Imaging 

(page 157)

Determines the 
average depth and 
total photon flux of a 
luminescent point 
source in a user-
specified region of 
interest. Analyzes a 
sequence of 
luminescent images 
acquired using 
different emission 
filters.

 Surface Topography
(page 181)

Analyzes structured 
light images to 
reconstruct the animal 
surface. A surface is 
required for 3D 
reconstruction of 
luminescent or 
fluorescent sources 
inside a subject

DLIT 
Reconstruction

(page 193)

A 3-dimensional 
reconstruction of the 
subject that estimates 
the depth and intensity 
of a luminescent light-
emitting source. 

FLIT 3D 
Reconstruction

(page 201)

A 3-dimensional 
reconstruction of the 
subject that estimates 
the location and 
intensity of a 
fluorescent light-
emitting source. 

Spectral Unmixing
(page 165)

Extracts the signal 
of one or more 
fluorophores from 
the tissue 
autofluorescence. 
Distinguishes the 
spectral signatures 
of different 
fluorescent or 
luminescent 
reporters when 
more than one 
reporter is used in 
the same animal 
model. 

Image sequence (luminescent or fluorescent)

Analyses Requiring an Image Sequence

Image Adjust Tools
(page 88)

�• Tune the photograph 
brightness, gamma (similar 
to contrast), or opacity

�• Set the image display color 
scale minimum and 
maximum

�• Select a color table for 
image display

ROI Tools 
(page 119)

�• Measure counts or photons 
in a user-specified region of 
interest (ROI) and compute 
measurement statistics (for 
example, average, min, max, 
standard deviation)

�• Measure efficiency in the 
ROI and compute 
measurement statistics (for 
fluorescent images only)

 Tool Palette for an Image Sequence
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Additional tools are available in the menu bar after data are loaded.

Figure 2.6  Tools accessible from the menu bar

Tool Description See 
Page

3D Animation Tools for creating an animation from an image sequence. For example, 
an animation can depict a rotating 3D scene. The animation can be 
recorded to a movie file (.mov, .mp4, or .avi)

231

Longitudinal 
Study

Enables you to view multiple DLIT and/or FLIT reconstruction results 
side-by-side; provides a convenient way to compare longitudinal study 
results. Voxel intensity within the entire surface or a user-selected area 
can be measured in all results.

213

Well Plate 
Quantification

Analyzes images of known serial dilutions of luminescent cells or 
fluorescent dye molecules and generates a quantification database. 
The software uses the quantification database to determine the 
number of cells in a DLIT source or the number of cells or dye 
molecules in a FLIT source.

185

Image Overlay Displays multiple luminescent or fluorescent images on one 
photograph.

110

Colorize Renders luminescence or fluorescence data in color, enabling you to 
see both intensity and spectral information in a single view. The tool 
provides a useful way to visualize multiple probes or scale probe 
signals that are not in the visible range.

113

Transillumination 
Overview for 
<name>_SEQ

Available for FLIT image sequence. Generates an overview image for 
each filter pair that includes the data from all of the transillumination 
locations. The overview image can be analyzed using the tools in the 
Tool Palette.

109

Image Math A method for mathematically combining two images (add, subtract, 
multiply, or divide). Use image math to remove autofluorescence from 
a fluorescent image.

151
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This chapter explains how to start the Living Image® software and initialize the IVIS® Imaging 
System. After it is initialized, the imaging system is ready to acquire images.

3.1 Starting the Living Image Software

The Living Image software on the PC workstation that controls the IVIS Imaging System 
includes both the acquisition and analysis features. The Living Image software on other 
workstations includes only the analysis features. For information on installing the software, see 
the Installation Guide included on the Living Image CD ROM. By default, the software is 
installed at:

PC (32-bit windows): C:Program Files:Caliper Life Sciences: Living Image

PC (64-bit windows): C:Program Files (x86):Caliper Life Sciences: Living Image

Macintosh: Applications:Caliper Life Sciences: Living Image

NOTE
All components of the IVIS® Imaging System should be left on at all times due to the long 
cooling time required to reach operating (demand) temperature. It is also important to leave 
the system on to enable automatic overnight electronic background measurements. 
Periodically rebooting the computer is permissible and does not affect the camera operation.

To start the software:
1. PC Users: Click the Windows Start button  and select All Programs → Caliper Life 

Sciences → Living Image. Alternatively, click the Living Image software icon  on the 
desktop.

Macintosh Users: Click the Living Image icon  on the desktop or run the software from 
the application folder.

�— The main window appears (Figure 3.1).
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2. Select a user ID from the drop-down list or enter a new User ID (up to three letters), and click 
OK.

�— The control panel appears if the workstation controls the IVIS® Imaging System (Figure 
3.2). For more details on the control panel, see Appendix A, page 259.

Figure 3.1  Living Image® main window

Figure 3.2  Living Image main window and IVIS Acquisition Control Panel

Menu bar (for more details, see Appendix J, page 327)

Toolbar 

Activity 
window

Control panel
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NOTE
The Living Image software on the PC workstation that controls the IVIS Imaging System includes 
both the acquisition and analysis features. The Living Image software on other workstations includes 
only the analysis features. Macintosh users have access to the analysis features only.

3.2 Initializing the IVIS Imaging System

The imaging system must be initialized each time the Living Image® software is started, or if the 
power has been cycled to the imaging chamber or the camera controller (a component of some 
IVIS® Imaging Systems). The initialization procedure moves every motor-driven component in 
the system (for example, stage and lens) to a home position, resets all electronics and controllers, 
and restores all software variables to the default settings. Initialization may be useful in error 
situations. For further details on instrument operation, see your IVIS Imaging System hardware 
manual.

To initialize the IVIS Imaging System:
3. Start the Living Image software (double-click the  icon on the desktop).

4. In the control panel that appears, click Initialize.

�— You will hear the motors move.

NOTE
The control panel is only available on the workstation that controls the imaging system. The 
items available in the control panel depend on the particular IVIS Imaging System and the 
imaging mode selected (luminescent or fluorescent, Image Setup or Sequence Setup mode).

Figure 3.3  IVIS® Acquisition Control Panel
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3.3  Checking the System Temperature

The IVIS acquisition control panel indicates the temperature status of the charge coupled device 
(CCD) camera (Figure 3.4). After the system is initialized, the temperature box turns green 
when the temperature is locked at the demand temperature (-90 °C or -105 °C for IVIS Systems 
cooled by a Cryotiger® unit), indicating the instrument is ready for operation and image 
acquisition.

The demand temperature for the CCD camera is fixed. Electronic feedback control maintains the 
CCD camera temperature to within a few degrees of the demand temperature. The default 
temperature of the stage in the imaging chamber is 37 °C, but may be set to a temperature from 
20-40 °C.

NOTE
The items in the control panel depend on the particular IVIS Imaging System and the imaging 
mode selected (luminescent or fluorescent, Image Setup or Sequence Setup mode). For 
more details on the control panel, see Appendix A, page 259.

The IVIS Imaging System is ready for imaging after the system is initialized and the operating 
(demand) temperature of the CCD camera is reached (locked). 

Figure 3.4  IVIS® Acquisition Control Panel, IVIS Lumina XR

Temperature box color indicates:

System not initialized

System is initialized, but CCD camera temperature is 
out of range and not ready for imaging

System is initialized and CCD camera is at or within 
acceptable range of the demand temperature and 
locked. The system is ready for imaging.

Click the temperature box to 
view the demand and 
measured temperatures of 
the CCD camera and stage
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3.4  About the IVIS Acquisition Control Panel & Auto Exposure Feature

The control panel (Figure 3.5) provides the image acquisition functions. For details on the 
imaging parameters in the control panel, see Appendix A, page 259.

The auto exposure setting is useful in situations where the signal strength is unknown or varies 
widely, for example during a time course study. If auto exposure is chosen (Figure 3.5), the 
system acquires an image at maximum sensitivity, then calculates the required settings to 
achieve, as closely as possible, an image with a user-specified target max count. If the resulting 
image has too little signal or saturated pixels, the software adjusts the parameters and takes 
another image.

In most cases, the default auto exposure settings provide a good luminescent or fluorescent 
image. However, you can modify the auto exposure preferences to meet your needs. For more 
details, see page 269.

NOTE
The options available in the control panel depend on the selected imaging mode, the imaging 
system, and the installed filter wheel or lens option.

3.5 Tracking System and User Activity

Activity Window

The Activity window shows the imaging system activities. The software creates and saves a log 
of the system activities related to data acquisition, for example, the type and number of acquired 
images, fluorescent lamp usage, X-ray tube accumulated usage, and kinetic camera usage. This 
information may be useful for Caliper field service engineers to understand the imaging system 
behavior over time or for troubleshooting. The activity log is located at C:\Program Files\Caliper 
Life Sciences\Living Image.

Figure 3.5  IVIS Acquisition Control Panel

To acquire an image using auto exposure, 
click the  arrow and select Auto.

Luminescence 
imaging settings

Fluorescence 
imaging settings

Photographic 
imaging settings

Structured light 
imaging settings

X-ray imaging 
settings
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The software tracks user time on the system (hr/min/sec per user ID) from logon until switching 
users or system shut down. The software creates a separate record for each month (for example, 
LI_USAGE_<MONTH>_2009.csv) located at C:Program Files\Caliper Life Sciences\Living 
Image\Usage). 

Software Help

There are several ways to obtain help on the software features:

�• To view a tooltip about a button function, put the mouse cursor over the button.

�• To view a brief description about an item in the user interface, click the  toolbar button, 
then click the item.

Press F1 or select Help → User Guide on the menu bar to display the Living Image Software 
User�’s Manual (.pdf).

Figure 3.6  Activity window

Activity window
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Optical imaging measures the light emitted by bioluminescent or fluorescent light-
producing reporters such as luciferase or fluorescent proteins. 

The IVIS® Imaging System is ready to acquire optical images after the system temperature 
is initialized and the CCD camera reaches operating (demand) temperature (the system is 
then locked). This chapter explains how to acquire optical image data�—a bioluminescent 
or fluorescent image or an image sequence. 

4.1 Bioluminescent Optical Imaging

This section explains how to acquire a single bioluminescent optical image. For 
information on acquiring an image sequence, see Acquire a Sequence Using the Imaging 
Wizard, page 33.

NOTE
Before setting the imaging parameters, the IVIS® Imaging System should be intialized and 
the temperature locked. For more details, see Chapter 3, page 15.

1. In the control panel, put a check mark next to Luminescent and select Auto exposure 
(click the  arrow).

When you select Auto exposure, the software automatically determines the binning 
and F/Stop settings. Alternatively, you can manually set the exposure, binning, and F/
Stop. For more details on these control panel settings, see page 259.

Figure 4.1  Acquisition Control Panel
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2. Put a check mark next to Photograph and select Auto exposure (click the  arrow). 

3. Make a selection from the Field of View drop-down list. For more details on the field 
of view, see page 261.

4. Set the proper Focus by choosing one of the methods below.

The focal distance to the camera is set at stage z = 0 for each field of view. To focus 
at the top of the animal, the stage will move down so that the top of the animal is at z 
= 0. You can either enter the height of the animal using the �“use subject height�” option 
or let the software determine the animal height by choosing the�“scan mid range�” 
option.

�• Select use subject height and use the  arrows or the keyboard arrows to specify 
a subject height (cm). 

�• Select manual focus. For more details on manual focusing see page 264.

�• Select scan mid range (available on the IVIS 200 or Spectrum Imaging System 
only). The imaging system determines the subject height using a laser scan. This 
value is automatically entered in the subject height box and is used to set the focal 
length.

5. To acquire an overlay image (coregistered images) for display after acquisition, put a 
check mark next to Overlay.

NOTE
To view the subject(s) inside the chamber before image acquisition, take a photograph. 
Uncheck the Luminescent option, choose the Photograph and Auto options, and click 
Acquire.

6. Click Acquire when you are ready to capture the image.

NOTE
If necessary, click  in the control panel to operate in single image mode.In single 
image mode, the  button appears in the control panel. Click this button to set up 
sequence acquisition. (For details on sequence setup, see page 33.)
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7. In the Edit Image Labels box that appears (Figure 4.2), enter information about the 
image and click OK.

NOTE
You can enter image label information at any time during or after acquisition. If you do not 
want to enter image information, click Cancel.

8. If this is the first image of the session, you are prompted to enable the autosave 
function.

9. To enable autosave, click Yes in the prompt and choose a folder in the dialog box that 
appears.

If autosave is enabled, all images acquired during the session are automatically saved 
to the user-selected folder. You can choose a different folder at any time (select 
Acquisition → Auto-Save on the menu bar).

Image acquisition proceeds. During acquisition, the control panel Acquire button 
becomes a Stop button. To cancel the acquisition, click Stop in the control panel. The 
image window appears when acquisition is completed (Figure 4.4).

Figure 4.2  Enter image label information (optional)

Figure 4.3  Autosave prompt

Information entered here 
appears in the image label

Image label
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Figure 4.4  Overlay (luminescent image on photograph) in the image window

Table 4.1  Image window 

Item Description
Units Select the measurement units for the image display from this drop-down list. The 

available units depend on the type of image data. For more details on 
measurement units, see page 281.

Display A list of image types available for display, for example, overlay. For more details 
on the different types of image displays, see Table 2.2, page 8.

Note: If the acquisition included more than two imaging modes (for example, 
luminescent, x-ray, and photograph), additional drop-down lists appear so you can 
conveniently choose any two images to overlay. 

Info Click to display or hide the image label. The image label includes information you 
enter in the Edit Image Labels dialog box (Figure 4.2) and other image information 
automatically recorded by the software.

Opens a dialog box that enables you to export the active view as a graphic file.

Tool palette

Image label

Check the image min and 
max in the color scale to 
determine whether the 
signal of interest is above 
the noise level and below 
CCD saturation
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4.2 Fluorescent Optical Imaging With Epi-Illumination

This section explains how to acquire a single fluorescent optical image. Epi-illumination 
provides an excitation light source located above the stage. For more details about 
fluorescent imaging, see page 291. For information on acquiring an image sequence, see 
Acquire a Sequence Using the Imaging Wizard, page 33.

NOTE
Before setting the imaging parameters, the IVIS® Imaging System should be intialized and 
the temperature locked. For more details, see Chapter 3, page 15.

1. In the control panel, put a check mark next to Fluorescent and select Auto exposure 
(click the  arrow).

When you select Auto exposure, the software automatically determines the binning 
and F/Stop settings. Alternatively, you can manually set the exposure, binning, and F/
Stop. For more details on these control panel settings, see page 259.

Creates a preview picture (snapshot) of the image or thumbnails that the Living 
Image Browser displays when the data are selected in the browser. For more 
details on the browser, see page 83.

Color Scale Provides a reference for the pixel intensities in a luminescent or fluorescent 
image. Pixels less than the color scale minimum do not appear in the image. Pixels 
greater than the color scale maximum are displayed in the maximum color

Table 4.1  Image window  (continued)  

Item Description

Preview picture of the data selected in the browser (blue row)

Figure 4.5  Acquisition control panel
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2. Select an excitation and emission filter from the drop-down lists. For more 
information about the standard filter sets, see Table F.1, page 296.

3. Put a check mark next to Photograph. 

4. Make a selection from the Field of View drop-down list. For more details on the field 
of view, see page 261.

5. Set the proper Focus by choosing one of the methods below.

The focal distance to the camera is set at stage z = 0 for each field of view. To focus 
at the top of the animal, the stage will move down so that the top of the animal is at z 
= 0. You can either enter the height of the animal using the �“use subject height�” option 
or let the software determine the animal height by choosing the�“scan mid range�” 
option.

�• Select use subject height and use the  arrows or the keyboard arrows to specify 
a subject height (cm). 

�• Select manual focus. For more details on manual focusing see page 264.

�• Select scan mid range (available on the IVIS 200 or Spectrum Imaging System 
only). The imaging system determines the subject height using a laser scan. This 
value is automatically entered in the subject height box and is used to set the focal 
length.

6. To acquire an overlay image (coregistered images) for display after acquisition, put a 
check mark next to Overlay.

NOTE
To view the subject(s) inside the chamber before image acquisition, take a photograph. 
Uncheck the Fluorescent option, choose the Photograph and Auto options, and click 
Acquire.

7. Click Acquire when you are ready to capture the image.

NOTE
If necessary, click  in the control panel to operate in single image mode.In single 
image mode, the  button appears in the control panel. Click this button to set up 
sequence acquisition. (For details on sequence setup, see page 33.)
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8. In the Edit Image Labels box that appears, enter information about the image and click 
OK.

NOTE
You can enter image label information at any time during or after acquisition. If you do not 
want to enter image information, click Cancel.

9. If this is the first image of the session, you are prompted to enable the autosave 
function.

10. To enable autosave, click Yes in the prompt and choose a folder in the dialog box that 
appears.

If autosave is enabled, all images acquired during the session are automatically saved 
to a user-selected folder. You can choose a different folder at any time (select 
Acquisition → Auto-Save on the menu bar).

Image acquisition proceeds. During acquisition, the control panel Acquire button 
becomes a Stop button. To cancel the acquisition, click Stop in the control panel. The 
image window appears when acquisition is completed (Figure 4.8). 

Figure 4.6  Edit Image Labels box

Figure 4.7  Autosave prompt

The information entered here appears in 
the image label (Figure 4.8, page 28).
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4.3 Fluorescent Optical Imaging With Transillumination

This section explains how to acquire a fluorescent optical image with transillumination. 
Transillumination provides an excitation light source located below the stage. FLIT 
reconstruction of fluorescent sources analyzes a transilluminated image sequence. For 
more information about fluorescent imaging, see page 291. 

If the fluorescent source is deep relative to the imaged side of the animal, acquisition with 
transillumination is recommended. By default, acquisition with transillumination 
includes an Normalized Transmission Fluorescence (NTF) Efficiency image in which the 
fluorescent emission image is normalized by the transmission image measured with the 
same emission filter and open excitation filter (Figure 4.9). 

NOTE
Transillumination is only available on the IVIS® Spectrum Imaging System.

Figure 4.8  Overlay (fluorescent image on photograph) in the image window
For more details on the items in the image window, see Table 4.1, page 24.

Image label

Check the image min and 
max in the color scale to 
determine whether the 
signal of interest is above 
the noise level and below 
CCD saturation

Tool palette
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To acquire a fluorescent image with transillumination:

NOTE
Before setting the imaging parameters, the IVIS® Imaging System should be intialized and 
the temperature locked. For more details, see Chapter 3, page 15.

1. In the control panel, put a check mark next to Fluorescent and Transillumination (Figure 
4.10). 

NOTE
The Normalization option is selected by default so that NTF Efficiency images can be 
produced.

Figure 4.9  Fluorescent images acquired with transillumination
In this example, the NTF Efficiency image highlights the presence of fluorescence in the 
animal, while the Radiant Efficiency image shows signal ambiguous with autofluorescence

Figure 4.10  Acquisition Control Panel

NTF Efficiency Image Radiant Efficiency Image
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2. Select an excitation and emission filter from the drop-down lists. For more 
information about the standard filter sets, see Table F.1, page 296. 

3. Click Setup.

If you are prompted to acquire a subject photograph, click Yes.

4. In the Transillumination Setup box that appears (Figure 4.11), choose the location for 
transillumination and image acquisition (click a  square). 

Figure 4.11  Opening the Transillumination Setup dialog box 

Table 4.2  Transillumination Setup box

Item Description
Move Motors to Selected 
Spot

Transillumination motors will move the excitation light source to the 
grid location selected in the Transillumination Setup dialog box.

Mask Grid points To 
Subject

When setting up a transillumination sequence, choose this option to 
automatically select only the grid locations within the subject 
boundaries. Grid locations outside the subject are masked out. The 
mask prevents the transillumination excitation source from selecting 
an uncovered hole. Projecting light through an open hole would 
saturate the camera.

Single location mode 
acquires one image at 
the location marked 
by a green square .
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5. Confirm that the Lamp Level is set to High.

The lamp may be set to Low for certain applications, such as long wavelength data 
through thin tissue.

6. Make a selection from the Field of View drop-down list. For more details on the field 
of view, see page 261.

7. Set the Focus: 

�• Select use subject height and use the  arrows or the keyboard arrows to specify 
a subject height (cm). 

�• Select manual focus. For more details on manual focusing see page 264.

�• Select scan mid range (available on the IVIS 200 or Spectrum Imaging System 
only). The imaging system determines the subject height using a laser scan. This 
value is automatically entered in the subject height box and is used to set the focal 
length.

8. If necessary, click  in the control panel to operate in single image mode.

NOTE
In single image mode, the  button appears in the control panel. Click this button 
to set up sequence acquisition.

9. To acquire an overlay image (coregistered images) for display after acquisition, put a 
check mark next to Overlay.

NOTE
To view the subject(s) inside the chamber before image acquisition, take a photograph. 
Uncheck the Fluorescent option, choose the Photograph option, and click Acquire.

10. When you are ready to capture the image, click Acquire.

Raster Scan If this option is not selected, the software generates one image per 
transillumination location per filter pair. For example, a sequence 
setup that includes 20 locations using two filters will generate 20 
images. If the raster scan option is selected, the software takes all of 
the images from the transillumination locations and adds them 
together into one image. 

The raster scan option may be helpful when trying to determine the 
optimal excitation and emission filters for a particular fluorescent 
probe.

Grid Type Select a grid type from the drop-down list: 15x23, 11x23, 5x10, or 
8x12 well plate, Xenogen Sparse Mask, 6x8x1cm.

Update Photograph Click to acquire a new photographic image. If the chamber door is 
opened during transillumination setup, you are prompted to acquire a 
new photograph.

Clear Selections Clears selected/ highlighted transillumination locations on the grid.

Table 4.2  Transillumination Setup box (continued)  

Item Description
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11. In the Edit Image Labels box, enter information about the image and click OK. 

NOTE
You can enter image label information at any time during or after acquisition. If you do not 
want to enter image information, click Cancel.

12. If this is the first image of the session, you are prompted to enable the autosave 
function.

13. To enable autosave, click Yes in the prompt and choose a folder in the dialog box that 
appears.

If autosave is enabled, all images acquired during the session are automatically saved 
to a user-selected folder. You can choose a different folder at any time (select 
Acquisition → Auto-Save on the menu bar).

Image acquisition proceeds. During acquisition, the control panel Acquire button 
becomes a Stop button. To cancel the acquisition, click Stop in the control panel. The 
image window and Tool Palette appear when acquisition is completed (Figure 4.8, 
page 28).

Figure 4.12  Edit Image Labels box

Figure 4.13  Autosave prompt

The information entered here appears in 
the image label (Figure 4.8, page 28).
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4.4  Acquire a Sequence Using the Imaging Wizard

This section explains how to acquire a sequence of multiple images. To acquire an image 
sequence, first specify the acquisition parameters for each image in the sequence table 
(Figure 4.15). The Imaging Wizard provides a convenient way to do this for some imaging 
applications (Table 4.3). The wizard guides you through a series of steps, prompting you 
for the information that the software needs to set up the sequence. A sequence can also be 
set up manually (for more details, see page 41).

NOTE
For details on acquiring a sequence on the Lumina XR that includes X-ray images, see 
Chapter 5, page 49.

Figure 4.14  Imaging Wizard 

Table 4.3  Imaging Wizard options 

Bioluminescence Description Page
Open Filter Acquires an image at maximum sensitivity.

Planar Spectral Analyze the sequence to compute the average depth and total photon 
flux of a luminescent point source in a region of interest (ROI).

157

Spectral Unmixing Analyze the sequence to determine spectral signature of different 
reporters in the same image and calculate the contribution of each 
reporter on each pixel in the image.

165

DLIT Apply the DLIT algorithm to the sequence to reconstruct the 3D 
surface topography of the subject and the position, geometry, and 
strength of the luminescent sources.

193

Fluorescence Description Page
Filter Pair Choose this option to acquire measurements of one or more 

fluorescent probes.

Spectral Unmixing/
Filter Scan

Analyze a sequence to extract the signal of one or more fluorophores 
from the tissue autofluorescence. Helps you determine the optimum 
excitation and emission filter for a probe.

165

FLIT Apply the FLIT�™ algorithm to the sequence to reconstruct the 3D 
surface topography of the subject and the position, geometry, and 
strength of the fluorescent sources.

201
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Sequence Setup Using the Imaging Wizard

1. Click Imaging Wizard in the control panel (Figure 4.15).

NOTE
If necessary, click Restart to show the first page of the wizard.

2. In the wizard that appears:

a. Choose Bioluminescence or Fluorescence imaging.

b. In the next wizard screen, choose the type of image sequence that you want to 
acquire (see Table 4.3, page 33). 

c. Step through the rest of the wizard.

Each page of the wizard guides you with step-by-step instructions and descriptions. 
When you complete the wizard, the sequence information appears in the sequence 
table (Figure 4.15).

3. To clear the sequence, click the Remove button  and select All.

Figure 4.15  Opening the sequence table and Imaging Wizard

Sequence table

Double-click here to set 
up a bioluminescence 
image sequence

Double-click here to 
set up a fluorescence 
image sequence

If this screen does not appear 
when the wizard starts, click 
Restart Wizard  (on 
the wizard screen) to restart 
the wizard.

When the wizard is finished, 
the sequence is displayed.

Imaging Wizard
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NOTE
The imaging options available in the Imaging Wizard depend on the IVIS Imaging System and 
the installed filter set.

Acquire the Image Sequence

1. Confirm that the IVIS Imaging System is initialized and the CCD temperature is 
locked. (For more details, see page 17.)

2. When you are ready to acquire the images, click Acquire Sequence in the control 
panel.

The Edit Image Labels box appears.

Figure 4.16  Choose the type of image sequence

Figure 4.17  Control panel and sequence table during acquisition
Each row in the sequence table specifies the acquisition parameters for one image in the 
sequence. For more details on the sequence table, see Table 4.5, page 43.

Imaging Wizard - Bioluminescence options Imaging Wizard - Fluorescence options

Sequence table
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3. In the Edit Image Labels box, enter information about the image and click OK. If you 
do not want to enter image information, click Cancel.

4. If this is the first image of the session, you are prompted to enable the autosave 
function.

5. To enable autosave, click Yes in the prompt and choose a folder in the dialog box that 
appears.

If autosave is enabled, all images acquired during the session are automatically saved 
to a user-selected folder. You can choose a different folder at any time (select 
Acquisition → Auto-Save on the menu bar).

Image acquisition proceeds. The Sequence View window appears and displays the 
images as they are acquired. The Tool Palette appears when acquisition is completed 
(Figure 4.20).

6. To stop acquisition, click the Stop in the control panel. To pause acquisition, click 
Pause in the control panel.

Figure 4.18  Edit Image Labels box

Figure 4.19  Autosave prompt

The information entered here appears 
in the image label (Figure 4.20).
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NOTE
The Spectra window is available if the acquisition included multiple wavelengths. The Spectra 
window provides a convenient way to view probe spectra from the factory-installed library and 
ROIs. For more details, see page 171.

Figure 4.20  Sequence View window & Tool Palette
Double-click an image in the sequence to open it in a separate image window.

Table 4.4  Sequence View window

Item Description
Units Select the measurement units for the image display from this drop-down list. The 

available units depend on the type of image. For more details on measurement units, 
see page 281.

Use Saved 
Colors

Choose this option to display the image data using the color table that was specified 
in the Preferences at the time of acquisition. If this option is not selected, image data 
are displayed using the color table currently specified in the Preferences. 

Tool palette

Check the image min and max in the color scale 
to determine whether the signal of interest is 
above the noise level and below CCD saturation

Sequence View window
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Options Layout - Choose a display option for the images in a sequence (Default, Dynamic, or 
Film Strip). For example, here is Film Strip mode:

Sort by - Options for ordering images in the sequence window. This option only 
applies to images that were opened using the �“Load as Group�” function in the LIving 
Image browser.

Default - Order in which the images are stored in the folder
TimeStamp - Ascending order of the image acquisition time
UserID - Ascending alphanumeric order of the user ID

Display - Choose the types of information to display with each image.

Info Click to show or hide the image label information (Figure 4.20).

Opens all of the images in the sequence.

Closes all open images.

Opens the Edit Sequence dialog box that enables you to add or remove images from 
the sequence.

Enables you to export the active image as a graphic file (for example, .png, .dcm).

Table 4.4  Sequence View window (continued)  

Item Description

In this example, exposure 
time and binning factor are 
displayed on each image 
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4.5 Acquire Multiple Sequences in Batch Mode

In batch mode, you can set up multiple, separate sequences, which will be automatically 
acquired, one after another, without manual intervention. 

To setup and acquire sequences in batch mode:
1. In the Control Panel, click Sequence Setup.

2. Choose the Batch Sequences option.

Creates a preview picture (snapshot) of the image or thumbnails that the Living 
Image Browser displays when the data are selected.For more details on the browser, 
see page 83.

Table 4.4  Sequence View window (continued)  

Item Description

Preview picture of the selected data

Figure 4.21  Control Panel

Batch Sequences option
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3. To set up the first sequence, do either of the following:

�• Click Imaging Wizard and step through the wizard (for more details on the 
Imaging Wizard, see page 33).

OR

�• Set up the sequence manually (for more details, see page 41).

4. To set up the next sequence:

�• If using the Imaging Wizard, repeat step 3. 
Each sequence is dislayed in a separate tab.

�• If setting up the sequence manually, click the  button in the sequence table to add 
a new tab, then proceed with manual set up in the new tab.

NOTE
Sequence tabs can be renamed. Double-click a tab name to edit it. Alternatively, right-click 
the selected name to view a shortcut menu of edit commands (for example, Cut, Copy, 
Paste).

5. To remove a sequence, click the sequence tab and then click the  button.

6. Click Acquire when you are ready to capture the sequences.

Image acquisition proceeds with no intervening time delay between sequences. 

NOTE
If the check mark is removed next to the Batch Sequences option (Figure 4.21), only the 
sequence in the active tab will be acquired.

Figure 4.22  Multiple sequence tabs
In this example, three sequences are specified.

Sequence tabsAdds a new tab (use with 
manual sequence setup)

Removes the active tab and its sequence
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4.6 Manually Set Up an Image Sequence

This section explains how to set up an image sequence if you do not use the Imaging 
Wizard. You can save the sequence parameters in the sequence table to a Living Image 
Sequence Setup file (.xsq).

For details on image acquisition, see Acquire the Image Sequence, page 35.

NOTE
To create an image sequence, it may be convenient to edit a sequence setup generated by 
the Imaging Wizard or an existing sequence setup (.xsq). Save the revised sequence setup 
to a new name.

1. Click Sequence Setup in the control panel.

The sequence table appears.

2. If necessary, click the Remove button  and select All to clear the sequence 
table.

3. Choose a subject and probe from the drop-down lists (Figure 4.24).

Figure 4.23  Opening the sequence table 

Sequence table
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4. In the control panel, specify the imaging settings for the first luminescence or 
fluorescence image in the sequence and the photograph. (For details on the imaging 
parameters in the control panel, see page 259.)

NOTE
If you choose the photograph Reuse option in the control panel (Figure 4.25), the IVIS 
System acquires only one photograph for the entire sequence. If this option is not chosen, 
the system acquires a photograph for each image in the sequence.

5. Click the Add button .

The acquisition parameters appear in the sequence table (Figure 4.25).

6. Repeat step 4 to step 5 for each image in the sequence.

7. To set a time delay between each acquisition, enter a time (minutes) in the Delay box 
in the sequence table.

8. To save the sequence setup information (.xsq):

a. In the sequence table, click the Save button .

b. In the dialog box that appears, select a destination directory, enter a file name, and 
click Save.

Figure 4.24  Choose a subject and probe

Figure 4.25  Control panel and sequence table with image settings
Each row in the sequence table specifies the acquisition parameters for one image in the sequence.

Reuse option
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Editing Image Parameters

You can edit parameters in the sequence table or in the control panel.

To edit a parameter in the sequence table:
1. Double-click the cell that you want to edit.

2. Enter a new value in the cell or make a selection from the drop-down list.

Table 4.5  Sequence table 

Item Description
Starts the Imaging Wizard.

Displays a dialog box that enables you to select and open a 
sequence setup (.xsq), sequenceinfo.txt, or clickinfo.txt file.

Displays a dialog box that enables you to save the information in 
the sequence table to a sequence setup file (.xsq).

Display Photographic Settings Choose this option to include the photograph exposure time, 
binning, and F/Stop in the sequence table.

If a subject and probe are specified (optional), the software uses 
the information to automatically set parameters in the Surface 
Topography, DLIT, FLIT, Spectral Unmixing, and Planar Spectral 
Imaging tools. If a subject or probe is not selected here, the 
default parameters appear in the Tool Palette.

Number of Segments The sequence specified in the sequence table is called a segment. 
Choose this option to set the number of segments to acquire and 
the time delay between segments. This is useful for acquiring data 
for kinetic analysis.

Delay Specifies a time delay between each segment acquisition.

Applies the selected cell value to all cells in the same column.

Remove Selected - Deletes the selected row from the sequence 
table.

Remove All - Removes all rows from the sequence table.

Updates the selected row in the sequence table with the 
acquisition parameters in the control panel.

Inserts a row above the currently selected row using the 
information from the control panel.

Adds a new row at the end of the sequence setup list.

Figure 4.26  Control panel and sequence table
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To apply the new value to all of the cells in the same column, click .

3. Click outside the cell to lose focus.

To edit a parameter in the control panel:
1. In the sequence table, select the row that you want to modify.

2. In the control panel, choose new parameter values and/or imaging mode.

3. Click  in the sequence table.

Inserting Images in a Sequence

Method 1:
1. In the sequence table, select the row next to where you want to insert the image. 

2. Set the imaging mode and parameters in the control panel. 

3. To insert the new image above the selected row, click . 

Method 2:
Select the row(s) of interest and right-click the sequence table to view a shortcut menu of 
edit commands.

Figure 4.27  Sequence table, edit commands in the shortcut menu

Table 4.6  Sequence table, shortcut menu edit commands

Command Description
Copy row(s) Copies the selected row(s) to the system clipboard.

Select All Selects all rows in the sequence table.

Delete row(s) Deletes the selected row(s) from the sequence table.

Replace Row(s) Replaces the row(s) selected in the sequence table with the rows in 
the system clipboard. 

Note: The Replace function is only available when the number of rows 
in the system clipboard is the same as the number of rows selected in 
the sequence table.

Paste Row(s) Adds copied rows to end of the sequence.
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Removing Images From a Sequence

Method 1:
1. Select the row(s) that you want to delete.

2. Click  and choose Selected from the drop-down list.

Method 2:

Select the row(s) of interest and right-click the sequence table to view a shortcut menu of 
edit commands (Figure 4.27).

4.7 High Resolution Imaging With the Optical Zoom Lens Attachment

The optional Optical Zoom Lens attachment enables close up and high resolution imaging 
on the IVIS Lumina, IVIS Lumina XR, and IVIS Kinetic Imaging Systems. When the 
Zoom lens attachment is installed, only the �“Z�” field of view setting (2.6 cm) is available 
for single-image or sequence acquisition. 

The imaging system is set to the Z field of view position until the Zoom lens attachment 
is removed. If the Zoom lens attachment is installed when the Living Image software is 
closed, the stage will move to the Z position when the system is initialized.

NOTE
When installing or removing the Optical Zoom Lens attachment, avoid touching the optical 
glass.

Installing the Zoom Lens Attachment

1. Choose the Zoom option in the control panel (Figure 4.28).

You are prompted to insert the Zoom Lens attachment.

Figure 4.28  Control panel, Zoom option selected
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2. After you install the Zoom Lens attachment in the imaging chamber, click OK in the 
prompt.

The stage moves to the �“Z�” field of view position. 

NOTE
When the Zoom Lens attachment is installed, single images or sequential images can only 
be acquired at the Z field of view setting. During sequence setup, if you attempt to change 
away from the Z setting, the sequence table will be cleared. If you attempt to change from 
another field of view setting to the Z setting, the sequence table is cleared of all previous 
settings before the camera settings for the Z position are added.

Removing the Zoom Len Attachment

The imaging system is set to the �“Z�” field of view until the Zoom Lens attachment is 
removed. 

1. Remove the check mark next to Zoom in the control panel (Figure 4.29).

The stage moves to position C, then you are prompted to remove the lens attachment.

2. After you remove the Zoom Lens attachment, click OK in the prompt.

Always store the lens wrapped in its protective container.

4.8 Manually Saving Image Data

When you acquire the first image(s) of a session, you are prompted to enable the autosave 
feature. If autosave is enabled, all images acquired during the session are automatically 
saved to this folder. You can choose a different folder at any time (select Acquisition → 
Auto-Save on the menu bar).

Figure 4.29  Control panel, remove the check mark next to Zoom
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This section explains how to manually save data if you do not want to use the autosave 
feature.

1. Turn off the autosave feature: select Acquisition on the menu bar and remove the 
check mark next to Auto Save.

2. After you acquire an image or image sequence, click the Save button . Alternatively, 
select File → Save on the menu bar.

3. In the dialog box that appears, select a directory and click OK.

NOTE
The software automatically includes the user ID, and a date and time stamp with the data.

4.9 Exporting Image Data

You can save the active image view in different file formats (for example, .bmp, .dcm).

1. Open an image or image sequence.

2. Click the Export Graphics button .

3. In the dialog box that appears, select a directory, choose a file type, and enter a file 
name.

4. Click Save.

NOTE
To export a sequence to DICOM (.dcm) format, select Export → Image/Sequence as 
DICOM on the menu bar. This creates a directory that contains the .dcm files and a 
SequenceInfo.txt.

Figure 4.30  Exporting an image to a graphic file
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X-ray images can be acquired on the Lumina XR Imaging System. An X-ray image, 
luminescent or fluorescent image, and a photograph can be acquired at the same time. You 
can choose two images to create an overlay (Figure 5.1). 

5.1 Acquire an X-Ray Image

This section explains how to acquire an X-ray image on the Lumina XR Imaging System. 
For information on including a luminescent or fluorescent image in the acquisition, see 
Chapter 4, page 21.

1. Start the Living Image software (double-click the  icon on the desktop).

2. Initialize the Lumina XR Imaging System and confirm or wait for the CCD 
temperature to lock. (For more details, see page 17.)

3. In the control panel, put a check mark next to X-Ray (Figure 5.2).

NOTE
To enable X-ray acquisition, verify that the X-ray enabling key on the front of the Lumina XR 
is set to ON, and the orange X-ray enable button has been depressed and is illuminated.

Figure 5.1  Example overlay: fluorescence image on X-ray image
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4. Select the Auto exposure time (click the  arrow). Alternatively, manually set the 
exposure, binning, and F/Stop. (For more details on the control panel settings, see 
page 259.)

5. Make a selection from the Energy drop-down list.

NOTE
A Caliper field service engineer can customize the default X-ray energy levels (Table 5.1) to 
settings from 5.0 - 40 Kv and from 1-100 µA with or without the low energy X-ray absorbing 
(Al) filter.

6. Set the Field of View: Make a selection from the Field of View drop-down list. For 
more details on the field of view, see page 261.

NOTE
To view the subject(s) inside the chamber before image acquisition, take a photographic 
image (uncheck the luminescent or fluorescent option, choose the Photographic and Auto 
options, and click Acquire).

7. Set the Focus: 

�• Select use subject height from the Focus drop-down list and use the  arrows or the 
keyboard arrows to specify a subject height (cm). 

NOTE
The subject height for X-ray images is restricted to 2.8 cm or less. The subject height is 
critical to ensure proper optical and X-ray overlay. The subject height is used to determine 
the X-ray resizing coefficient. Select a subject height which suits the region of interest.

or

Figure 5.2  Lumina XR control panel

Table 5.1  Lumina XR energy options

Energy Option Suitable For X-Ray Energy Level
Animal Living subject 35 Kv 100 µA, filtered X-rays

Specimen Non-living specimen 28 Kv 100 µA, unfiltered X-rays

X-ray acquisition 
settings
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�• Select Manual focus from the Focus drop-down list. (For more details on manual 
focusing see page 264.)

8. If you want to acquire a photograph, set the Photograph image settings:

a. Put a check mark next to Photograph.

b. Enter an exposure time or choose the Auto option.

c. Confirm the binning and f/stop defaults or enter new values.

9. If necessary, click  in the control panel to operate in single image mode.

NOTE
In single image mode, the  button appears in the control panel. Click this button 
to set up sequence acquisition. (For more details on setting up a sequence, see page 54.)

10. When you are ready to acquire the image, click Acquire.

The Edit Image Labels box appears.

11. In the Edit Image Labels box, enter information about the image and click OK (Figure 
5.3). If you do not want to enter image information, click Cancel.

Image acquisition proceeds. During acquisition, the Acquire button becomes a Stop 
button. To cancel the acquisition, click Stop. When acquisition is complete, the image 
window appears (Figure 5.6). 

12. If this is the first image of the session, you are prompted to enable the autosave 
function.

Figure 5.3  Edit Image Labels box

The information you enter here appears 
in the image label (Figure 5.6).
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13. To enable autosave, click Yes in the prompt and choose a folder in the dialog box that 
appears.

If autosave is enabled, all images acquired during the session are automatically saved 
to a user-selected folder. You can choose a different folder at any time (select 
Acquisition → Auto-Save on the menu bar).

The acquisition proceeds and the control panel warns you that X-ray radiation is being 
produced (Figure 5.5). The image window and Tool Palette appear when acquisition is 
completed (Figure 5.6)

14. If you need to stop the acquisition, click Stop in the control panel .

Figure 5.4  Autosave prompt

Figure 5.5  Control panel during X-ray image acquisition

X-ray energy 
warning

Click to stop 
the acquisition
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NOTE
It may be necessary to use the Image Adjust tools to optimize the overlay display. Use the 
Opacity control to adjust the appearance of the overlay. For more details on adjusting image 
appearance, see page 97.

Figure 5.6  Overlay (fluorescent image on X-ray image) in the image window

Table 5.2  Image window 

Item Description
Units Select the measurement units for the image display from this drop-down list. The 

available units depend on the type of image data. For more details on 
measurement units, see page 281.

Display Select the image type (for example, X-ray) that you want to display from this drop-
down list. For more details on the different types of image displays, see Table 2.2, 
page 8.

Note: If the acquisition included more than two imaging modes (for example, 
luminescent, X-ray, and photograph), additional drop-down lists appear so you can 
conveniently choose any two images to overlay. 

Info Click to display or hide the image label information.

Opens a dialog box that enables you to export the active view as a graphic file.

Tool palette

Image label

Check the image min and 
max in the color scale to 
determine whether the 
signal of interest is above 
the noise level and below 
CCD saturation
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5.2 Acquire an Image Sequence That Includes X-Ray Images

To acquire an image sequence, first specify the acquisition parameters for each image in 
the sequence table (Figure 5.7). The Imaging Wizard provides a convenient way to do this 
for some imaging applications. The wizard guides you through a series of steps, 
prompting you for the information that the software needs to set up the sequence in the 
sequence table. If you don�’t use the wizard, you can set up a sequence manually (for more 
details, see page 41).

Sequence Setup Using the Imaging Wizard

1. Click Sequence Setup in the control panel (Figure 5.7).

The sequence table appears.

2. If necessary, click the Remove button  and select All to clear the sequence 
table.

3. Click the Imaging Wizard button . 

Takes a �“snapshot�” that is displayed with the data in the Living Image Browser.

Color scale Provides a reference for the pixel intensities in a luminescent or fluorescent 
image. Pixels less than the color scale minimum do not appear in the image. Pixels 
greater than the color scale maximum are displayed in the maximum color

Image label Information about the image that the software automatically records and user-
specified information entered in the Edit Image Label dialog box.

Table 5.2  Image window  (continued)  

Item Description

Snapshot

Living Image 
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4. In the wizard, choose bioluminescence or fluorescence imaging (Figure 5.7).

5. In the next wizard screen, choose the type of image sequence that you want to acquire. 
Step through the rest of the wizard

6. To include an X-ray image or photograph in the sequence, put a check mark next to 
the X-ray or Photograph option when you set the imaging parameters in the wizard 
(Figure 5.8).

Figure 5.7  Opening the sequence table and starting the Imaging Wizard

Sequence table

Double-click here to set 
up a bioluminescence 
image sequence

Imaging Wizard

If this screen does not 
appear when the wizard 
starts, click Restart 
Wizard  (on the 
wizard screen) to restart 
the wizard.

Double-click here to set 
up a fluorescence 
image sequence

Select the type of 
subject and probe from 
the drop-down lists.
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Figure 5.8  Imaging Wizard, imaging parameters

Table 5.3  Imaging Wizard

Item Description
Imaging Subject Choose the type of subject from this drop-down list.

Exposure Parameters The Auto Settings exposure option is the default. To manually set the 
exposure parameters, select the Manual Settings option. For more 
details on the exposure parameters, see page 259.

NOTE
In the control panel, the Photograph and X-ray Reuse option is 
selected by default (Figure 5.9). This means the same X-ray image 
and photograph will be used if camera conditions do not change (for 
example, binning or F/Stop). If you do not want to reuse the X-ray 
image or photograph, you can manually edit the image sequence in 
the sequence table (for more details, see page 44). Alternatively, 
remove the check mark next to Reuse in the control panel before 
you begin the Imaging Wizard.

Field of View Sets the size of the stage area to be imaged by adjusting the position of 
the stage and lens.The FOV is the width of the square area (cm) to be 
imaged. A smaller FOV gives a higher sensitivity measurement, so it is 
best to set the FOV no larger than necessary to accommodate the 
subject or area of interest. The FOV also affects the depth of field (range 
in which the subject is in focus). A smaller FOV results in a narrower 
depth of field, but gives a higher resolution image. Select the FOV by 
choosing a setting (A, B, or C) from the drop-down list. For more details 
on the calibrated FOV positions, see Table A.3, page 263. 

To include a photograph or X-ray image in the 
acquisition, put a check mark next to the 
Photograph or X-ray option.
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7. Complete the rest of the Imaging Wizard.

When you complete the wizard, the sequence information appears in the sequence 
table (Figure 5.10).

Focus Drop-down list of focusing methods available:

Use subject height - Choose this option to set the focal plane at the 
specified subject height. 

Manual - Choose this option to open the Focus Image window so that 
you can manually adjust the stage position. For more details on manual 
focusing, see 264.

Options Time Series Study - Choose this option to specify the number of 
segments to acquire and a time delay between segments. This option is 
useful for acquiring data for kinetic analysis. 

Note: The sequence specified in the sequence table is called a segment. 

Restart Wizard Returns the wizard to the starting screen.

Table 5.3  Imaging Wizard

Item Description

Figure 5.9  Control panel and sequence table

Reuse photograph & Reuse X-ray options

Figure 5.10  Control panel and sequence table

X-ray reuse option is selected by default. 
One X-ray image is acquired for the sequence. 
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Acquire the Image Sequence

1. Confirm that the IVIS Imaging System is initialized and the CCD temperature is 
locked. (For more details, see page 17.)

2. When you are ready to acquire the images, click Acquire Sequence in the control 
panel.

The Edit Image Labels box appears.

3. In the Edit Image Labels box, enter information about the image and click OK. If you 
do not want to enter image information, click Cancel.

4. If this is the first image of the session, you are prompted for an autosave location. All 
images acquired during the session are automatically saved to this folder. You can 
choose a different folder at any time (select Acquisition → Auto-Save on the menu 
bar).

To select a folder for autosaved data, click Yes in the prompt and choose a folder in 
the dialog box that appears.

Image acquisition proceeds. The Sequence View window appears and displays the 
images as they are acquired. The Tool Palette appears when acquisition is completed 
(Figure 5.13).

5. To stop acquisition, click the Stop in the control panel. To pause acquisition, click 
Pause in the control panel.

Figure 5.11  Edit Image Labels box

Figure 5.12  Autosave prompt appears if this is the first acquisition of the session

The information entered here appears 
in the image label (Figure 5.13).
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Figure 5.13  Image sequence and Tool Palette
Double-click an image in the sequence to open it in a separate image window.

Table 5.4  Image window: Sequence view

Item Description
Units Select the measurement units for the image display from this drop-down list. The 

available units depend on the type of image data. For more details on measurement 
units, see page 281.

Use Saved 
Colors

Choose this option to display the image data using the color table that was specified 
in the Preferences at the time of acquisition. If this option is not selected, image data 
are displayed using the color table currently specified in the Preferences. 

Image label

Check the image min and max in the color scale 
to determine whether the signal of interest is 
above the noise level and below CCD saturation

Tool palette
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Options Layout - Choose a display option for the images in a sequence. For example, here is 
Film Strip mode:

Sort by - Options for ordering images in the sequence window:

Default - Order in which the images are stored in the folder
TimeStamp - Ascending order of the image acquisition time
UserID - Ascending alphanumeric order of the user ID

Display - Choose the types of information to display with each image.

Info Click to show or hide the image label information (Figure 5.13).

Opens all of the images in the sequence.

Closes all open images.

Opens the Edit Sequence dialog box that enables you to add or remove images from 
the sequence.

Enables you to export the active image as a graphic file (for example, .png, .dcm).

Table 5.4  Image window: Sequence view (continued)  

Item Description

In this example, exposure 
time and binning factor are 
displayed on each image 
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5.3 Acquire Multiple Sequences in Batch Mode

In batch mode, you can set up multiple, separate sequences, which will be automatically 
acquired, one after another, without manual intervention. 

To setup and acquire sequences in batch mode:
1. In the Control Panel, click Sequence Setup.

2. Choose the Batch Sequences option.

Creates a preview picture (snapshot) of the image or thumbnails that the Living 
Image Browser displays when data are selected. For more details on the browser, 
see page 83.

Table 5.4  Image window: Sequence view (continued)  

Item Description

Preview picture of the selected data

Figure 5.14  Control Panel

Batch Sequences option
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3. To set up the first sequence, do either of the following:

�• Click Imaging Wizard and step through the wizard (for more details on the 
Imaging Wizard, see page 54).

OR

�• Set up the sequence manually (for more details, see page 41).

4. To set up the next sequence:

�• If using the Imaging Wizard, repeat step 3. 
Each sequence is dislayed in a separate tab.

�• If setting up the sequence manually, click the  button in the sequence table to add 
a new tab, then proceed with manual set up in the new tab.

NOTE
Sequence tabs can be renamed. Double-click a tab name to edit it. Alternatively, right-click 
the selected name to view a shortcut menu of edit commands (for example, Cut, Copy, 
Paste).

5. To remove a sequence, click the sequence tab and then click the  button.

6. Click Acquire when you are ready to capture the sequences.

Image acquisition proceeds with no intervening time delay between sequences. 

NOTE
If the check mark is removed next to the Batch Sequences option (Figure 5.14), only the 
sequence in the active tab will be acquired.

Figure 5.15  Multiple sequence tabs
In this example, three sequences are specified.

Sequence tabsAdds a new tab (use with 
manual sequence setup)

Removes the active tab and its sequence
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5.4  High Resolution Imaging With the Optical Zoom Lens Attachment

The optional Optical Zoom Lens attachment enables close up and high resolution imaging 
on the IVIS Lumina, IVIS Lumina XR, and IVIS Kinetic Imaging Systems. When the 
Zoom lens attachment is installed, only the �“Z�” field of view setting (2.6 cm) is available 
for single-image or sequence acquisition. 

The imaging system is set to the Z field of view position until the Zoom lens attachment 
is removed. If the Zoom lens attachment is installed when the Living Image software is 
closed, the stage will move to the Z position when the system is initialized.

NOTE
When installing or removing the Optical Zoom Lens attachment, avoid touching the optical 
glass.

Installing the Zoom Lens Attachment

1. Choose the Zoom option in the control panel (Figure 5.16).

You are prompted to insert the Zoom Lens attachment.

2. After you install the Zoom Lens attachment in the imaging chamber, click OK in the 
prompt.

The stage moves to the �“Z�” field of view position. 

Figure 5.16  Control panel, Zoom option selected
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NOTE
When the Zoom Lens attachment is installed, single images or sequential images can only 
be acquired at the Z field of view setting. During sequence setup, if you attempt to change 
away from the Z setting, the sequence table will be cleared. If you attempt to change from 
another field of view setting to the Z setting, the sequence table is cleared of all previous 
settings before the camera settings for the Z position are added.

Removing the Zoom Len Attachment

The imaging system is set to the �“Z�” field of view until the Zoom Lens attachment is 
removed. 

1. Remove the check mark next to Zoom in the control panel (Figure 5.17).

The stage moves to position C, then you are prompted to remove the lens attachment.

2. After you remove the Zoom Lens attachment, click OK in the prompt.

Always store the lens wrapped in its protective container.

Figure 5.17  Control panel, remove the check mark next to Zoom



Chapter 5 | X-Ray Imaging  65 

5.5  Measuring Relative Density

As density increases, tissue absorbs more X-ray energy and appears darker in a raw 
Lumina XR X-ray image (Figure 5.18). To enable measurements of this X-ray absorption, 
the raw X-ray image is mathematically transformed, resulting in an image where denser 
material appears lighter and intensity measurements are proportional to the tissue density 
(Figure 5.18). 

The Living Image software displays transformed X-ray images by default. To display raw 
X-ray images, remove the check mark next to X-Ray Absorption in the Corrections / 
Filtering tools (Figure 5.19).

When the X-ray data has been corrected for absorption, you can evaluate relative bone 
density by comparing the signal intensities of measurement ROIs. The ROI intensity 
increases with increasing tissue density. 

NOTE
When acquiring X-ray images for bone density evaluation, it is best if the subject does not fill 
the entire field of view since the X-ray absorption measurements are referenced to the 
exposed scintillator plate.

Figure 5.18  X-ray images: raw (left) and in absorption units (right)

Figure 5.19  Corrections/Filtering tools

If this option is not selected, no 
mathematical transformation is 
applied to the data and raw X-ray 
images are displayed (Figure 5.18).



66  Living Image Software User’s Manual

To determine relative bone density:
1. Load an X-ray image. (For more details on opening image data, see page 83.)

2. Confirm that the X-ray absorption correction (default) is applied (Figure 5.19).

3. In the ROI tools, select Measurement ROI from the Type drop-down list (Figure 5.20).

4. To select the ROI shape:

a. Click the Circle  or Square  button. 

b. On the drop-down list that appears, select the number of ROIs that you want to add 
to the image. 

�— The ROI(s) and intensity label(s) appear on the image. If you are working with a 
sequence, open an image to show the ROI intensity.

5. Adjust the ROI position:

a. Place the mouse pointer over the ROI. When the pointer becomes a , click the 
ROI.

b. Drag the ROI.

6. Adjust the ROI dimensions:

a. Place the mouse pointer over the ROI. When the pointer becomes a , click the 
ROI.

b. Place the mouse pointer over an ROI handle  so that it becomes a . Drag the 
handle to resize the ROI.

NOTE
You can also change the ROI position or size using the adjustment controls in the ROI 
Properties box (see “Moving an ROI,” page 138 and “Editing ROI Dimensions,” page 139).

Figure 5.20  X-ray image with absorption correction
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7. Click the Measure button . 

The ROI intensity measurements appear in the X-ray image and the ROI measurements 
table appears. For more details on the table, see �“Managing the ROI Measurements Table,�” 
page 145. For information on how to save ROIs, see page 142.

Figure 5.21  Measurement ROIs on X-ray image
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The IVIS Kinetic Imaging System is ready to acquire kinetic data after the system is 
initialized and the CCD camera reaches operating (demand) temperature (locked).

6.1 Kinetic Acquisition

NOTE
Before setting the imaging parameters, the IVIS® Imaging System should be intialized and 
the temperature locked. For more details, see Chapter 3, page 15.

1. If you are acquiring ventral images (requires the subject be placed in the Ventral 
Imaging Chamber), choose the VIC option in the control panel.

2. When you are ready to begin imaging, click Kinetics in the control panel.

The Kinetic Acquisition window appears.

Figure 6.1  Control panel (top) and Kinetic Acquisition window (bottom)
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3. Select the type of data to acquire and set the acquisition parameters. (For more details 
on the acquisition parameters, see Table 6.1, page 71.)

4. Click the  Record button  to start acquisition. (After acquisition begins, the button 
changes to a Stop button .) To stop acquisition, click the  Stop button . 

The maximum vs. time graph appears when kinetic acquisition begins and plots the 
maximum intensity signal in each frame. The graph provides a convenient way to look 
for signal trends or select particular frames for viewing.

Figure 6.2  Kinetic Acquisition window 

After acquisition, choose 
the type of data to display

Select the type data to acquire 
(luminescent or fluorescent) 
and choose the Overlay option 
to acquire photographs

To adjust a setting using the 
thumb wheel, put the mouse 
arrow on the wheel, then click 
and hold the mouse button while 
you move the mouse arrow left 
or right.
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Figure 6.3  Maximum vs. time graph

Table 6.1  Kinetic acquisition settings

Item Description

Select the type of data to acquire (luminescent or fluorescent) from this 
drop-down list. Choose the Overlay option to also acquire photographs.

Overlay Choose this option to acquire photographs.

�• Click a point in the graph to view 
the corresponding image 
(frame)

�• Put the mouse pointer over the 
graph to view a tooltip that 
shows the frame number and 
time

�• Right-click the graph to view the 
available shortcut menu of 
graph display options
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Dynamic Range 14 bit - If this option is chosen, the signal intensities range from 0 to 
16383 counts per pixel.

16 bit - If this option is chosen, the signal intensities range from 0 to 
65535 counts per pixel. 

Note: The14 bit dynamic range enables faster imaging.

Exposure Time 
(msecs)

The exposure time for the luminescent image. Shorter exposure times 
enable faster frame rates; longer exposure times provide greater 
sensitivity. The14 bit dynamic range enables faster imaging by attaining a 
higher frame rate at the cost of a smaller dynamic range.

Binning Controls the pixel size on the CCD camera. Increasing the binning 
increases the pixel size, sensitivity, and frame rate, but reduces spatial 
resolution. Using larger binning for a luminescent or fluorescent image 
can significantly improve the signal-to-noise ratio. The loss of spatial 
resolution at high binning is often acceptable for in vivo images where 
light emission is diffuse. For more details on binning, see Appendix C, 
page 276.

Recommended binning: 1-4 for imaging of cells or tissue sections, 4-8 for 
in vivo imaging of subjects, and 8-16 for in vivo imaging of subjects with 
very dim sources.

F/Stop Sets the size of the camera lens aperture.The aperture size controls the 
amount of light detected and the depth of field. A larger f/stop number 
corresponds to a smaller aperture size and results in lower sensitivity 
because less light is collected for the image. However, a smaller aperture 
usually results in better image sharpness and depth of field.

In kinetic mode, the photographic and luminescent (or fluorescent) image 
are acquired at the same F/Stop. For more details on f/stop, see Appendix 
C, page 275.

EM Gain Multiplies the signal in real time. This option is useful for boosting low 
signals above the background noise. For kinetic imaging, the EM gain may 
be set to 50, 100, or 250. For conventional 16-bit still image acquisition, 
EM gain may be set to Off, 50, 100, or 250.

Excitation Filter A drop-down list of fluorescence excitation filters. For fluorescent 
imaging, choose the appropriate filter for your application (GFP, DsRed, 
Cy5.5, or ICG). For luminescent imaging, Block is selected by default.

Emission Filter A drop-down list of fluorescence emission filters. For fluorescent imaging, 
choose the appropriate filter for your application (GFP, DsRed, Cy5.5, or 
ICG). For luminescent imaging, Open is selected by default.

FL Lamp Level Sets the illumination intensity level of the excitation lamp used in 
fluorescent imaging (Off, Low, or High). 

Low - This setting is approximately 18% of the High setting. 

Note: Make sure that the filters of interest are selected in the filter drop-
down lists before you select Inspect. The Inspect operation automatically 
positions the selected filters in the system before turning on the lamp. 
Subsequent changes to the filter popup menus will have no effect until 
another Inspect operation is performed.

Photograph Light 
Level

Controls the brightness of the lights at the top of the imaging chamber 
that are used to acquire photographic images.

Accumulate Select this option to view the cumulative intensity signal in real time. 
When this option is chosen, the software computes and visualizes the 
cumulative signal in each frame. 

Table 6.1  Kinetic acquisition settings (continued)  

Item Description
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Accumulated Signal

The Accumulate option enables you to view increasing signals in real time. If you plan to 
accumulate signals, it is recommended that you perform a test acquisition to optimize 
settings so that the photographic image, luminescent, or fluorescent signal is not 
saturated. 

To perform a test acquisition:
1. Confirm that the Accumulate option is selected. Do not select the Auto color scale 

option.

2. Start the acquisition (click the Record button ).

3. If the photographic image is saturated, stop the acquisition (click the  button) and 
reduce the photograph light level.

CAUTION!
CAUTION!  Extended acquisition of saturated images can shorten the life of the EMCCD 
and should be avoided.

4. Restart the acquisition. If necessary, repeat step 3 and step 4.

Color Scale Auto - If this option is chosen, the software chooses the color scale 
minimum and maximum. Note: Do not choose this option if the 
Accumulate option is selected.

Minimum - A user-specified threshold for the color scale minimum that is 
applied to the data if the Auto option is not selected. Intensity signals less 
than the minimum are not displayed. 

Maximum - A user-specified threshold for the color scale maximum that 
is applied to the data if the Auto option is not selected.

File Size Displays the file size of the kinetic stream (.dcm) being acquired. The file 
size display is only available in the Kinetic Acquisition panel.

Save Click to select an option for saving the data:

Save Current Image - Saves the currently selected frame (single image, 
photograph, and read bias).
Save Accumulated Image - Saves the accumulated signal for the selected 
frames (.tiff).
Save Kinetic Data - Saves all selected photographic, luminescent or 
fluorescent images (frames) and the read bias image (.dcm). The signal is 
not accumulated.

Done Closes the Kinetic Acquisition window

Table 6.1  Kinetic acquisition settings (continued)  

Item Description
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6.2  High Resolution Imaging With the Optical Zoom Lens Attachment

The optional Optical Zoom Lens attachment enables close up and high resolution imaging 
on the IVIS Lumina, IVIS Lumina XR, and IVIS Kinetic Imaging Systems. When the 
Zoom lens attachment is installed, only the �“Z�” field of view setting (2.6 cm) is available 
for single-image or sequence acquisition. 

The imaging system is set to the Z field of view position until the Zoom lens attachment 
is removed. If the Zoom lens attachment is installed when the Living Image software is 
closed, the stage will move to the Z position when the system is initialized.

NOTE
When installing or removing the Optical Zoom Lens attachment, avoid touching the optical 
glass.

Installing the Zoom Lens Attachment

1. Choose the Zoom option in the control panel (Figure 6.4).

You are prompted to insert the Zoom Lens attachment.

2. After you install the Zoom Lens attachment in the imaging chamber, click OK in the 
prompt.

The stage moves to the �“Z�” field of view position. 

NOTE
When the Zoom Lens attachment is installed, single images or sequential images can only 
be acquired at the Z field of view setting. During sequence setup, if you attempt to change 
away from the Z setting, the sequence table will be cleared. If you attempt to change from 
another field of view setting to the Z setting, the sequence table is cleared of all previous 
settings before the camera settings for the Z position are added.

Figure 6.4  Control panel, Zoom option selected
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Removing the Zoom Len Attachment

The imaging system is set to the �“Z�” field of view until the Zoom Lens attachment is 
removed. 

1. Remove the check mark next to Zoom in the control panel (Figure 6.5).

The stage moves to position C, then you are prompted to remove the lens attachment.

2. After you remove the Zoom Lens attachment, click OK in the prompt.

Always store the lens wrapped in its protective container.

6.3 Viewing & Editing Data in the Kinetic Acquisition Window

After stopping acquisition, you can view the data in the Kinetic Acquisition window. 

1. To start the playback, click the Play button . (After playback starts, the button 
changes to a Stop button .).

2. To stop the playback, click the Stop button .

3. To view a particular frame, do either of the following:

�• Move the top frame slider or enter a frame number in the box next to the frame slider

�• Click a location in the Maximum vs. Time graph

4. To select a particular range of kinetic data, move the start and end frames selection 
handles. Alternatively, enter a frame number in the box next to each slider. Only the 
selected frames will be played back or saved.

NOTE
Kinetic data (.dcm) can also be edited in the Image window. For more details, see page 109.

Figure 6.5  Control panel, remove the check mark next to Zoom
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Viewing Options

After acquisition has been stopped, right-click the image to access a shortcut menu of 
viewing options.

Figure 6.6  Acquisition window

Current frame number. Enter a new number 
or use the top slider to view another frame.

Start frame in a user-specified data range 

= Position of the displayed (current) frame

= Position of the start frame

= Position of the end frame

Frame number 121

Table 6.2  Kinetic view options

Item Description
Zoom Area To magnify a particular area, draw a box around the area that you want to 

zoom in on, right-click the area and select Zoom Area on the shortcut 
menu.

Zoom In Incrementally magnifies the view.

Zoom Out Incrementally reduces the magnification.

Reset Zoom Returns the image to the default display magnification.

Pan View Enables you to view a different area of a magnified image. To view 
another area of the image, choose this option, then click and hold the 
pointer while you move the mouse over the image. 

Crop Area To crop the image, draw a rectangle over the area of interest in the image, 
then right-click the area in the box and select Crop Area on the shortcut 
menu.

Draw Grid Displays a grid over the frame.

Display Color Bar Choose this option to display the color scale.

Display Color Min/Max Choose this option to display the color scale minimum and maximum.

Display Image Min/
Max

Choose this option to display the minimum and maximum signal.
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6.4 Saving Kinetic Data

The IVIS Kinetic instrument enables you to acquire a real-time data stream which can 
generate very large files. The file size limit for DICOM data is 2GB. Kinetic data 
acquisition automatically stops when this file size limit is reached. Table 6.3 shows how 
binning conditions affect the total number of frames that can be collected in overlay or 
luminescent/fluorescent only mode.

To save data:
1. In the Kinetic Acquisition window, click the Save button and select a save option.

2. In the Edit Image Labels box that appears, enter information for the image label and 
click OK. If you do not want to enter label information, click Cancel.

Table 6.3  Frames collected per 1 GB DICOM file

Binning Level Frame Size Overlay Mode Luminescent or 
Fluorescent Only DICOM File Size

Total Frames Collected

Bin 1 2 MB 250 500

Bin 2 512 KB 975 1950 1 GB

Bin 4 128 KB 3900 7800

Bin 8 32 KB 15600 31250

Bin 16 8 KB 62500 125000

Save Option Description
Save ' Current Image Saves the currently displayed frame.

Save ' Accumulated Image Saves the accumulated signal for the selected frames (.tiff). 

Note: It is not necessary to select the Accumulate option to save 
an accumulated image.

Save ' Kinetic Data Saves the data (photographic frames, all luminescent or 
fluorescent frames, and read bias) in DICOM format (.dcm).
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NOTE
You can edit and analyze kinetic data in the Image window.

6.5 Playing Kinetic Data

In the image window, you can:

�• Play kinetic data

�• Select and view a particular image

�• Select a range of images and extract as a separate kinetic data set

Figure 6.7  The Edit Image Labels box, Image window, and Tool Palette appear 
when saving an image or kinetic stream

Tool palette
Edit Image Labels box

Image window

Kinetic Acquisition 
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Figure 6.8  Image window, kinetic data

Current image number 
(top slider position). To 
select a particular 
image, enter a new 
number or move the 
top slider. 

Start frame (image) in 
the selected data range 
(left slider position) 

Current image 

End frame (image) in 
the selected data range 
(right slider position) 

Use the bottom sliders to select a 
range of data for viewing or export
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Figure 6.9  Image window, selecting kinetic data for export
Put the mouse arrow over a bottom slider to view a tooltip that shows the 
number of selected images (frames)

Table 6.4  Image window, kinetic data

Item Description
 Play Starts playing kinetic data.

 Stop Stops playing kinetic data.

 Edit and Save 
xxxxoptions

Shows or hides the bottom sliders that enable you to select a range of 
data and the Extract button that provides save options for the user-
selected image or data.

Accumulate If this option is chosen, the software computes and displays the 
cumulative intensity signal. Choose this option and playback the kinetic 
data to visualize accumulation as it happens.

Extract Click to select a save option for the current image or selected data.

Extract Current Image Displays the current image in a new image window.The software 
prompts you to save the image when you close the image window.

Extract Accumulated 
Image

The software computes the cumulative signal for each image (sum of 
the signal in all images up to and including the current image), then 
displays the cumulative signal of the current image in a new image 
window. The software prompts you to save the image when you close 
the image window.

Extract Kinetic Data Choose this option if you want to save a particular range of images. 
Opens the Browse For Folder dialog box that enables you to select 
where to save the selected data. 

Save As a Movie Saves the kinetic data set as a movie (.mp4, .mov, .avi, .mpg)
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Viewing Kinetic Data

1. Open the kinetic data.

2. To start playing the kinetic data, click the Play button . If you want to start the 
playback at a particular image, first move the top slider to the starting image, then 
click the Play button .

3. To stop playing data, click the Stop button .

4. To view the cumulative signal during playback, choose the Accumulate option. If the 
accumulated image maximum exceeds the current color scale range, use the image 
adjust tools to adjust the color scale. 

Kinetic Plot

The Kinetic Plot is a graph of the maximum signal versus time. To view the Kinetic Plot, 
click the  button in the Image Information tools.

Exporting Kinetic Data

You can select a range of images for export to DICOM format (includes photographs, 
intensity signal, and read bias) or to a movie. 

1. In the image window, click the  button (Figure 6.9, page 80). 

2. If you want to select a particular range of data for export, use the frame range selection 
to select the data. Use the left slider to select the start image and the right slider to 
select the end image in the data range of interest. 

The top slider automatically moves to denote the location of the current image with 
respect to the selected data range. 

3. To export the selected data to a movie:

a. Click Extract and choose Save as a Movie.

b.  In the dialog box that appears, select a folder, enter a name for the movie, and 
choose the file format (for example, .mpg4).

Figure 6.10  Kinetic Plot
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Exporting an Image from a Kinetic Data Set

1. To select an image, move the frame slider or enter a frame number in the spin box.

2. Click Extract and choose Extract Current Image.

A new image window appears and displays the selected image.

3. To save a snapshot of the current image, click the Export Graphics button  in the image 
window. In the dialog box that appears, select a destination folder, enter a file name, select a 
file type, and click Save.

Figure 6.11  Image window, selecting an image for export

Spin box

Export Graphics 
button

Frame slider
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This chapter explains how to open (load), view, and perform other operations on the 
optical image data obtained on an IVIS® Imaging System. 

7.1 Opening Optical Image Data

You can load optical images from the:

�• Living Image Browser (see below)

�• Toolbar or menu bar (page 87)

Multiple data sets can be open at the same time.

NOTE
To open a recently viewed file, select File → Recent Files on the menu bar.

Loading Optical Images From the Living Image Browser

The Living Image Browser provides a convenient way to browse and preview optical data, 
view information about the data, and load the data. 

To start the browser:

1. Click the Browse button . Alternatively, select File → Browse on the menu bar.

2. In the dialog box that appears, select the folder of interest and click OK.

The Living Image Browser appears (Figure 7.1).
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NOTE
The next time you start the Living Image software and open the Browse For Folder box, the 
software automatically returns to the last folder visited.

The Living Image Browser displays the selected data along with the user ID, label 
information, and camera configuration information. 

 - image 

 - image sequence

 - kinetic data or image exported as DICOM file

Figure 7.1  Opening the Living Image Browser

Living Image Browser
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3. To load data, do one of the following:

�• Double-click the data row

�• Right-click the data name and select Load on the shortcut menu

�• Select the data row and click Load.

�• Double-click the thumbnail

The image(s) and Tool Palette are displayed. Green rows in the browser indicate 
loaded data (Figure 7.3). 

Figure 7.2  Living Image Browser 

Click a column header to sort 
the browser contents in 
ascending alpha numeric 
order. Click the column header 
again to sort in descending 
alpha numeric order.

To expand a sequence, click 
the  arrow next to .

To view data properties, 
right-click a row and 
select Properties on 
the shortcut menu.

To preview data, click a row. 

Note: A preview is only available if a “snapshot” was taken of 
the image or sequence thumbnails in the image window. For 
more details on acquiring a snapshot, see Chapter 4, page 25.
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Figure 7.3  Image sequences opened (“loaded”)
Multiple data sets can be loaded at the same time.

Table 7.1  Living Image Browser

Item Description
Hide Browse View Closes the browser table.

Close Preview Closes the image preview box.

Label Set A drop-down list of the available label sets which specify image information 
(column headers) that is displayed in the Living Image Browser.

Add to List If this option is chosen, the selected in the Browse for Folder box is added 
to the Living Image Browser. If this option is not chosen, the data selected 
in the Browse for Folder box replaces the contents of the Living Image 
Browser, except for loaded data.

Browse Opens the Browse For Folder box.

View The name of the Living Image Browser configuration (the column headers 
and their order in the browser). 

Configure Opens a dialog box that enables you create and save custom Living Image 
Browser configurations. 

Note: To reorder a column in the browser, click the column header, then 
press the mouse key while you drag the header left or right. Release the 
mouse key to set the new position.
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Opening Data from the Menu or Toolbar

NOTE
To open a recently viewed file, select File → Recent Files on the menu bar.

1. Click the Open button  on the toolbar. Alternatively, select File → Open on the 
menu bar.

2. In the box that appears, choose a file type filter from the drop-down list (Figure 7.4).

Load as Group Enables you to select particular images that you want to view as a 
sequence. The images may be acquired during different sessions.

To select adjacent images in the browser, press and hold the Shift key 
while you click the first and last file in the selection. 

To select non-adjacent images in the browser: 

PC users: Press and hold the Ctrl key while you click the images in the 
browser
Macintosh users: Press and hold the Cmd key (apple key) while you click the 
images in the browser. 

Note: The Load as Group option is only available when two or more images 
(non-kinetic) are selected in the browser.

Load Opens the selected image or image sequence.

Remove Removes a user-selected image sequence(s) from the browser.

Close Closes the Living Image Browser.

Table 7.1  Living Image Browser (continued)  

Item Description

Figure 7.4  Opening data from the toolbar or menu bar

Select the file type(s)
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3. Navigate to the file and click double-click it. Alternatively, select the data and click 
Open.

Organizing Images 

When multiple image windows are open, you can organize them in a cascade or tile 
arrangement. 

Choose Window → Cascade or Window→ Tile on the menu bar.

File Type Filter Shows:
Living Image files Click*.txt �– an image (Living Image file format).

Sequence*.txt �– an image sequence (Living Image file format).

*.dcm �– kinetic data or an image that was exported to a DICOM file.

TIFF Image Files Graphic files (*.tif, *.tiff).

All Files (*.*) All file types.

Figure 7.5  Image windows: cascade (top) or tiled (bottom)
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7.2  About the Image Window & Tool Palette

Image Window

An image, image sequence, or kinetic data set is displayed in an image window. Multiple 
image windows can be open at the same time. 

Figure 7.6  Image windows, sequence view and single image
The options available in the image window depend on the type of active image data.

Table 7.2  Image window 

Item Description
Units Select the measurement units for the image display from this drop-down list. The 

available units depend on the type of image data. For more details on 
measurement units, see page 281.

Use Saved 
Colors (image 
sequence)

Choose this option to display the image data using the color table that was 
specified in the Preferences at the time of acquisition. If this option is not 
selected, image data are displayed using the color table currently specified in the 
Preferences. 

Double-click an image in 
the sequence to view it in 
a separate image window

Tool palette
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Options 

(image 
sequence)

Layout �– Choose a display option for the images in a sequence (Default, Dynamic, 
or Film Strip). For example, here is Film Strip mode:

Sort by �– Options for ordering images in the sequence window:

Default �– Order in which the images are stored in the folder.
TimeStamp �– Ascending order of the image acquisition time.
UserID �– Ascending alphanumeric order of the user ID.

Display - Choose the types of information to display with each image.

Lablels �– Enables you to select the information to include in the image label.

Table 7.2  Image window  (continued)  

Item Description

In this example, exposure 
time and binning factor are 
displayed on each image 

Image label
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Info Click to show or hide the image label. The image label includes information you 
enter in the Edit Image Labels dialog box (see page 23) and other information 
automatically recorded by the software.

Opens all of the images in a sequence.

Closes all open images of a sequence.

Opens the Edit Sequence dialog box that enables you to add or remove images 
from a sequence.

Opens a dialog box that enables you to export the active view as a graphic file.

Takes a �“snapshot�” that is displayed with the data in the Living Image Browser. 
For more details on the browser, see page 83.

Display 

(single image)

A list of image types available for display, for example, overlay. For more details 
on the different types of image displays, see Table 2.2, page 8.

Note: If the acquisition included more than two imaging modes (for example, 
luminescent, x-ray, and photograph), additional drop-down lists appear so you can 
choose any two images to overlay. 

To change the foreground or background, click the button or select from the drop-
down list.

Options 
(single image)

Enables you to select the type of information to include in the image label.

Table 7.2  Image window  (continued)  

Item Description

Snapshots of an image sequence

Image label
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Tool Palette

The Tool Palette appears when you open an image or sequence. The options available in 
the Tool Palette depend on the type of active image data. 

Color Scale

(single image)

Provides a reference for the pixel intensities in a luminescent or fluorescent 
image. Pixels less than the color scale minimum do not appear in the image. Pixels 
greater than the color scale maximum are displayed in the maximum color

Table 7.2  Image window  (continued)  

Item Description

Figure 7.7  Tool palette
For an overview of the tools, see Figure 2.4 on page 11and Figure 2.5 on page 12. 

Click to expand a tool.
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7.3  Viewing Image Information

At acquisition, the software captures image information that includes all of the text 
information that is associated with an image, for example, camera parameters and any 
image label information entered at acquisition (Figure 7.8).

Another way to view information about images is available in the View menu.

1. Open an image or sequence.

2. Select View → Image Information on the menu bar.

The Image Information window appears.

3. Choose an image by making a selection from the Sequences drop-down list and the 
Images drop-down list (Figure 7.9).

Figure 7.8  Image window displaying image information

Click Info to display the image label and acquisition information

Image label
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4. To view particular information, select a category in the upper box to show the 
associated information in the lower box. For example, select luminescent image in the 
upper box to show the luminescent image acquisition parameters.

Editing the Image Label

You can edit image label information or add information to the label after acquisition.

To edit the image information:

1. Open an image or sequence.

2. Click Info to display the image label.

Figure 7.9  Viewing image information

Drop-down list of images in the selected sequence. 
Or a list of single images if “Individual Images” is 
selected in the Sequences drop-down list.

Drop-down list of open sequences. 
Choose Individual Images from the 
list to show the open single images in 
the Images drop-down list.

Choose the Show All 
Sections option to 
display all categories 
of image information.

Figure 7.10  Image information

Edit an entry. For 
example, revise 
the comment.
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3. Edit the label information.

To add information to the image label:

1. Click the  toolbar button. Alternatively, select Edit → Image Labels on the menu 
bar.

2. In the Edit Image Labels box that appears, select information and/or enter a comment 
(Figure 7.11).

NOTE
If a single image is active, changes are applied to that image only. If a sequence is active, 
changes are applied to each image of the sequence.

3. When finished, click OK.

The image information is updated.

4. Save the image to save the updated image label (select File → Save or File → Save 
As on the menu bar).

7.4 Adding Comments or Tags to an Image

Adding Comments

Comments can be added to an image and saved with the image.

1. Open an image.

2. Right-click the image and select Insert Comment on the shortcut menu. Enter 
comments in the yellow box that appears (Figure 7.12).

To reposition a comment: 

1. Position the mouse pointer over the comment.

2. When the hand tool appears , use a click-and-drag operation to move the comment 
box, then click the mouse to set the location.

To remove a comment(s):

�• To remove a comment, right-click the comment and select Remove Comment on 
the shortcut menu.

�• To remove all comments, right-click the image and select Remove All Comments 
on the shortcut menu.

Figure 7.11  Edit Image Labels
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Tagging an Image

An image tag displays the x,y pixel coordinates of the location, and the pixel intensity (z, 
counts or photons). You can apply a tag at a user-selected location in an image. 

To apply a tag:

1. Right-click a location in the image. 

2. Select Insert Tag on the short cut menu.

Figure 7.12  Add a comment to an image

Figure 7.13  Insert a tag on an image (left), move the tag label (right)
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To move a tag:

1. Position the mouse pointer over the tag.

2. When the hand tool appears , use a click-and-drag operation to move the tag, then 
click the mouse to set the tag location.

A line between the pixel and the tag identifies the location associated with the tag.

7.5 Adjusting Image Appearance

Use the image adjust tools to adjust the appearance of an image (Figure 7.14).

NOTE
Not all tools are available for all image display modes.

Figure 7.14  Tool palette, Image Adjust tools 

Table 7.3  Image Adjust tools

Item Description
Click this button to incrementally zoom out on the image (reduces the image 
dimensions in the image window). Note: The zoom tools are also available in the 
shortcut menu when you right-click the image (Ctrl-click for Macintosh users).

Click this button to incrementally zoom in on the image (incrementally magnifies 
the image in the image window).

Click this button to magnify the area inside a rectangle that you draw using a 
click-and-drag operation. (Sets the dimensions of the magnified area equal to 
image window dimensions.)

Click this button to return the image to the default display magnification.

Color scale Min and Max

Image 
Adjust tools
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Magnifying or Panning in the Image Window

To incrementally zoom in or out on an image:

Click the  or  button. Alternatively, right-click the image and select Zoom In or 
Zoom Out on the shortcut menu.

To magnify a selected area in an image:

1. Click the  button. Alternatively, right-click the image and select Area Zoom on the 
shortcut menu.

Click this button to move a magnified image (pan) in the image window. For more 
details, see page 99.

Click this button to hide or display the image min/max information in the image 
window

Click this button to hide or display the color scale in the image window

Click this button to hide or display the color scale min/max information in the 
image window

Photo 
Adjustment

Brightness �– Click and move the slider left or right to adjust the brightness of an 
image displayed in overlay or photograph mode. Alternatively, enter a brightness 
value.

Contrast �– Click and move the slider left or right to adjust the gamma of an image 
displayed in overlay mode. Alternatively, enter a gamma value. (Gamma is related 
to image contrast.)

Opacity �– Click and move the slider left or right to adjust the opacity of the 
pseudocolor luminescent data of an image displayed in overlay mode. 
Alternatively, enter an opacity value.

Color Scale Min �– The minimum pixel intensity associated with the color scale for an image. 
Pixels less than the minimum value are not displayed.

Max �– The maximum pixel intensity associated with the color scale for an image. 
Pixels greater than the maximum value are displayed in the maximum color.

Color Scale 
Limits

Auto �– If this option is chosen, the software sets the Min and Max values to 
optimize image display and suppress background noise. The Min and Max 
settings can be manually adjusted to further optimize the image display for your 
needs.

Full �– Choose this option to set the Max and Min values to the maximum and 
minimum data values in the image.

Manual �– Choose this option to enter Max and Min values for the image display.

Individual �– Applies a separate color table to each image in a sequence. Note: 
This option is only available when an image sequence is active.

Color Table  

Click the drop-down arrow to select a color table for the image data. (For more 
details on color tables, see Pseudocolor Images, page 279.)

Reverse �– Choose this option to reverse the selected color table.

Logarithmic Scale �– Choose this option to apply a log scale to the relationship 
between numerical data and the color range in the color table. A log scale 
increases the range of meaningful numerical data that can be displayed.

Table 7.3  Image Adjust tools (continued)  

Item Description
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2. When the pointer becomes a +, draw a rectangle around the area that you want to 
magnify.

The selected area is magnified when you release the mouse button.

To reset the magnification (remove magnification):

Click the  button. Alternatively, right-click the image and select Reset Zoom on the 
shortcut menu.

To pan the image window:

NOTE
Panning helps you view different areas of a magnified image. If the image has not been 
magnified, you cannot pan the image.

1. Click the  button. 

2. When the pointer becomes a ., click and hold the pointer while you move the mouse.

7.6 Correcting Optical Image Data

Use the Corrections/Filtering tools to subtract background or apply corrections to the 
optical image data. (For more details on sources of background, see Appendix E, 
page 285.) You can also apply smoothing and soft binning to the image data. (For more 
information on binning and smoothing, see Appendix C, page 275.)

Figure 7.15  Tool palette, Corrections/Filtering tools

Table 7.4  Tool palette, Corrections/Filtering tools

Tool Description
Read Bias 
Subtraction/Dark 
Charge Subtraction

Select this check box to subtract dark background from the image data. If 
a dark charge image is available for the imaging conditions, the dark 
background image, including read bias noise, will be subtracted. 
Otherwise, only read bias noise will be subtracted. For more details on 
background, see Appendix E, page 285. 

Note: In Radiance (Photons) mode, dark background or read bias 
subtraction is a mandatory default. In counts mode, the check box can be 
cleared.

Read Bias Subtraction and Flat 
Field Correction are default 
mandatory corrections in photons 
mode. In counts mode, these 
corrections can be cleared.
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Flat Field Correction Select this check box to apply a lens correction factor to the image data. 
For more details on flat field correction, see Appendix D, page 284. Note: 
In photons mode, flat field correction is a mandatory default. In counts 
mode, the check box can be cleared.

Cosmic Correction Select this check box to correct image data for cosmic rays or other 
ionizing radiation that interact with the CCD. For more details on cosmic 
correction, see Appendix D, page 284.

Adaptive FL 
Background 
Subtraction

Opens the Photo Mask Setup box that enables you to set the photo mask 
for adaptive fluorescent background subtraction. For more details on 
adaptive fluorescent background subtraction, see Appendix F, page 305.

Binning Specifies the number of pixels in the image data that are grouped together 
to form a larger pixel (called soft binning). Binning changes the pixel size 
in the image (Figure 7.16). For more details on binning, see Appendix C, 
page 276.

Smoothing Computes the average signal of the specified number of pixels and 
replaces the original signal with the average signal (Figure 7.16). 
Smoothing removes signal noise without changing pixel size.

Click this button to return the binning or smoothing to the previous setting 
and update the image.

Figure 7.16  Example of binning and smoothing image data

Table 7.4  Tool palette, Corrections/Filtering tools (continued)  

Tool Description

Binning at acquisition = 8, no smoothing Binning = 2, smoothing = 5x5
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7.7  Viewing Intensity Data & Making Measurements

The Image Information tools enable you to view intensity data and measure distance on 
an image. You can view pixel data in different formats:

Image Information Description See Page
x,y coordinates and 
associated intensity

The x,y pixel coordinates of the mouse pointer location in the 
image and the intensity (counts or photons) at that location.

102

Histogram Histogram of pixel intensities in an image. 103

Line profile Plots a line graph of intensity data at each pixel along a user-
specified horizontal or vertical line in the image

104

Figure 7.17  Tool Palette, Image Information tools

Table 7.5  Tool palette, Image Information tools

Tool Description
Click this button to display a histogram of pixel intensity. For more details, see 
page 103.

Click this button to display a line profile. For more details, see page 104.

Click this button to display a 3D representation of signal itensity. For mre details, 
see page 106.

Click this button to display the distance measurement cursor in the image 
window. For more details, see page 107.

Click this button to draw and measure a rectangle on an image. For more details, 
see page 108.

Click this button to display/hide a scale on the x and y-axis of the image window.

Click this button to display/hide a grid the image window.
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Viewing X,Y Coordinates & Intensity Data

1. Open an image, and the Image Information tools, choose Cm or Pixels from the Units 
drop-down list.

2. Put the mouse pointer over a location of in the image.

The x,y coordinates and intensity data are displayed in the Tool Palette.

Units Choose the units (cm or pixels) for distance measurements in the image window.

Image Binning �– The binning applied to the image. Note: If soft binning is applied to the 
image data, and the binning level is changed from 8 to 16, the new binning is 
indicated as 8x2.

Width/Height �– The FOV dimensions. Note: If �“Pixels�” is selected from the Units 
drop-down list, the dimensions are provided in terms of binned pixels.

Image X,Y �– The x,y pixel coordinates of the mouse pointer location in the image.

Image Data �– The intensity (counts or photons) at the pixel location of the mouse 
pointer.

Crop/Distance The x,y pixel coordinates at the upper left corner of the crop tool.

OR

The x,y pixel coordinates at the �“A�” end of the distance.

The x,y pixel coordinates at the lower right corner of the crop tool.

OR

The x,y pixel coordinates at the �“B�” end of the distance.

The width and height of the image crop tool.

OR
∆x, ∆y from the A to B end of the distance measurement cursor.

For more details, see page 107 and 108.

Table 7.5  Tool palette, Image Information tools (continued)   (continued)  

Tool Description

Figure 7.18  x,y coordinates and intensity data at the mouse pointer location

x,y coordinates and 
intensity data at the 
pointer location
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Image Histogram

The image histogram plots a frequency distribution of the pixel intensities in an image. 
The software sorts the intensities into groups or bins (x-axis) and plots the number of 
pixels per bin (y-axis). 

To view the image histogram:

1. Open an image, and in the Image Information tools, click the Image Histogram button 
.

NOTE
By default the Auto min/max range of the image data determines the histogram range and 
bins (the software sets the min and max values to optimize image display and suppress 
background noise). To display the histogram using the full intensity range of the image, click 
Full in the Histogram window.

2. To edit the minimum or maximum bin intensity, enter a new value in the Min Bin or 
Max Bin box, or click the  arrows.

3. To edit the number of bins, enter a new value in the # Bins box or click the  arrows.

NOTE
In the Overlay display mode, the histogram plots the luminescent data. To obtain a histogram 
of the photograph, select Photograph from the Display drop-down list.

Figure 7.19  View a histogram of pixel intensities

Table 7.6  Histogram window

Item Description
Full Displays the histogram using the full intensity range of the image.

Min Bin The lowest intensity bin.

Max Bin The highest intensity bin.

# Bins The total number of bins.

Opens a dialog box that enables you to export the histogram (.csv).
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Line Profile

The line profile plots intensity (y-axis) at each pixel (x-axis) along a user-specified line 
in the image. The line profile is automatically updated when you change the line position.

NOTE
In the Overlay display mode, the line profile plots the luminescent data. To obtain a histogram 
of the photograph, select Photograph from the Display drop-down list.

To display the line profile:

1. Open an image, and in the Image Information tools, click the Line Profile button .

A line appears on the image and the Line Profile window appears.

2. To view the line profile at another location in the image, put the mouse pointer over 
the line. When the pointer becomes a , drag the line over the image. The blue part 
of the line indicates the pixel intensities that are plotted in the line profile graph.

Copies the histogram to the system clipboard.

Opens the print dialog box.

Table 7.6  Histogram window (continued)  

Item Description

Figure 7.20  Viewing a line profile of pixel intensities

Line Profile window
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The line profile is updated as you move the line move over the image.

Table 7.7  Line Profile window

Item Description
Line Orientation Choose Vertical, Horizontal, or Free Hand from the drop-down list to set the 

orientation of the line in the image window. The Free Hand orientation 
enables you to drag each line segment endpoint to a user- selected position.

Width Sets the line width.

Position Line position (pixels).

Enables you to choose the grid line pattern to display in the line profile 
window. 

Exports the line profile data to a .csv or .txt file.

Copies the line profile graph to the system clipboard.

Opens the Print dialog box.

X Min

X Max

Displays the minimum and maximum value of the x-axis. Use the  arrows 
to change the x-axis min or max. If �“photons�” is selected in the image 
window, the x-axis units = pixels. If �“counts�” is selected in the image 
window, the x-axis units = cm. To display the range available for the Min or 
Max, place the mouse pointer over the Min or Max edit box.

Y Min

Y Max

Displays the minimum and maximum value of the y-axis. Use the  arrows 
to change the y-axis min or max. To display the range available for the Y Min 
or Y Max, place the mouse pointer over the Min or Max edit box.

Click to reset the X and Y Min and Max values to the defaults.

Full Scale Select this option to display the full X and Y-axis scales.

Logarithmic Scale Select this option to apply a log scale to the y-axis.
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Viewing 3D Signal Intensity

1. Open an image and then click the Plot 3D button  in the Image Information tools.

A 3D representation of all signals in the image is displayed in the 3D Plot window 
(Figure 7.21).

2. To change the display, make a selection from the Plot drop-down list and click the 
Refresh button .

Figure 7.21  3D intensity signal

Table 7.8  3D Plot Window

Item Description
Plot Full Image �– Displays all signals in the image.

ROI <ROI number or name> �– Displays the signal within the 
selected ROI.

All ROIs �– Displays the signal within all ROIs in the image.

Z Max Height of the z-axis. Use the up/down arrows to change the 
height of the z-axis.

Click to reset the z-axis to the default setting.

Copies the 3D window to the system clipboard.

Opens a Print dialog box that enables you to print the 3D window.
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Making Measurements

To measure distance with the measurement cursor:

1. Open an image and click the Distance Measurement Cursor button  in the Image 
Information tools.

A measurement cursor ( ) appears on the image (Figure 7.22). The Tool 
Palette shows the position and length of the cursor.

2. To change the cursor position or size, drag the A or B end of the cursor to a new 
location on the image.

The measurement information in the Tool Palette is updated.

3. To hide the cursor, click the  button.

Figure 7.22  Measurement cursor
The Tool Palette displays the measurement cursor position and length.

Table 7.9  Measurement cursor position & length

Item Description
Pixel x,y coordinates of position A on the cursor.

Pixel x,y coordinates of position B on the cursor.

Length of the cursor from A to B (number of pixels), vertical distance from 
A to B (number of pixels).

Distance Length of the cursor from A to B (number of pixels).

Measurement cursor 
position and length
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To measure distance using the crop box:

1. Open an image, and in the Image Information tools, click the Image Crop button .

2. When the mouse pointer changes to a +, draw a rectangle on the area of interest.

3. To change the size or position of the crop box, drag a handle  at a corner or side of 
the box.

4. To delete the crop box from the image, click the  button.

Figure 7.23  Using a crop box to make measurements

Table 7.10  Crop box position & dimensions

Item Description
x,y coordinates at the upper left corner of the box.

x,y coordinates of lower right corner of the box.

Box width and height.

Distance Length of the diagonal from the upper left to lower right corner of the box.

Crop box position 
and dimensions
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7.8  Creating a Transillumination Overview

The transillumination overview tool combines the images of a FLIT sequence (a 
fluorescence sequence acquired in transillumination mode) into a single image. All of the 
individual fluorescent signals are stacked over one photograph and the intensity is 
summed. One overview is created per filter pair. If two filter pairs were used during 
acquisition, then two overview images will be created. 

All transillumination locations are displayed simultaneously; a tool tip displays the 
transillumination position when you mouse over a transillumination point. An overview 
image is displayed in radiant efficiency and can be analyzed using the tools in the Tool 
Palette.

NOTE
If you choose the Raster Scan option in the Transillumination Setup box, the overview image 
is automatically generated. For more details, see page 30.

1. Load a sequence that was acquired in fluorescence transillumination mode.

2. Click the  button. Alternatively, select Tools → Transillumination 
Overview for <name>_SEQ on the menu bar.

The overview appears.

Figure 7.24  Transillumination overview
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7.9  Overlaying Multiple Images

The image overlay tool provides a convenient way to view multiple reporters in one 
image. You can use the image overlay tool to display multiple luminescence or 
fluorescence images on one photographic image. 

To coregister multiple images:

1. Acquire an image sequence using the appropriate filters for each reporter. 
Alternatively, create a sequence from images acquired during different sessions. (For 
more details, see page 117.)

2. Load the image sequence. 

3. Open one of the images and optimize the image display using the color scale Min and 
Max sliders in the Image Adjust tools. 

To view all images in the sequence, click the Display All button  to open each image 
(overlay mode) in a separate image window.

4. Select Tools→ Image Overlay for <sequence name>_SEQ on the menu bar.

The image overlay window appears and shows the first photograph in the sequence.To 
view a different photograph, make a selection from the photograph drop-down list.

Figure 7.25  Image sequence
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5. To overlay all images, click the  button.

The overlay appears. The photograph is at the bottom of the stack and the last 
fluorescent or luminescent image in the list is at the top of the stack.

Figure 7.26  Image Overlay window

Figure 7.27  Generated overlay

Table 7.11  Image Overlay window

Item Description
Units Choose the type of units for displaying the fluorescent or luminescent 

image. For more details on measurement units, see page 281. 

Photograph A drop-down list of the photographs in the image sequence.

Fluorescent or 
Luminescent Images

The sequence images. 
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Copies the overlay to the system clipboard. 

Click to export the overlay to a graphic file.

Click to include all fluorescent or luminescent images in the overlay.

Click to remove all fluorescent or luminescent images from the 
photograph.

Image Adjust Tools for adjusting the appearance of the highlighted fluorescent or 
luminescent image. Adjustments can only be made on one image at a 
time. 

Min �– The minimum pixel intensity associated with the color scale for 
an image. Pixels less than the minimum value are not displayed.

Max �– The maximum pixel intensity associated with the color scale for 
an image. Pixels greater than the maximum value are displayed in the 
maximum color.

Opacity �– Controls the opacity of the fluorescent or luminescent image.

Color Table Tools selecting and modifying the color scale associated with an image.

Color Scale Type �– Choose BlackLevel to show black at the low end of 
the color scale. Choose WhiteLevel to show white at the low end of the 
color scale.

 Click the drop-down arrow to select a color table 
for the image data. (For more details on color tables, see Pseudocolor 
Images, page 279.)

Reverse �– Choose this option to reverse the selected color table.

Logarithmic �– Choose this option to apply a log scale to the relationship 
between numerical data and the color range in the color table. A log 
scale increases the range of meaningful numerical data that can be 
displayed.

Palette label To include a brief line of text next to the color scale, enter text in the 
palette label box, then press the Enter key. To remove the text from the 
image window, delete the text in the palette label box and press Enter.

Scales per Column Sets the number of color scales to display in a column.

Table 7.11  Image Overlay window

Item Description
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7.10  Rendering Intensity Data in Color

The colorize tool renders luminescence or fluorescence data in color, enabling you to see 
both intensity and spectral information in a single view. The tool provides a useful way 
to visualize multiple probes or scale probe signals that are not in the visible range.

To view colorized intensity data:

1. Load an image sequence.

2. Select Tools → Colorize on the menu bar.

The software renders each luminescent or fluorescent image in color and combines 
them into a single image (Figure 7.29).

Figure 7.28  Microplate images
Images were acquired using different combinations of excitation and 
emission filters. The samples are quantum dot nanocrystals (700 or 800 nm).

Figure 7.29  Colorize view
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7.11 Exporting or Printing Images

The Image Layout window (Figure 7.30) provides an alternative way to:

�• Annotate and export an image (for example, .bmp)

�• Print an image

�• Copy an image to the system clipboard

1. To open the Image Layout window, select View → Image Layout Window on the 
menu bar.

2. To paste the active image into the Image Layout window, click the  button.

3. To resize the image, drag a handle  at a corner of the image.

4. To reposition the image in the window, drag the image.

Table 7.12  Colorize tools

Item Description
Colorize View

Color Map NIR �– A special camera setup that extends the color response into the near 
infrared range. Near infrared fluorophores appear red to purple using the NIR 
camera setup.

VIS �– Regular camera setup that mainly renders color in the visible range. It is 
similar to the color response of a commercial digital camera. NIR fluorophores 
appear dark red to invisible using the VIS camera setup.

Color Range The color map indicates the color range of the selected camera setup from 
short to long wavelength. The two sliders determine the lower and upper limits 
of the color range that is used to render color. The parts of the color map 
outside the selected range are not used in the color rendering process. By 
default, the entire color range is selected.

Filter Range The wavelength range of the luminescent images in the sequence. The two 
sliders determine the lower and upper end of the filter range. Only the parts of 
the image that are within the selected wavelength range are colorized. By 
default, the entire filter range is selected.

Log Scale If this option is chosen, the dynamic range of the brightness in the image is 
compressed using a log scale. This improves the visibility of dark areas in the 
image.

Real Color If this option is chosen, the colors are rendered using the wavelengths that 
directly correspond to the camera setup. For example, GFP appears green 
using real color rendering.

If this option is not chosen, the original wavelength range of the image is 
modified to include the entire visible wavelength range of the camera setup. 
This helps improve the color contrast.

Click this button to copy the colorize view to the system clipboard.

Click this button to export the colorize view as a graphic file (for example, .jpg).

Click this button to print the colorize view.
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Figure 7.30  Image Layout window

Table 7.13  Image Layout window

Item Description
Clears the Image Layout window. 

Note: If you do not clear the layout (click the button) before you close the 
Image Layout window, the same window contents are displayed the next time 
the window is opened

Opens a dialog box that enables you to save the Image Layout window 
contents to a graphic file.

Pastes an image of the active data in the Image Layout window.

Copies the contents of the Image Layout window to the system clipboard.

Pastes the contents of the system clipboard to the Image Layout window.

Rectangle drawing tool

Ellipse drawing tool

Pointer tool

Arrow and line drawing tool

Select an the item in the Image Layout window. To move the item to the front 
or back in the window, choose an option from the  drop-down list.

Deletes the selected image.
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7.12 Editing an Image Sequence

You can add or remove individual images from a sequence. Only individual images, not 
an image sequence, can be added to a sequence.

1. Open the image sequence that you want to edit.

2. If you plan to add images to the sequence, browse for the images that you want to add 
in the Living Image® browser. (For more details on browsing, see page 83.)

NOTE
If you plan to add images to the sequence, browse for the images that you want to add in the 
Living Image Browser. (For more details on the browser, see page 83.)

3. In the image window, click the Edit button .

A drop-down list of formatting options for the Image Layout window. For 
example, the 2x2 layout style provides 4 separate layout areas in the window. 
A different image can be pasted into each layout area. 

To apply notes to an image, enter text in the annotation box and press Enter. 
Drag the text to the location of interest in the image.

Opens a dialog box that enables you to select a font or edit the font style and 
size.

Opens a color palette that enables you to select a font color or specify a 
custom font color.

Opens a text editor that enables you to edit the selected text.

Table 7.13  Image Layout window (continued)  

Item Description

Figure 7.31  Opening the Edit Sequence dialog box

Images in the 
active sequence

Single images in the Living 
Image Browser that can be 
added to the sequence

Images that have 
been removed from 
the active sequence
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4. In the Edit Sequence box that appears, choose the image(s) to add or remove (retire) 
from the sequence (Figure 7.31). 

To add an image to the sequence, select an image from the �“Browser Images�” and click 
Copy. To remove an image from the sequence, choose an image from �“Sequence 
Clicks�” and click Retire.

5. To restore a retired image to the sequence, select the retired image and click 
Reactivate.

6. To reorder the sequence, select an image and click Move Up or Move Down. 

NOTE
The Move Up and Move Down buttons are only available when the sequence view window 
displays images in the default sort order. If the TimeStamp or UserID sort order is selected, 
the images cannot be reordered.

7. When you are finished editing the sequence, click Close.

The updated image sequence is displayed.

7.13 Creating an Image Sequence from Individual Images

You can create a sequence from images acquired during different sessions.

1. In the Living Image Browser, browse for the images of interest. (For more details on 
browsing, see page 83.)

NOTE
Browse for individual images (which may or may not be part of a sequence), not image 
sequences.

2. In the browser, select the images that you want to group together.

Figure 7.32  Living Image Browser

Individual images (highlighted blue in this example) that may or may not be part 
of a sequence can be selected for grouping into a new sequence.

Images loaded in the browser as part of a sequence (highlighted yellow in this 
example). These images can also be selected for grouping into another sequence.
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To select adjacent images in the browser, press and hold the Shift key while you click 
the first and last file in the selection. 

To select non-adjacent images in the browser: 

�• PC users - Press and hold the Ctrl key while you click the images of interest in the 
browser. 

�• Macintosh users - Press and hold the Cmd key (apple key) while you click the 
images of interest in the browser.

3. Click Load as Group.

The image thumbnails are displayed together in an image window. 

4. To save the images as a sequence:

a. Click the Save button . Alternatively, select File → Save on the menu bar.

b. In the dialog box that appears, select a folder and click OK.
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8.1 About ROIs

A region of interest (ROI) is a user-specified area in an optical image (Figure 8.1). The 
ROI tools enable you to create three types of ROIs: measurement, average background, or 
subject ROI (Table 8.1). During a session, the Living Image software records information 
about the ROIs you create and computes statistical data for the ROI measurements. The 
ROI Measurements table displays the data and provides a convenient way to review or 
export ROI information (Figure 8.1). (For more details, see Managing the ROI 
Measurements Table, page 145.)

Figure 8.1  Example measurement ROIs and ROI measurements table

ROI Measurements table
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8.2 Quick Guide: Drawing Measurement ROIs on an Image or Sequence

These steps provide a quick guide on how to apply a measurement ROI to an optical image 
or image sequence. For more details about measurement ROIs, see page 125.

1. Open an image or sequence and click ROI Tools in the Tool Palette.

2. In the ROI tools, select Measurement ROI from the Type drop-down list.

3. Click the Contour button  and make a selection from the drop-down list.

Image or image or sequence �– Select Auto All from the drop-down list. 

Kinetic data �– Select Kinetic ROI.

Table 8.1  Types of ROIs

Type of ROI
Measurement ROI Average Background ROI Subject ROI

Description

Measures the signal 
intensity in an area of 
an image. 

Measures the average signal 
intensity in a user-specified area of 
the image that is considered 
background. 

Note: Using this type of ROI is 
optional. If the animal has significant 
autoluminescence or 
autofluorescence, you can determine 
a background-corrected signal in a 
measurement ROI by subtracting an 
average background ROI from a 
measurement ROI. 

Identifies a subject animal in an 
image. 

Note: Using this type of ROI is 
optional. It provides a convenient 
way to automatically associate 
(link) a measurement and average 
background ROI for background-
corrected ROI measurements 
when there is significant 
autoluminescence or 
autofluorescence. 

Available ROI 
Drawing Methods 

�• Manual 

�• Automatic

�• Free draw 

�• Manual

�• Free draw 

�• Manual 

�• Automatic

�• Free draw

Available Shapes Circle, square, grid, or 
contour

Circle or square Square

Figure 8.2  Select a type of ROI
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The software automatically draws measurement ROIs on all images. The ROI label 
shows the total intensity in the ROI and the Threshold % (Figure 8.3).

NOTE
Auto ROIs are created and numbered in order from highest to lowest maximum signal within 
the ROI (ROI 1 contains the highest maximum signal). You may want to arrange the ROIs in 
a known order for easier comparison between images.To renumber the ROIs (ascending 
order from right to left), right-click the image and select Sort ROIs on the shortcut menu. If 
the "Apply to Sequence" option is selected in the ROI tools, choose "Sort ROIs in Sequence" 
to sort all of the ROIs in the sequence. The sort options are only available if the ROIs have 
not been sorted.

4. To adjust the ROI boundaries, change any of the auto ROI parameters using the slider 
or  arrows (Figure 8.4).

Figure 8.3  ROI intensity measurements
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NOTE
After the ROIs have been created, right-click an ROI to view a shortcut menu of ROI 
commands (Ctrl-click for Macintosh users). The shortcut menu provides easy access to many 
functions for managing ROIs and viewing ROI properties.

5. Click the Measure button  in the ROI tools to show the ROI Measurements 
table.

The ROI Measurements table displays data for all ROIs created in images or sequences 
during a session (one ROI per row). The table provides a convenient way to review and 
export ROI data. For more details on the table, see �“Managing the ROI Measurements 
Table,�” page 145.

Figure 8.4  Auto ROI parameters

Figure 8.5  ROI Measurements table

Threshold % - Specifies the minimum per 
cent of peak pixel intensity that a pixel must 
have to be included in an ROI identified by 
the software.
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8.3 ROI Tools

Table 8.2 provides brief explanations for the ROI tools. The ROI tools that appear in the 
Tool Palette depend on the type of ROI selected from the ROI Type drop-down list, and 
whether an image or sequence is active. Some ROI parameters are only available if �“Show 
Advanced Options�” is selected in the General Preferences. 

Figure 8.6  ROI tools

Table 8.2  ROI tools

Item Description
Click to select the number of circle ROIs to add to the active image. 

Click to select the number of square ROIs to add to the active image.

Click to specify the grid pattern for a measurement ROI that you want to add to 
the active image. This tool is useful for an image of a multi-well culture plate or 
microplate.

Click and select Auto All to automatically draw ROIs in the image using the auto 
ROI parameters. Click and select Auto 1 to automatically draw one ROI at a user-
selected location using the auto ROI parameters. For more details on using the 
auto ROI features, see page 127.

Click to display the ROI Measurements table or compute intensity signal in an ROI.

Click to display a drop-down list of options to delete an ROI(s) in the active image. 
For more details, see page 143.

Note: These commands do not delete the ROIs that are saved to the system 
(listed in the Menu Name drop-down list).

Apply to 
Sequence

Choose this option to apply the selected ROI to all images in a sequence.

These Auto ROI 
parameters are 
available if “Show 
Advanced Options” 
is selected in the 
General Preferences. 
For more details on 
setting Preferences, 
see Appendix B, 
page 265.
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Type Choose the ROI type from the drop-down list: 

Measurement - Measures the signal intensity in an area of an image.

Average Bkg - Measures the average signal intensity in a user-specified area of 
the image that is considered background.

Subject ROI - Identifies a subject animal in an image. The software automatically 
associates a measurement and an average bkg ROI that are included in the same 
subject ROI. Using this type of ROI is optional.

Save ROIs Creates a file that includes the ROI parameters (for example, the X,Y coordinates, 
type of ROI, color, shape, width/height). ROIs that have been saved to file can be 
recalled and applied for another image at any time. 

Name The name of the selected ROI set or the default name for a new ROI set.

Delete Deletes the selected ROI set from the system. Note: This permanently removes 
the ROI from the system.

Load Applies the ROI set selected from the Name drop-down list to the active image.

Save Saves the ROI set in the active image. 

Note: This is a global save (the ROI is saved to the system) and the ROI set can 
be loaded onto any image. If you use the File ' Save commands to save an 
image that includes an ROI, the ROI is saved with the image only (not a global 
save) and is not available for loading onto other images. For more details, see 
Saving ROIs, page 142.

Auto ROI 
Parameters

Parameters that specify how the auto ROI tool draws an ROI. 

Threshold % �– If the Auto All or Auto 1 method is selected, the Threshold % specifies 
the minimum percent of peak pixel intensity that a pixel must have to be included 
in an ROI identified by the software. After ROIs are drawn on an image, if you 
modify the Threshold% (move the slider or enter a new value), the software 
automatically updates the ROIs.

Note: The following Auto ROI parameters are only available if �“Show Advanced 
Options�” is selected in the general preferences. For more details on setting 
Preferences, see Appendix B, page 265.

Lower Limit �– Specifies a multiple (1 to 10) of the color scale minimum that sets 
the lower threshold for identifying an ROI. For example, if the lower limit = 2 and 
the color scale minimum = 1000 counts, then the auto ROI tool will only draw an 
ROI on areas of 2000 counts or greater. This helps create ROIs only in the visible 
range.

Minimum Size �– Sets the minimum size of an ROI (measured in pixels). For 
example if the minimum size is set at 50, then ROIs created on the image must 
be greater than 50 pixels in size.

Preview �– If this option is chosen, the software draws the ROI each time a 
parameter is changed. ROI parameters can be saved without drawing the ROI.

Use Bkg Offset �– Choose this option to measure background-corrected signal. This 
is typically used to remove natural animal background luminescence, and should 
not be confused with the dark-charge and read-bias 'background' corrections that 
are applied (by default) to the raw CCD data to remove electronic noise before any 
measurements. For more details, see page 130.

Replace ROIs �– If this option is chosen, all auto ROIs are replaced when new 
ROI(s) are created.

Restore Defaults �– Restores the factory-set defaults for the auto ROI parameters.

Save/Load Click to display or hide the tools that enable you to save, load, or delete auto ROIs 
in the active data. Note: The save function saves parameters, the not actual ROIs. 
This means that when you load saved auto ROI parameters, the software draws a 
new ROI using the saved values (Threshold%, Lower Limit, Minimum Size).

Table 8.2  ROI tools (continued)  

Item Description
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8.4 Measurement ROIs

To obtain the intensity signal in a user-specified area of an image, draw a measurement 
ROI on the image. This section explains in detail the three ways to draw measurement 
ROIs. 

NOTE
For a quick guide to drawing measurement ROIs, see page 120.

Manually Drawing a Measurement ROI

1. Open an image or image sequence, and in the ROI tools, select Measurement ROI from 
the Type drop-down list.

2. Select the ROI shape:

a. Click the Circle , Square , or Grid button . 

The grid shape is useful for drawing a grid of ROIs on an image of a well plate.

b. On the drop-down list that appears, select the number of ROIs that you want to add 
to the image or the grid ROI dimensions. 

The ROIs and intensity measurements appear on the image. 

NOTE
Manual ROIs are numbered in the order they are created. You may want to arrange the ROIs 
in a known order for easier comparison between images.To renumber the ROIs (ascending 
order from right to left), right-click the image and select Sort ROIs on the shortcut menu. If 
the "Apply to Sequence" option is selected in the ROI tools, choose "Sort ROIs in Sequence" 
to sort all of the ROIs in the sequence. The sort options are only available if the ROIs have 
not been sorted.

.

Drawing 
Method Description See 

Page
Manual Places one or more ROIs (circular, square, or grid shape) on the image. 120

Automatic The software automatically locates and draws an ROI(s) on the image. 
To do this, the software locates the peak pixel intensities in the image 
and searches the neighborhood around a peak pixel. A pixel is included 
in the ROI if the pixel intensity is greater than the threshold%, a user-
specified percentage of the peak pixel intensity.

127

Free draw Draw line segments that define the ROI. 129



126  Living Image Software User’s Manual

3. Adjust the ROI position:

a. Place the mouse pointer over the ROI. When the pointer becomes a , click the 
ROI. 

b. Drag ROI(s).

NOTE
To move multiple ROIs at the same time, press and hold the Shift key while you click the 
ROIs, and then drag them to a new location. Contour ROIs ( ) cannot be moved using this 
method.

4. Adjust the ROI dimensions:

a. Place the mouse pointer over the ROI. When the pointer becomes a , click the 
ROI.

b. Place the mouse pointer over an ROI handle  so that it becomes a . Drag the 
handle to resize the ROI.

NOTE
You can also change the ROI position or size using the adjustment controls in the ROI 
Properties box (see “Moving an ROI,” page 138 and “Editing ROI Dimensions,” page 139).

5. Click the Measure button . 

The ROI measurements and table appear. For more details on the table, see �“Managing 
the ROI Measurements Table,�” page 145.

For information on how to save ROIs, see page 116.

Figure 8.7  Placing two circular ROIs on the image
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Automatically Drawing Measurement ROIs

The Living Image® software can automatically identify all of the ROIs in an image or 
image sequence that meet the auto ROI parameter thresholds or draw one ROI at a user-
specified location.

1. Open an image or image sequence, and in the ROI tools, select Measurement ROI from 
the Type drop-down list.

2. Click an ROI shape button (Circle , Square , or Contour ) and select Auto 
All from the drop-down list. 

The ROIs appear on the image or sequence thumbnails. The ROI label includes the 
ROI intensity threshold (Threshold%) and intensity measurement. 

NOTE
Auto ROIs are created and numbered in order from highest to lowest maximum signal within 
the ROI (ROI 1 contains the highest maximum signal). You may want to arrange the ROIs in 
a known order for easier comparison between images.To renumber the ROIs (ascending 
order from right to left), right-click the image and select Sort ROIs on the shortcut menu. If 
the "Apply to Sequence" option is selected in the ROI tools, choose "Sort ROIs in Sequence" 
to sort all of the ROIs in the sequence. The sort options are only available if the ROIs have 
not been sorted.

3. Click the Measure button  in the ROI tools to show the ROI Measurements 
table.

Figure 8.8  Automatically drawing measurement ROIs detected by the software
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The ROI Measurements table displays data for all ROIs created in images or sequences 
during a session (one ROI per row). The table provides a convenient way to review and 
export ROI data. For more details on the table, see �“Managing the ROI Measurements 
Table,�” page 145 

To automatically draw an ROI at a user-specified location:
1. Open an image.

2. Click an ROI shape button (Circle , Square , or Contour ) and select Auto 1 
from the drop-down list.

The create tool appears on the image.

3. Use the ring  to move the create tool to the area where you want to draw the ROI, 
then click Create.

The ROI appears on the image and the ROI label displays the intensity signal.

Figure 8.9  ROI Measurements table

Figure 8.10  ROI create tool
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4. To draw another ROI on the image, repeat step 2. to step 3.

For information on how to save ROIs, see page 142.

Drawing an ROI Using the Free Draw Method

1. Open an image, and in the ROI tools, select the type of ROI that you want to draw from 
the Type drop-down list.

2. Click an ROI shape button (Circle , Square , or Contour ) and select Free 
Draw from the drop-down list. In this example, the Contour shape  was selected for 
the free draw method. 

The ROI shapes that are available depend on the type of ROI selected.

3. If you selected:

 or  - Use the pointer (+) to draw the ROI.

 - Use the pointer (+) to click around the area of interest and draw line segments that 
define the ROI. Right-click when the last point is near the first point in the ROI.

8.5 Subject ROIs

A subject ROI identifies a subject animal in an image. It provides a convenient way to 
automatically associate (link) a measurement and average background ROI for 
background-corrected ROI measurements when there is significant autoluminescence or 
autofluorescence. (For more details on background-corrected ROI measurements, see 
page 130.) Using a subject ROI is optional.

To draw a subject ROI using the auto ROI feature:
1. Select Subject ROI from the Type drop-down list.

2. Click the  button. 

Figure 8.11  Drawing an ROI using the free draw method
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3. Select Auto All.

To manually draw a subject ROI:
4. Select Subject ROI from the Type drop-down list.

5. Click the  button, and select 1. 

6. Position the subject ROI so that it includes the measurement ROI(s) and the associated 
average background ROI.

8.6 Measuring Background-Corrected Signal

If a subject has significant autoluminescence or autofluorescence, you can obtain a 
background-corrected ROI measurement by subtracting an average background ROI from 
a measurement ROI. The software computes:

Background-corrected intensity signal = Average signal in the measurement ROI - 
Average signal in the average background ROI

NOTE
This is an optional "background" correction that is applied in addition to the electronic dark-
charge and read-bias corrections that are applied to the raw CCD data. 

The Image Adjust tools and zoom feature are helpful for selecting an appropriate area for 
an ROI. By setting the image minimum close to zero and zooming in on a background area 
in the image, you can determine where naturally occurring background luminescence or 
autofluorescence is present. For more details on the Image Adjust tools and the zoom 
feature, see Adjusting Image Appearance, page 97 and Magnifying or Panning in the 
Image Window, page 98.

To measure background-corrected signal:
1. Draw one or more measurement ROIs on the subject. (For more details, see page 129.)

2. Draw an average background ROI on the subject:

a. Select Average Bkg ROI from the Type drop-down list.

b. Click the Square  or Circle  button and select 1.

The ROI is added to the image.For more details on adjusting the ROI position or 
dimensions, see page 138 and page 139.

NOTE
The average background ROI and measurement ROI do not need to be the same shape or 
size because the software computes the average intensity signal in each ROI.

3. Use one of the following methods to associate the average background ROI with one 
or more measurement ROIs:

�• Method 1: Draw a subject ROI around the average background ROI and the 
measurement ROI(s) (Figure 8.12)

�• Method 2: Right-click the measurement ROI and select a background ROI from the 
shortcut menu that appears (Figure 8.13).

�• Method 3: Set the background ROI in the ROI properties dialog box (Figure 8.14)
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Figure 8.12  Associate the average background ROI with measurement ROIs (Method 1)

Figure 8.13  Associate an average background ROI with measurement ROIs (Method 2)

Draw a subject ROI that 
includes the 
measurement ROI and 
the average 
background ROI. For 
details on how to draw 
a subject ROI, see 
page 129.

Right-click the 
measurement ROI and 
select an average 
background ROI from the 
shortcut menu.
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8.7 Kinetic ROIs

Kinetic ROIs help you track signal sources on an unanesthetized, mobile subject. The 
software automatically creates a separate ROI in each frame based on the user-specified 
auto ROI settings. As a result, kinetic ROIs are continuously displayed during kinetic data 
playback. You can draw a kinetic ROI using any of the methods or shapes in Table 8.1, 
page 120.

NOTE
Large kinetic data sets may require more time to create, plot, and measure the ROIs because 
the software first applies corrections to a frame (specified in the Corrections/Filtering Tool 
Palette), then draws the ROIs in the frame. The process can be aborted at any time.

These steps provide a quick guide on how to apply a measurement ROI to kinetic data. 
For more details about measurement ROIs, see page 125.

1. Open the kinetic data and click ROI Tools in the Tool Palette.

2. In the ROI tools, select Measurement ROI from the Type drop-down list.

3. Click the Contour button  and select Kinetic ROI.

The create tool appears on the image.

Figure 8.14  Associate an average background ROI with measurement ROIs (Method 3)

1. Right-click a background ROI and select Properties on the shortcut menu.

2. In the ROI Properties box that appears, click the Background ROI tab and put a 
check mark next to Use as BKG for future ROIs in.

3. Choose the image name or the Entire sequence option.
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4. Use the ring  to move the create tool to the area where you want to draw the ROI, 
then click Create.

The ROI and label appear on the image.

NOTE
When drawing kinetic ROIs on kinetic data with multiple sources, it is recommended that you 
start with the brightest source, then the next brightest, and so on in order to create ROIs that 
can be distinguished based on the signal strength.

5. If it is necessary to adjust the ROI boundaries or change any of the auto ROI 
parameters (use the slider or  arrows):

Threshold % - Specifies the minimum per cent of peak pixel intensity that a pixel must 
have to be included in an ROI identified by the software

6. Click Done to hide the create tool.

The kinetic data playback starts and shows the ROI in each image.

NOTE
After the ROIs have been created, right-click an ROI to view a shortcut menu of ROI 
commands (Ctrl-click for Macintosh users). The shortcut menu provides easy access to many 
functions for managing ROIs and viewing ROI properties.

7. To measure intensity in the ROI, click the Measure button  in the Tool 
Palette.

The Kinetic ROI Measurements table appears (Figure 8.16).

8. To view ROI measurements for all images, click the  arrow next to Current Frame 
and select All Frames, then click the Refresh button.

Figure 8.15  ROI create tool
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Plotting Kinetic ROI Measurements

The kinetic ROI plot provides a convenient way to view and compare kinetic ROI 
measurements across user-selected image frames from the same or different kinetic data 
sets.

1. Open one or more kinetic data sets.

2. Draw kinetic ROIs on the data sets in which you want to measure and compare ROIs.

3. In the ROI tools, click the ROI Measurements button .

The ROI measurements table appears.

4. Click the Plot Kinetic ROI Measurements tab.

5. Make a selection from the Measurement Unit and ROI Measurement drop-down lists.

6. Select a data set and an ROI.

7. Click Plot ROI Measurements.

8. To add other ROI data to the graph, repeat step 6 to step 7.

Figure 8.16  ROI Measurements table

Kinetic ROI measurements are displayed in a separate tab

Figure 8.17  Plot Kinetic ROI Measurements tab
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8.8 Managing ROIs

In the ROI Properties box, you can view information about an ROI, change the position 
of the ROI on the image, and edit the ROI label or line characteristics

Viewing ROI Properties

1. To view ROI properties, do one of the following:

�• Double-click an ROI in the image

�• Right-click the ROI and select Properties from shortcut menu that appears.

�• Select the ROI, then select View → Properties on the menu bar.

The ROI Properties box appears (for more details see Figure 8.20).

2. To view properties for another ROI, click the ROI in the image. Alternatively, select 
an ROI from the ROI drop-down list in the ROI Properties dialog box (Figure 8.18).

Figure 8.18  Opening the ROI Properties dialog box

ROI selected in the 
image. To view 
properties for another 
ROI, select another 
ROI from the drop-
down list or click an 
ROI in the image.
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Figure 8.19  ROI Properties, Background ROI tab
The items in the ROI Properties box depend on the type of ROI selected in the image. For more 
details see Table 8.3, page 137.

ROI selected in the image 

Label of the ROI 
selected in the image. 
Double-click to edit.

Selected image 

Background 
ROI selected

Measurement 
ROI selected
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Figure 8.20  ROI properties, Subject tab
The items in the ROI Properties box depend on the type of ROI selected in 
the image. For more details see Table 8.3, page 137.

Table 8.3  ROI Properties

Item Description
ROI A drop-down list of ROIs in the active image or image sequence. To select an 

ROI, double-click the ROI in the image or make a selection from the drop-down 
list.

Shape �– The shape of the ROI (circle, square, grid, or contour) selected in the 
image.

Type �– Indicates the method that was used to draw the selected ROI (automatic, 
manual, or free draw). 

ROI Label Click to edit the selected ROI label name.

Image Number A drop-down list of open images.

Background 
ROI tab

The Background ROI tab shows a drop-down list shows all average background 
ROIs in active image that can be linked to a user-specified measurement ROI or 
subject ROI (selected from the drop-down list at the top of the dialog box).

ROI label name. Edit the label here.

Subj ROI tab

Drop-down list of subject ROIs in the image

Enter information about the 
selected ROI (optional)
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Moving an ROI

There are two ways to move an ROI on an image:

�• Drag the ROI to a new location

�• Edit the settings in the ROI Properties box 

NOTE
An ROI cannot be moved if it was created using the auto ROI tool or if the ROI position is 
locked.

To drag an ROI:
1. Put the mouse pointer over the ROI so that it becomes a  arrow.

2. Drag the ROI.

3. Release the mouse button when the ROI is properly positioned.

To move an ROI using the ROI Properties dialog box:
1. Double-click the ROI in the image.

Subj ROI The Subject ROI tab shows a drop-down list of all subject ROIs in the image 
number selected above that can be linked to a user-specified measurement ROI 
or average background ROI (selected from the drop-down list at the top of the 
dialog box).

The Background ROI tab shows a drop-down list shows all average background 
ROIs in the click number selected above that can be linked to a user-specified 
measurement ROI or subject ROI (selected from the drop-down list at the top of 
the dialog box).

ID User-entered information about a subject ROI.

Label Label name of the selected subject ROI.

Lock Position Choose this option to lock the position of the ROI selected in the image.

Xc x-axis coordinate at the center of the ROI selected in the image.

Yc y-axis coordinate at the center of the ROI selected in the image.

Lock Size Choose this option to lock the dimensions of the ROI selected in the image.

Width Width (pixels or cm) of the ROI selected in the image (for more details on setting 
the units, see ROI Dimensions, page 147).

Height Height (pixels or cm) of the ROI selected in the image.

Line Size Specifies the ROI line thickness. To change the line thickness, enter a new value 
or click the up/down arrows .

Line Color Specifies the color of the ROI line. To select a line color, click the Browse button 
.

Done Click to close the ROI Properties box and apply any new settings, including:

�• Linkage between a measurement ROI and subject ROI (for more details, see 
Drawing an ROI Using the Free Draw Method, page 129).

�• ROI size dimensions or position

�• Subject ROI ID information

Table 8.3  ROI Properties

Item Description
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The ROI Properties box appears and displays the position and dimensions of the 
selected ROI.

2. To set ROI position, enter new coordinates for the center of the ROI (Xc (pix) and Yc 
(pix) values) in the ROI Properties box.

3. To rotate the ROI clockwise, enter the degrees in the Angle (deg) box and click outside 
the box.

4. To lock the current ROI position, choose the Lock Position option.

NOTE
The ROI position cannot be changed until the Lock Position option is cleared.

Editing ROI Dimensions 

There are two ways to resize a circle or square ROI:

�• Drag a handle on the ROI

�• Edit the settings in the ROI Properties box

NOTE
You cannot change the size of an ROI that was created using the auto ROI or free draw tool. 

To resize an ROI using a handle:

Figure 8.21  ROI Properties dialog box

Position of the ROI 
selected in the image
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1. Select the ROI and put the mouse pointer over a handle ( ) on the ROI.

2. When the pointer becomes a  arrow, drag the handle.

To resize an ROI using the ROI Properties box:
1. Double-click the ROI in the image.

The ROI Properties box appears and displays the positions and dimensions of the 
selected ROI.

2. Enter a new width or height value in the ROI Properties box.

3. To lock the current ROI size, choose the Lock Size option.

NOTE
The ROI size cannot be changed until the Lock Size option is cleared.

Figure 8.22  ROI Properties dialog box

Dimensions of the ROI 
selected in the image
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Editing the ROI Line

1. Double-click the ROI that you want to edit.

The ROI Properties box appears (Figure 8.23).

2. To edit the ROI line thickness, enter a new value in the Line Size box. Alternatively, 
click the  arrows.

3. To change the ROI line color:

a. Click the Browse button .

b. The Select Color box appears.

c. To select a basic color for the ROI line, click a basic color swatch, and click OK.

d. To define a custom color, drag the crosshairs in the custom color field, adjust the 
brightness slider, and click Add to Custom Colors.

e. To select a custom color for the ROI line, click a custom color swatch, and click 
OK.

Figure 8.23  Editing ROI properties

Brightness slider

Cross hairs in 
the custom 
color field
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Move or Edit the ROI Label

To move the ROI label:
1. Put the mouse pointer over the ROI label.

2. When the pointer becomes a , drag the label, and then click to release the label at 
the new location (Figure 8.24).

To edit the ROI label:
1. Double-click the ROI of interest. Alternatively, right-click the ROI (Ctrl-click for 

Macintosh users) and select Properties on the shortcut menu.

2. In the ROI Properties box that appears, edit the name in the ROI Label box and click 
Done (Figure 8.24).

Saving ROIs

The software automatically saves ROIs with an image. The ROI measurements are saved 
in the AnalyzedClickInfo.txt file associated with the image. ROIs are saved per user and 
can be applied to other sequences. Additionally, ROI parameters can be saved per user 
and applied to other sequences.

To save ROIs to the system:
1. In the Name drop-down list, confirm the default name or enter a new name for the 

ROI(s).

Figure 8.24  Move or edit the ROI label

Edit the ROI 
label here
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2. Click Save. 

The ROI(s) from the image are saved to the system and can be selected from the Name 
drop-down list.

To load ROIs on an image:
1. Open an image.

2. In the ROI tools, make a selection from the Name drop-down list and click Load.

NOTE
If you load ROI(s) onto an image, then draw additional ROIs, the Save button changes to 
Overwrite. If you want to save this collection of ROIs using the existing name, click 
Overwrite.

Deleting ROIs

You can delete ROIs from an image or permanently remove ROIs from the system.

To delete ROIs from an image:
1. In the ROI tools, click the  button. 

Figure 8.25  Name and save the ROIs to the system



144  Living Image Software User’s Manual

2. In the drop-down list that appears, select a delete command.

The specified ROIs are deleted from the image. 

NOTE
This does not delete ROIs saved to the system (global save).

To permanently remove ROIs from the system:
1. Select the ROI(s) that you want to delete from the drop-down list of saved ROIs.

2. Click Delete (Figure 8.27).

Figure 8.26  Removing ROIs from an image

Figure 8.27  Removing ROIs from the system
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8.9 Managing the ROI Measurements Table

The ROI Measurements table shows information and data for the ROIs created during a 
session. The ROI measurements can be displayed in units of counts or photons, or in terms 
of efficiency. For more details, see Quantifying Image Data, page 281.

Viewing the ROI Measurements Table

1. Click the  button. Alternatively, select View → ROI Measurements on the menu 
bar. 

Figure 8.28  Opening the ROI Measurements table
Column headers in the table include ROI information, ROI measurements and dimensions, and 
information about the image recorded at acquisition.

Select the type of data to include 
in the table. For more details, see 
Table 8.4, page 146.

Grid ROIs 



146  Living Image Software User’s Manual

Figure 8.29  ROI Measurements table, kinetic ROIs

Table 8.4  ROI Measurements table

Item Description
Measurement Types Make a selection from the drop-down list to specify the type of ROI 

measurements to include in the table.

None Excludes ROI measurements from the table.

Counts
(luminescence)

Includes Total Counts, Avg Counts, Stdev Counts, Min Counts, and Max 
Counts in the table. 

Total Counts = the sum of all counts for all pixels inside the ROI.

Avg Counts = Total Counts/Number of pixels or super pixels.

Stdev Counts = standard deviation of the pixel counts inside the ROI

Min Counts = lowest number of counts in a pixel inside the ROI.

Max counts = highest number of counts in a pixel inside the ROI.

For more details on count units, see page 281.

Note: These numbers are displayed if the units selected in the ROI 
Measurements table and the image are the same. Otherwise, N/A 
appears in each column.

Radiance (Photons)
(fluorescence)

Total Flux = the radiance (photons/sec) in each pixel summed or 
integrated over the ROI area (cm2) x 4π.

Average Radiance = the sum of the radiance from each pixel inside the 
ROI/number of pixels or super pixels (photons/sec/cm2/sr).

Stdev Radiance = standard deviation of the pixel radiance inside the ROI

Min Radiance = lowest radiance for a pixel inside the ROI.

Max Radiance = highest radiance for a pixel inside the ROI.

For more details on photon units, see page 282.

Radiant Efficiency
(fluorescence)

Epi-fluorescence - Fluorescence emission radiance per incident excitation 
irradiance: p/sec/cm2/sr/µW/cm2

Transillumination fluorescence - Fluorescence emission radiance per 
incident excitation power: p/sec/cm2/sr/mW

Efficiency
(epi-fluorescence)

Fluorescent emission yield normalized to the incident excitation intensity 
(radiance of the subject/illumination intensity)

NTF Efficiency
(transillumination 
fluorescence)

Fluorescent emission image normalized to the transmission image which 
is measured with the same emission filter and open excitation filter.
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Configuring the ROI Measurements Table

You can customize the data and information (column headers) in the ROI Measurements 
table. Several preset categories are available in the Measurement Types, Click Attributes, 
and ROI Dimensions drop-down lists.

1. To reorder the columns, drag a column header (left or right) in the table.

2. To change the measurement units, make a selection from the Measurement Types 
drop-down list.

Image Attributes Make a selection from the drop-down list to specify the click number 
(image file) information to include in the table. Click attributes include 
label name settings and camera settings.

None Excludes image attributes from the table.

All Possible Values Includes all of the image attributes (for example, label name settings and 
camera settings) in the table.

All Populated Values Includes only the image attributes with values in the table.

Living Image 
Universal

Includes all Living Image Universal label name settings in the table.

ROI Dimensions Make a selection from the drop-down list to specify the ROI dimensions 
to include in the table.

None Excludes the ROI area, x,y-coordinates, and dimensions from the table.

Pixels Includes ROI area, x,y-coordinates, and dimensions (in pixels) in the 
table.

cm Includes ROI area, x,y-coordinates, and dimensions (in cm) in the table.

Copy Copies the selected row(s) in the table to the system clipboard.

Select All Copies all rows in the table to the system clipboard.

Refresh Updates the ROI Measurements table (for example, after you draw new 
ROIs, move an ROI, and close or open image data).

Configure Displays the Configure Measurements box that enables you to specify 
and organize the data categories (column headers) for the table.

Export Displays the Save Measurements box so that the data can be saved to a 
.txt or .csv file. 

Note: Grid ROI measurements exported to a .csv file can be opened in a 
spreadsheet application like Microsoft® Excel®.

Close Closes the ROI Measurements table.

Table 8.4  ROI Measurements table (continued)  

Item Description

Figure 8.30  ROI Measurements table
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3. To include image information in the ROI table, make a selection from the Image 
Attributes drop-down list.

4. To include ROI dimensions in the table, select units (Pixels or cm) from the ROI 
Dimensions drop-down list. 

Creating a Custom ROI Table Configuration

A table configuration specifies the column headers in the ROI table. Several preset 
configurations are available (selected from the Measurements Types drop-down list in the 
ROI table, Figure 8.30). You can also create a custom table configuration.

NOTE
Preset table configurations cannot be edited. You can modify a preset configuration and save 
it to a new name.

1. In the ROI Measurements table, click Configure.

The Configure Measurements box appears.

2. Select a configuration from the User Lists drop-down list and click Customize.

3. To add column header to the ROI table, make a selection from the �“Available Item�” 
list and click Add. 

4. To remove column header from the ROI table, select the item that you want to remove 
in the Selected Items list, and click Remove.

5. To reorder an item in the Selected Items list, select the item and click Move Up or 
Move Down.

The columns in the ROI Measurements table are updated.

6. Enter a name for the custom configuration in the Name box and click Save.

Figure 8.31  Configure Measurements dialog box

Column headers in 
the active ROI table 
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To delete a custom table configuration:
1. Select the configuration from the User Lists drop-down list and click Delete.

NOTE
Preset table configurations cannot be deleted.

Copying or Exporting the ROI Measurements Table

To export the table:
1. In the ROI Measurements table, click Export.
2. In the dialog box that appears, select a folder and enter a name for the file (.txt), then 

click Save.

To copy the table to the system clipboard:

Copy selected rows - Select the rows of interest and click Copy. Alternatively, select the 
rows, then right-click the table and choose Copy on the shortcut menu.

All rows - Click Select All and then click Copy. Alternatively, press Ctrl+A, then right 
click the table and choose Copy on the shortcut menu.

Figure 8.32  Copy all rows in the ROI Measurements table to the system clipboard
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9 Image Math
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The Living Image software provides tools that enable you to mathematically combine two 
images to create a new image. The primary use of image math is to subtract tissue 
autofluorescence background from signal.

To perform image math, open an image sequence or a group of images. For more details 
on creating a sequence from individual images, see page 117.

9.1 Creating a New Image Using Image Math 
1. Load an image sequence.

2. Select Tools → Image Math for <name>_SEQ on the menu bar.

3. In the Image Math window that appears, select an image from box A and from box B.

The Image Math window shows a thumbnail of image A, image B, and the new image.

LIving Image Tool Use This Tool To... See Page
Image Math Mathematically combine (add, multiply, subtract, or divide) two 

user-specified images.
151

Image Math Remove autofluorescence from a fluorescent image. 153

Figure 9.1  Opening the Image Math window
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NOTE
For more details on items in the Image Math window, see Table 9.1, page 153.

4. Select a mathematical function from the Result drop-down list.

5. To include a scaling factor (k) in the function, enter a value for k.

6. To view the new image, click Display Result for Measuring.

To save the new image:
1. Click the Save button . Alternatively, select File → Save on the menu bar.

2. In the dialog box that appears, select a directory, and click Save.

A folder of data is saved to the selected location (AnalyzedClickInfo.txt, ClickInfo.txt, 
luminescent and photographic TIF images).

To export the image to a graphic file:
1. Click the Export button  (Figure 9.2).

2. In the dialog box that appears, select a directory, enter a file name, and select the file 
type from the Save as type drop-down list.

3. Click Save.

Figure 9.2  Image Math window and new image

Click to export the 
image to a graphic file
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9.2 Subtracting Tissue Autofluorescence

To remove tissue autofluorescence from image data, the IVIS Imaging System 
implements a subtraction method using blue-shifted background filters that emit light at 
a shorter wavelength.

The objective of using a background filter is to excite the tissue autofluorescence without 
exciting the fluorophore. To reduce autofluorescence signal in the primary image data, 
use the image math tool to subtract the background filter image from the primary 
excitation filter image. For more details on tissue autofluorescence, see Appendix F, 
page 305

The software computes the signal corrected for background: (A - B) × k

where:

A = primary image (acquired using the excitation filter)

B = background image (acquired using the background filter)

k = (primary signal/background signal) 

The background signal is obtained from a measurement ROI that is located in an area 
where no fluorophore signal is present. The scale factor k accounts for different levels of 

Table 9.1  Image Math window

Item Description
Color Ranges for A and B Full - Choose this option to set the Max and Min values to the 

maximum and minimum data values in the image.

Auto - When this option is chosen, the software sets the Min and 
Max values to optimize image display and suppress background 
noise. The Min and Max settings can be manually adjusted to further 
optimize the image display for your needs.

Note: The color scale does not affect the image math result.

Color Ranges for Result 
Image

Full - See above.

Auto - See above.

Min = 0 - Choose this option to set the minimum data value to zero.

Results Drop-down list of mathematical functions that can be used to 
generate the new image, including:

A - B*k
A + B*k
A * B*k
A/B if Counts(B)>k (Useful for fluorescence tomography.)
(A/B)*k

k, Image Math window A user-specified scaling factor applied in the results function. 

Compute �‘k�’ from ROI This option is useful for subtracting fluorescence background. Draw 
one ROI in an image on an area considered background. In the 
�“Compute �‘k�’ from ROI�” drop-down list, select the this ROI.

with Photo from Choose this option to display the new image in overlay mode using 
the selected photographic image. (This option is only available if one 
of the selected images is an overlay.

Display Result for 
Measuring

Opens the image generated by image math in an image window.
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tissue autofluorescence due to different excitation wavelengths and filter transmission 
characteristics.

After you acquire an image sequence that includes a primary and background image, use 
the image math tool to subtract tissue autofluorescence. (For more details on acquiring an 
image sequence, see Chapter 4, page 33.)

To subtract tissue autofluorescence:
1. Load the image sequence that includes the primary and background fluorescent 

images.

2. Open either the primary or background image and:

a. Optimize the image display using the color scale Min and Max sliders in the Image 
Adjust tools.

b. Draw a measurement ROI on an area of the animal that represents background 
signal (area where no fluorophore signal is present).

NOTE
You only need to draw the ROI on one of the images. The software copies the ROI to the 
other image.

Figure 9.3  Image sequence
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3. Select Tools → Image Math for <name>_SEQ on the menu bar.

4. In the Image Math window that appears, select the primary image in box A. Select the 
background image in box B.

For more details on items in the Image Math window, see Table 9.1, page 153.

5. Select the math function 'A-B*k' in the Result drop-down list.

6. Click  and select the ROI (created in step 2) from the drop-down list.

The background-corrected signal is displayed.

7. To view the mathematical result (overlay mode) in a separate image window, click 
Display Result For Measuring.

Figure 9.4  Draw measurement ROI on an area that represents background signal

Figure 9.5  Select a math function and view the mathematical result
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If necessary, use the Color Scale Min and Max sliders in the Image Adjust tools to 
adjust the image display.

To save the new image:
1. Click the Save button . Alternatively, select File → Save on the menu bar.

2. In the dialog box that appears, select a directory, and click Save.

A folder of data is saved to the selected location (AnalyzedClickInfo.txt, ClickInfo.txt, 
luminescent and photographic TIF images).

To export the new image to a graphic file:
1. Click the Export button .

2. In the dialog box that appears, select a directory, enter a file name, and select the file 
type from the Save as type drop-down list.

3. Click Save.
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The Living Image software applies planar spectral image analysis to a sequence to 
determine the average depth and total photon flux of a luminescent point source in a user-
specified region of interest. For more information on planar spectral image analysis, see 
Appendix G, page 309.

10.1 Image Sequence Requirements

Use the Imaging Wizard to setup the image sequence required for planar spectral image 
analysis. (For more details on the Imaging Wizard, see Chapter 4, page 33.) At a 
minimum, the sequence must include a photographic and luminescent image at the first 
wavelength and a luminescent image at a second wavelength (560-660).

10.2 Planar Spectral Image Analysis
1. Load the image sequence that you want to analyze. 

2. In the Tool Palette, click Planar Spectral Imaging.

3. In the Analyze tab, select the emission filter wavelengths for the analysis (Figure 
10.2).

It is recommended that you do not include a wavelength in the analysis if the signal is 
less than or equal to the autoluminescent background. If autoluminescent background 
is a concern, you can create a background ROI and link it to the measurement ROI 

Figure 10.1  Sequence for planar spectral image analysis
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prior to planar spectral analysis. (For more details, see Measuring Background-
Corrected Signal, page 130.)

4. In the ROI List drop-down, select All or a particular ROI in an image for the analysis. 
If there is no measurement ROI, draw an ROI that includes the area for analysis. (For 
more details on drawing ROIs, see page 120.) 

You only need to draw the ROI(s) on one image in the sequence. The software copies 
the ROI(s) to all other images of the sequence during the analysis. The ROI should 
include as much of the light emission from a single source as possible.

Figure 10.2  Planar spectral imaging tools, Analyze tab
For more details on the Analyze tab, see page 159.

Figure 10.3  Selecting ROIs for planar spectral image analysis

Emission filter wavelengths 
selected for the analysis
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5. Choose the tissue properties:

a. In the Properties tab, choose Mouse Tissue or XPM-2/XFM-2 (mouse phantom) 
from the Tissue Properties drop-down list.

The software automatically sets the internal medium index of refraction based on 
the selection in the Tissue Properties list

6. Make a selection from the Source Spectrum drop-down list (Firefly in this example).

7. Click Analyze in the Analyze tab.

The Results tab displays the computed average depth (mm) and total flux (photon/sec) 
of the luminescent point source in the specified ROI(s). For more details on the results, 
see page 160.

Figure 10.4  Planar spectral imaging tools

Analyze tab Results tabProperties tab

Table 10.1  Planar spectral imaging tools

Item Description
Analyze tab

Sequence Name of sequence used for the analysis.

Tissue, Source The tissue properties and source spectrum selected in the Properties 
tab.

Select Filters In the Filter box, select the acquisition wavelengths for the images in 
the selected sequence. To select non-adjacent wavelengths, press and 
hold the Ctrl key while you click the wavelengths. (Macintosh users, 
press and hold the Cmd key while you click the wavelengths.)

ROI List A drop-down list of the ROIs in the active image.

Analyze Click to perform the spectral analysis.
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Properties tab

Tissue Properties Drop-down list of the absorption and scattering properties for Mouse 
Muscle or XPM-2/XFM-2 (mouse phantom).

Note: If a result from an earlier version of Living Image software is 
loaded, the tissue type will be listed in this drop-down list. 

Source Spectrum Drop-down list of luminescent sources.

Plot Tissue Properties - Click to display graphs (cm-1 vs. nm) of the 
absorption coefficient (µ

a), effective attenuation coefficient (µ
eff), and 

reduced scattering coefficient (µ�’s).
Source Spectrum - Click to display the spectrum of the selected 
luminescent source (intensity versus wavelength, normalized to one).

Results tab

Spectral Results ROI - Name of the analyzed ROI.

Depth (mm) - Estimated depth of the point source.

Total Flux (phot/s) - Estimated total photon flux from the point source.

Plot Linear Fit Displays a graph of normalized intensity versus the effective attenuation 
coefficient (µ

eff, the optical property of the tissue selected in the Tissue 
Properties drop-down list) along with the linear fit to these data 
determined by the spectral analysis code.

Plot Intensity Displays a graph of normalized intensity versus wavelength. Intensity is 
normalized by the selected source spectrum and filter transmission 
properties.

Export Opens a dialog box that enables you to save the results to a text file 
(.txt).

Save Results Name - A drop-down list of saved results. Includes the default name for 
new unsaved analysis results (SpIm_<name>). 

Delete - Deletes the selected results.

Load - Opens the selected results.

Save - Saves the analysis results (results name appears in the Name 
drop-down list).

Table 10.1  Planar spectral imaging tools (continued)  

Item Description
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10.3  Viewing Graphical Results

1. In the Results tab, select an ROI.

2. Click Plot Intensity or Plot Linear Fit (Figure 10.5).

Linear fit graph �– Plots the logarithm of the intensity, normalized to the selected 
source spectrum and the filter transmission properties, against the optical property of 
the tissue (µ

eff). The slope of the line is the source depth. If any of the measured points 
(in red) deviate significantly from the straight line fit, then the analysis results may be 
suspect. The horizontal error bars represent the uncertainty in the optical properties 
(usually estimated at ±10%). The vertical error bars represent noise in the image.

Intensity graph �– Displays a graph of the measured intensity in the selected ROI at 
each wavelength in the analysis. The intensity is normalized to the selected source 
spectrum and the filter transmission properties.

To export graph data:
1. Click the Export Data button .

2. In the dialog box that appears, select a directory for the data and enter a file name 
(.csv).

The data can be opened in a spreadsheet application such as Microsoft® Excel®.

Figure 10.5  View the Linear Fit or Intensity graph

Select an ROI 
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10.4  Managing Planar Spectral Imaging Results

Go to the Results tab to select results that you want to view or manage.

To save results:
1. Select results (Splm_<name>) from the Name drop-down list.

2. Click Save.

The planar spectral imaging results are saved with the image.

To view results:
1. Select results from the Name drop-down list.

2. Click Load.

To delete results:
1. Select the results that you want to delete from the Name drop-down list.
2. Click Delete.

To copy selected results:
1. Right-click the results (row) and select Copy from the shortcut menu that appears. 

The selected results are copied to the system clipboard.

To copy all results:
1. In the Results tab, right-click the results table and choose Select All from the shortcut 

menu that appears.

All of the results are copied to the system clipboard.

Figure 10.6  Planar spectral imaging tools, Results tab
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To export results:
1. Right-click the results table and select Export Results from the shortcut menu that 

appears.

In the dialog box that appears, choose a folder for the results, enter a file name (.txt), 
and click Save.
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The Living Image software applies spectral unmixing to distinguish the spectral 
signatures of different fluorescent or luminescent reporters and calculate the respective 
contribution of each on every pixel of an image. Use spectral unmixing to:

�• Extract the signal of one or more fluorophores from the tissue autofluorescence. 
Images can be acquired using epi-illumination (excitation light above the stage) or 
transillumination (excitation light below the stage)

�• Analyze luminescent or fluorescent images when more than one reporter is used in 
the same animal model

11.1 Image Sequence Requirements

Use the Imaging Wizard to set up the image sequence that is required for spectral 
unmixing. For more details on the wizard, see Chapter 4, page 33.

If you do not use the Imaging Wizard to set up the image sequence, it is recommended 
that the image sequence include images acquired using several filters that sample the 
emission or excitation spectra at multiple points across the entire range. Make sure that 
the band gap between the excitation and emission filters is sufficiently large (for example, 
>35 nm) so that the excitation light does not leak through the emission filter where it can 
be detected by the CCD.

11.2 Performing Spectral Unmixing
1. Load the image sequence.

In the example in Figure 11.1, the fluorophore is Quantum Dots 800. Images were 
acquired using a 675 nm excitation filter and emission filters from 720 to 820 nm in 
20 nm increments.



166  Living Image Software User’s Manual

2. In spectral unmixing tools, click the Analyze tab, and put a check mark next to the 
emission wavelengths that you want to include in the analysis.

3. Click Start Unmixing.

The Spectral Unmixing Wizard appears and shows the purple data mask that specifies 
the analysis area. By default, the data mask includes the entire subject.

Figure 11.1  Sequence for spectral unmixing 

Excitation 
wavelength

Emission 
wavelengths of 
the sequence
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4. If you do not want to analyze the entire subject, draw a data mask on a user-selected 
area using the data mask options.

5. Click Next in the wizard. 

In this screen, you will select the subject type and signals (components) to unmix.

Figure 11.2  Selecting the data mask 
For more details on the data mask options, see Table 11.1.

Table 11.1  Data mask options

Option Description
Photograph If this option is chosen, the software automatically draws the data mask 

so that it includes the entire photograph.

Threshold
If necessary use the threshold slider or  arrows to adjust the mask so 
that it matches the unerlying subject photograph as closely as possible 
without including any area outside the subject image.

Draw Mask Choose this option to manually draw a data mask on an area of the 
photograph.

Rectangle Specifies a rectangular shape for the manual data mask.

Ellipse Specifies an elliptical shape for the manual data mask.

Default data mask applied by the software Data mask manually applied to a user-
selected area
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NOTE
Select at least two, but no more than four components to unmix.

Figure 11.3  Choose the component to unmix

Table 11.2  Spectral unmixing wizard, choose the components to unmix

Item Description
Imaging Subject A drop-down list of subject types.

Background Signals Any undesired fluorescence that the camera detects; for example, 
autofluorescence from the animal, food, or instrument background.

Probe Information Specify the probes.

 - Click to add a probe.

 - Click to remove the selected probe.

Match Probe Labels If the probe names are specified, the software attempts to 
automatically match the unmixed spectra with the specified probe 
names. Note: A correct match is not guaranteed due to the complexity 
of the in vivo spectra and filter sections, especially when only part of the 
emission/excitation spectrum is sampled.

Use Constraints Choose this option to apply the recommended constraints when 
performing spectral unmixing. For more details on the constraints, see 
page 174. To disable the constraints, uncheck this option. Alternatively, 
in the Options tab of the Spectral Unmixing tools, click Reset Values 
and then click Update.

Number of components 
to unmix

The total number of components (background and probe signals) 
selected for unmixing.

1. Choose a subject type from the 
drop-down list.

2. Choose one or both types of 
background signals.

3. If the probe does not 
automatically appear in this list, 
select the probe(s). If you are not 
sure about the probe that was 
used, choose �“Unknown�”
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6. Click Finish when you are done choosing the components to unmix.

The unmixed images and results are displayed (Figure 11.4). The results include a 
signal distribution map of each unmixed result and a composite image that includes all 
of the fluorescent signals, each displayed in a different color.

7. To analyze an unmixed image, double-click the image.

The image appears in a separate image window and the Tool Palette is available. This 
enables you to make ROI measurements and image adjustments that are saved with the 
image.

8. To adjust the appearance of the composite image, double-click the composite image.

The composite image is displayed in a separate window.

Figure 11.4  Spectral unmixing results
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Figure 11.5  Composite image window

Table 11.3  Composite image window

Item Description
Units The type of data displayed in the composite image.

Image list A list of the images that comprise the composite (background 
component(s), probe(s), and a photograph).

Min/Max Sets the minimum and maximum count to display in the image.

Brightness Adjusts the brightness of the component signals.

Logarithmic Scale Choose this option to display signals using a logarithmic scale. This may 
be useful when probe signal strengths differ significantly, for example, 
a bright source and a dim source.

Color Shows the color of the figure legend for the image selected in the image 
list. Click the color swatch to open a color palette that enables you to 
select a new color for the figure legend.

Label The name of the image selected in the image list. To edit the name, 
double-click the name in this box. Right-click the label name to show a 
short-cut menu of edit commands (for example, Cut, Copy, Paste).

Copies the composite image to the system clipboard.

Click to export the composite image to a graphic file (for example, .jpg).

Opens the Print dialog box.
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11.3 Spectra Window

The Spectra window plots the normalized spectra of the unmixed results.

Figure 11.6  Spectra window

Table 11.4  Spectra window

Item Description
Enables you to select a spectrum to add to the graph.

From Library - Choose this option to select a probe from the Living Image 
database. The library includes spectra of different sources obtained using 
excitation and emission filters. 

From ROI - Choose this option to display a spectrum calculated for a user-
selected ROI.

Deletes the spectrum selected in the spectrum list from the plot.

Type The type of spectrum. 

UMX - A spectrum generated by the spectral unmixing algorithm.

LIB - A user-selected library spectrum. The library includes spectra obtained of 
different sources obtained using excitation and emission filters.

ROI - A spectrum calculated for a user-selected ROI.

Name The spectrum identifier used by the unmixing algorithm. The name cannot be 
modified.

Label The spectrum name in the spectrum plot key. Double-click the label to edit it.

The plot line color for a particular spectrum. For the UMX type spectrum, it is 
also the color in the composite image. Double-click a color swatch to open the 
color palette that enables you to change the plot line color for the spectrum.

Spectrum Plot

List of the spectra in the 
results. Add/remove a 
check mark to show/hide 
the spectrum in the plot.
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Adding Spectra to the Plot

You can add library spectra or a spectrum calculated for an ROI to the plot. 

To display library spectra:
1. Click the  button arrow and select From Library.

A new row appears in the spectrum list.

2. In the new row, select a probe name from the drop-down list.

To add spectra from an ROI:
1. Create an ROI on an image and apply it to the sequence.

1. Click the  button arrow and select From ROI.

A new row appears in the spectrum list.

2. In the new row, select an ROI name from the drop-down list.

To remove a spectrum:
1. In the spectrum list, select the spectrum (row) that you want to remove.

2. Click the  button.

Normalized Normalizes ROI spectra to library spectra.

Legend Click to show or hide the spectra plot legend.

Red Shift Adjusts library and ROI spectra to compensate for tissue absorption (simulates 
the red spectral shift of a spectrum produced by a signal that is located at a 
depth of 5 mm in tissue).

Table 11.4  Spectra window (continued)  

Item Description

Figure 11.7  Selecting a library spectrum to display
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11.4 Spectral Unmixing Parameters

The Results tab in the Spectral Unmixing Tool Palette shows the optimized fit parameters 
used by the software to derive the spectral unmixing results (Figure 11.8).

Figure 11.8  Tool palette, Spectral unmixing tools, Results tab

Table 11.5  Spectral unmixing tools, Results tab

Item Description
Spectral Unmixing Results

Number of 
Iterations

The number of iterations that the algorithm used.

Number of 
Components

The number of components unmixed.

Number of 
Wavelengths

The number of wavelength pairs used in the analysis.

Number of Samples The number of pixel samples used in the analysis.

Lack of Fit (%PCA) The fitting residue compared to the data filtered by principal component 
analysis.

Lack of Fit (% EXP) The fitting residue compared to the experimental data.

Divergence Counter The number of divergences that occurred.

Maximum Iterations The maximum number of iterations allowed.

Denoise (PCA) Indicates how much of the data was filtered by principal component analysis.

Normalization The normalization method used in the analysis.

Non-negativity 
Method

The non-negativity method used in the analysis.

Weighting Mode The weighting method applied to the data.

Column Weighting 
Mode

Indicates if column-wise weighting was used.

Row Weighting 
Mode

Indicates if row-wise weighting was used.

Save Results
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11.5 Spectral Unmixing Options

In the spectral unmixing tools, the Options tab shows the user-modifiable parameters in 
the spectral unmixing algorithm (Figure 11.9). It is recommended that you first perform 
spectral unmixing using the default settings. Then, if necessary, change the option 
settings and reanalyze the data.

 

Name The name of the selected spectral unmixing results.

Delete Removes the selected spectral unmixing results from the system.

Save Saves the spectral unmixing results.

Table 11.5  Spectral unmixing tools, Results tab (continued)  

Item Description

Figure 11.9  Spectral unmixing options

Table 11.6  Spectral unmixing options

Option Description
Constraints The constraints for unmixing the components. 

Reset Values Returns all constraint settings to the default values.

Init The method for generating the initial guess of the spectrum for the 
selected component. �“Auto�” means this is automatically determined by 
the software. Alternatively, you can used a loaded spectrum as the initial 
guess.

Fix This option determines whether the spectrum is allowed to change. If 
this option is chosen, the spectrum of that component is not updated 
during unmixing.

HP Sets a high pass filter for the spectrum. Signal below the HP cut-off 
frequency is forced to zero. Choose N/A to turn off the high pass filter. 
Otherwise, the value represents the high pass cut-off frequency. This 
constraint can help isolate components that are physically mixed and 
difficult to distinguish.
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PCA Explained Variance

The PCA Explained Variance histogram shows the part of variance (y-axis) that can be 
explained by a number of principal components (x-axis). 

LP Sets a low pass filter for the spectrum Signal above the LP cut-off 
frequency is forced to zero. Choose N/A to turn off the low pass filter. 
Otherwise, the value represents the cut-off frequency of the low pass 
cut-off frequency. This constraint can help isolate components that are 
physically mixed and difficult to distinguish.

Sort Choose this option to automatically sort the unmixed spectra in 
ascending order of their center wavelength.

Force Choose this option to force the first component to non-zero throughout 
the image.

Denoise by PCA Determines how much of the data will be filtered by principal component 
analysis. Stronger denoising means fewer principal components will be 
used in the data and more details will be lost. Stronger denoising also 
may slow down the unmixing.

PCA

Mode Standard - Principle component analysis performed on the original data.

Correlation - Principle component analysis performed on the correlation 
matrix of the original data.

Covariance - Principle component analysis performed on the covariance 
matrix of the original data. n 

Explained Variance Click to display the PCA variance plot (Figure 11.10).

Biplot Click to display the biplot graph (Figure 11.11).

Update Click to redo the spectral unmixing results with updated constraints.

Table 11.6  Spectral unmixing options (continued)  

Option Description

Figure 11.10  PCA explained variance histogram
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PCA Biplot

The PCA biplot is a visualization tool for principal component analysis. It shows a 
simultaneous display of n observations (pixels) and p variables (wavelengths) on a two-
dimensional diagram.

Figure 11.11  PCA biplot
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A surface is a 3D reconstruction of the animal surface (topography) derived from 
structured light images. The Living Image software requires a surface to perform some 
types of analyses (Figure 12.1). 

You can: 

�• Save a surface and use it for any of the analyses shown below

�• Export a surface for viewing in other 3D viewer applications

�• Import a surface 

For more details on how the software generates a surface, see Appendix H, page 317. 

Figure 12.1  Example surface and analyses that require a surface

Generate a surface for:

DLIT Analysis
3D reconstruction of luminescent sources 

displayed as voxels (page 193)

FLIT Analysis
3D reconstruction of fluorescent sources

displayed as voxels (page 201)



178  Living Image Software User’s Manual

12.1  Generating a Surface 

1. Load the image sequence for the reconstruction.

For example, a sequence that was acquired for DLIT analysis.

2. In the surface topography tools, make a selection from the Object drop-down list (nude 
mouse, fur mouse, or phantom).

3. Select an orientation (dorsal or ventral).

4. Select a smoothing level.

5. Click Reconstruct.

The Tomography Analysis box appears. By default, the entire subject is selected for 
the reconstruction. 

6. If you want to reconstruct only a particular region of the subject, resize the rectangle 
(drag a green handle ) so that it includes only the area of interest. 

7. Click Next.

The purple data mask appears. The mask is an overlay on the subject image that defines 
the area of interest for the surface topography reconstruction. The mask should match 
the underlying photograph of the subject as closely as possible without including any 
area outside the subject image.

Figure 12.2  Surface topography tools and tomography analysis box

The green rectangle 
selects the region to 
reconstruct. 
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8. If it is necessary, adjust the threshold value so that the mask fits the subject image as 
closely as possible. To change the threshold, do one of the following:

�• Press the left or right arrow keys on the keyboard.

�• Move the Threshold slider left or right.

�• Click the  arrows or enter a new value in the box.

9. Click Finish.

The surface and 3D tools appear in the Tool Palette. For more details on the Tool 
Palette, see page 220.

Figure 12.3  Data mask (purple) 

Figure 12.4  3D view and 3D tools in the toolbar and Tool Palette

Surface

3D View toolbar
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f

Figure 12.5  3D View toolbar

Table 12.1  3D view tools

Tool Description
Image Tools A drop-down list of tools for viewing and working with the surface. 

Select  to:

�• Click and display measurement dimensions in the coronal, sagittal, or transaxial 
view (in the 3D view window).

�• Drag a measurement cursor in the coronal, sagittal, or transaxial view and 
display measurement dimensions. (For details on measurement cursors, see 
page 107.)

Select  to zoom in or out on the image (use a click-and-drag operation).

Select  to move the subject in the window (use a click-and-drag operation).

Select  to rotate the subject around the x, y, or z axis (use a click-and-drag 
operation).

Click to hide or show the x,y,z-axis display in the 3D view window.

Click to hide or show coronal, sagittal, and transaxial planes through the surface 
in the 3D view window.

Click to show or hide a bounding box around the surface.

Click to show or hide a grid under the surface.

Select this tool from the drop-down list to change the view perspective (top, 
bottom, left, right, front, back, or perspective view). For examples of the views, 
see Figure 12.7.

Select this tool from the drop-down list to display the perspective view.

Click to show or hide measurement cursors in the coronal, sagittal, or transaxial 
views.

After you perform DLIT or FLIT analysis, click a voxel in the 3D reconstruction, 
then click this button to display measurements for the voxel in the 3D tools 
(source voxel measurements).

Enables you to save the 3D view to a graphic file (for example, .jpg).
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Changing the View Perspective

Figure 12.7 shows examples of the available views. You can view the surface from 
different perspectives by doing one of the following:

�• Select  to change the view (Figure 12.6) 

�• Alternatively, click the surface in the 3D View window, then press the V key to 
cycle through the different views of the surface 

Figure 12.6  Surface, perspective view

View name
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12.2 Managing Surfaces

After the surface is saved, it can be shared by the DLIT or FLIT tools.

Figure 12.7  Alternate views of a surface

Top Bottom Front

RightLeftBack

Figure 12.8  Tool palette, Surface topography tools

Surface name
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12.3 Export or Import a Surface

A surface can be shared with other users or viewed in other 3D viewer applications. 

NOTE
Surface import capability is only available if Show Advanced Options is selected in the 
general preferences (see page 266).

1. Load a surface. 

2. Select File → Export (or Import) → 3D Surface on the menu bar.

3. In the dialog box that appears, select a folder, enter a file name, and select a file type 
(see Table 12.2).

NOTE
Importing a surface by this method is for viewing purposes only, not for registration with 
optical reconstructions in Living Image software. To import a surface or other organs for 
registration purposes, import an organ atlas. For more details, see page 230.

Item in the Surface 
Topography Tools

Description

Name Name of the selected surface.

Delete Removes the selected surface from the system.

Load Opens the selected surface.

Save Saves a surface to the selected name.

Overwrite Saves the surface and overwrites the previous surface results.

Table 12.2  Surface file types

Export Option Description Export Import
Surface mesh 
(.xmh)

A native file format of the Living Image software that is 
used to exchange 3D surface information between 
Living Image software and other third party analysis 
tools. It is based on a basic indexed face set format 
which stores all of the vertex information first, then 
stores the triangle information in terms of indexes into 
the vertex list.

yes yes

AutoCAD DXF (.dxf) Drawing exchange format that is compatible with most 
DXF file viewers.

yes yes

VRML 1.0 (.wrl) VRML 1.0 (.wrl) - Virtual reality modeling language 
format that is compatible with most VRML viewers.

yes no

Open Inventor (.iv) The ASCII version of the IV file format which is 
supported by all IV viewers.

yes yes

STL (.stl or ASCII 
format) 

Stereo lithography binary format compatible with most 
STL viewers.

yes

(binary)

yes
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It is possible to determine the number of cells in a DLIT source or the number of dye 
molecules or cells in a FLIT source if a quantification database is available. The database 
is derived from an analysis of images of known serial dilutions of luminescent cells or 
fluorescent cells or dye molecules.

13.1 Preparing & Imaging the Samples
1. Prepare a well plate (4 x 6, 6 x 4, 8 x 12, or 12 x 8 well format) that contains a dilution 

series of luminescent cells or fluorescent dye at four or more concentrations.

2. Include at least four background wells that contain diluent only.

3. Place the well plate on the IVIS stage, positioning it so that it is centered and squared 
in the field of view.

NOTE
All of the wells must be within view in the image. For wells containing fluorosphores, FOV D is 
recommended to reduce shadows from well walls and ensure more uniform excitation of the wells.

4. Acquire the images:

Bioluminescent samples - Acquire one 'Open' filter image of the well plate

Fluorescent samples - Acquire reflectance-illumination Filter Scan images using the 
appropriate excitation and emission bandpass filters.

The well plate in Figure 14.1 contains a dilution series of a sample at four 
concentrations.  The image sequence is a filter scan set of images with the excitation 
filter centered at 465 nm for all the images, and emission filter images centered at 520 
nm, 540 nm, 560 nm, and 580 nm.

Figure 13.1  Well plate data
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13.2 Creating a Quantification Database
1. Load the well plate image sequence.

2. Select Tools → Well Plate Quantification for �“<name>_SEQ�” on the menu bar.

The Well Plate Quantification window appears.

3. For fluorescent samples, choose the Dye molecules or Cells option.

4. Select the well plate dimensions from the Well Plate Type drop-down list.

The first image in the sequence opens and a grid ROI appears on the image.

5. Adjust the grid ROI to closely fit the plate wells.

Figure 13.2  Well Plate Quantification window

Figure 13.3  Well plate image with grid ROI

These options only available
for fluorescence data.
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6. In the well plate table, select the sample cells, and click Set (Figure 13.4). 

Clicking a row or column header selects the entire row or column. 

7. To remove the �“sample�” designations from table cells, select the cells and click the  
button.

8. To apply a color to table cells:

a. Select the table cells and click the  button. Alternatively, right-click the selected 
table cells and choose Background Color on the shortcut menu.

b. Choose a color from the color palette that appears. 

9. Enter the dilution values in the table cells. 

NOTE
The values must be entered as dimensionless numbers. For example, for a picomole of dye 
molecules, enter "6.022e11". 

10. To delete a dilution value, select the table cell and press the Delete key. Alterrnatively, 
right-click the number to view a shortcut menu of edit commands (for example, cut, 
copy, paste).

11. Choose the Apply to Sequence option.

12. Choose the Background Wells option.

13. In the well plate table, select the background wells and click Set.

Clicking a row or column header selects the entire row or column. To remove the 
�“background�” well designations, click the  button.

Figure 13.4  Select the sample wells and enter the number of cells or molecules
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14. Click Quantify.

The results are displayed 

15. Check the linear fit of the data for each image in the quantification plot.

A good straight line fit gives confidence to the results values. Large deviations from a 
straight line could indicate possible issues with the dilution series or errors when 
entering sample dilution values. 

16. To export the quantification plot values:

Figure 13.5  Set the background wells

Figure 13.6  Example fluorescence quantification plot and results
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a. Click the  button.

b. In the dialog box that appears, select a folder for the file (.csv) and click Save.

17. To copy the quantification plot values to the system clipboard, click the  button.

13.3 Managing Quantification Results

The quantification results can be saved with the image sequence and as a calibration 
database that is made available in the DLIT or FLIT 3D reconstruction tools (in the 
Properties tab). When you define the properties for performing a 3D reconstruction and a 
calibration database is specified, the 3D reconstruction results will be displayed in 
calibrated units for cell numbers or molecule quantities in picomole units. 

Table 13.1  Quantification results

Item Description
Fluorescence

Excitation (nm)

Emission (nm)

The excitation and emission filter wavelengths for the image. 
'Excitation' and 'Emission' filters will be specified for fluorescent 
images, and the 'Open' filter for 'Emission' will be specified for 
bioluminescent images.

Extinction Coeff A measure of excitation photon absorption interaction with the well 
plate samples based on a base-10 logarithmic derivation. The quantum 
efficiency factor of the conversion of the absorbed photon to the 
emission wavelength is also included.

Cross Section A measure of excitation photon absorption interaction with the well 
plate samples based on a natural logarithmic derivation. The quantum 
efficiency factor of the conversion of the absorbed photon to the 
emission wavelength is also included.

Bioluminescence

Total Flux/cell A measure of total flux (photon/sec) emitted from a single cell. This 
number can be used to estimate the number of cells from the total flux 
in the 3D quantification.

Figure 13.7  Save the quantification results

Saves the results with 
the image sequence

Saves the results to a database that is 
available for DLIT or FLIT analyses
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Exporting Quantification Results

Right-click the results table to view copy and export options.

�• Copy �– Copies the selected rows to the system clipboard

�• Select All �– Selects all rows in the results table

�• Export Results �– Opens a dialog box that enables you to export the selected results 
to a text file

Table 13.2  Managing quantification results

Item Description
Delete - Removes the active quantification results from the image 
sequence.

Load - Opens quantification results from the sequence path.

Save - Saves the quantification results with the selected image 
sequence.

Overwrite - Saves the results with the selected image sequence and 
overwrites previous results.

Delete - Deletes the database from the system.

Load - Opens quantification results from the system path.

Save - Saves the quantification results to a system database that is 
available for DLIT or FLIT reconstruction. 

Overwrite - Saves the results to the selected database name and 
overwrites previous results.

Figure 13.8  Well plate quantification results
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The Living Image® software provides algorithms which analyze 2-dimensional image data 
to reconstruct 3-dimensional (3D) luminescent or fluorescent sources located inside an 
animal (tomographic analysis). For more details on the DLIT or FLIT algorithm, see 
Appendix H, page 317.

The input data to the DLIT algorithm for a 3D reconstruction of luminescent light sources 
includes:

�• A structured light image that is analyzed to generate a surface for the imaging 
subject.

�• A sequence of two or more images of the light emission from the surface of the 
subject acquired at different filter bandwidths (Table 14.1). Use the Imaging Wizard 
to acquire the images.

The input data to the FLIT algorithm for 3D reconstruction of fluorescent light sources 
includes: 

�• A surface that defines the surface of the subject.

3D Reconstruction 
Algorithm

Description  Page

Diffuse Tomography 
(DLIT)

DLIT provides a complete 3D reconstruction of the 
luminescent source distribution within the subject. DLIT 
places no constraints on the geometry or spatial 
variation of the source strength throughout the volume. 
DLIT is well-suited for analyzing complex and spatially 
extended luminescent sources. The 3D reconstruction is 
presented as voxels. If a luminescent calibration 
database is available, the number of cells per source can 
be determined in addition to source intensity (photons/
sec).

194

Fluorescent Tomography 
(FLIT)

FLIT provides a complete 3D reconstruction of the 
fluorescent source distribution within the subject.The 
3D reconstruction is presented as voxels. If a fluorescent 
calibration database is available, the number of 
fluorophore molecules or cells per source can be 
determined in addition to the total fluorescence yield.

201
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�• A sequence of images acquired at different transillumination source positions using 
the same excitation and emission filter at each position. Use the Imaging Wizard to 
acquire the images.

Figure 14.1 shows an example 3D reconstruction workflow.

Table 14.1  IVIS System filters for luminescence & fluorescence tomography

IVIS Imaging System Filters Bandwidth
200 Series 6 emission filters, 550-670 nm 20 nm

Spectrum 10 excitation filters, 415-760 nm

18 emission filters, 490-850 nm

30 nm

20 nm

Figure 14.1  Basic workflow for 3D reconstruction of sources

! Load an image sequence (see page 193 
for image sequence requirements)

" Generate or load a surface

$ Select tissue and 
source properties

# Reconstruct and view source measurements
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14.1  Reconstructing Luminescent Sources

General Considerations

Animal Requirements

The best surface topography reconstruction is obtained from nude mice. It is possible to 
perform 3D imaging on white or light-colored furred mice if the fur is reasonably smooth 
over the mouse surface. Therefore it is recommended that you comb the fur before 
imaging to eliminate any "fluffy" areas that may trigger artifacts during the surface 
topography reconstruction. In this case, it is recommended that you shave the animals or 
apply a depilatory. 3D reconstructions are currently not possible on black or dark-colored 
furred mice.

Luminescent Exposure vs. Luciferin Kinetic Profile

It is important to consider the luciferin kinetic profile when you plan the image sequence 
acquisition. The DLIT algorithm currently assumes a flat luciferin kinetic profile. 
Therefore, to optimize the signal for DLIT 3D reconstruction, carefully plan the start and 
finish of image acquisition and ration the exposure time at each emission filter so that the 
sequence is acquired during the flattest region of the luciferin kinetic profile. 

Image Sequence Requirements

Use the Imaging Wizard to setup the image sequence required for DLIT analysis. For 
more details on the Imaging Wizard, see page 33.

If you plan to manually set up the sequence, Table 14.2 shows the recommended image 
sequence. Analyzing more images usually produces more accurate results. At a minimum, 
the sequence must include data from at least two different emission filters (560-660 nm):

�• Emission filter #1: Photographic, luminescent

�• Emission filter #2: Luminescent image

�• One structured light image

NOTE
It is recommended that the binning level be the same for all of the luminescent images.

For more information on the DLIT algorithm and user-modifiable parameters, see 
Appendix H, page 317.

Table 14.2  Recommended image sequence for DLIT analysis 

Image Type Emission Filter Options
560 580 600 620 640 660

Photograph ( Select the Reuse option in the control panel. 

Structured light (

Luminescent ( ( ( ( ( (
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Steps to Reconstruct Luminescent Sources Using DLIT

1. Load an image sequence.

2. Generate or load a surface using the Surface Topography tools. For details on 
generating the surface, see page 181.

3. In the Tool Palette, choose DLIT 3D Reconstruction.

The Analyze tab shows the data that the algorithm automatically selects for the 
reconstruction (Figure 14.2). For more details about the Threshold %, see page 198.

4. In the Properties tab, make a selection from the �“Tissue Properties�” and �“Source 
Spectrum�” drop-down lists (Figure 14.3).

Figure 14.2  Analyze tab
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5. To view the tissue properties (µa, µeff, µ�’
s) for the tissue and source you selected, make 

a selection from the Plot drop-down.

6. To compute the number of cells per source, select a luminescent calibration database.

For details on generating a luminescent calibration database, see page 185.

7. In the Analyze tab, click Start.

The Data Preview window appears and displays the image data that will be included 
in the reconstruction. Usually, no data adjustment is required. However, it is possible 
to exclude or include user-selected pixel data from the analysis. For more details, see 
page 198.

Figure 14.3  Properties tab

Figure 14.4  Data Preview window (right)

The selected plot type is displayed below.



196  Living Image Software User’s Manual

8. In the Data Preview window, click Reconstruct.

The reconstruction normally requires less than one minute, depending on the 
reconstruction volume, parameter settings, and computer performance. When the 
analysis is finished:

�• The 3D View window displays the animal surface and the reconstructed sources

�• In the Tool Palette, the Results tab displays the results data and the algorithm 
parameter values

�• The 3D Tools appear after a reconstruction is generated or loaded. For more details 
on the 3D Tools, see page 220-231.

For details on managing results (for example, save, load, or delete), see page 205. 

Figure 14.5  DLIT reconstruction results

3D View toolbar
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f

Figure 14.6  3D View toolbar

Table 14.3  3D View tools

Tool Description
Image Tools A drop-down list of tools for viewing and working with the surface or DLIT 

results. 

 or  - Rotates or spins the surface in the x, y, or z-axis direction.

 - Moves the surface in the x or y-axis direction.

 - Zooms in or out on the image. To zoom in, right-click (Cmd key (apple 
key) +click for Macintosh users) and drag the  toward the bottom of the 
window. To zoom out, right-click and drag the  toward the top of the 
window.
Displays the x,y,z-axis display in the 3D view window.

Displays coronal, sagittal, and transaxial cross-sections through the subject 
in the 3D view window.

Displays a bounding box around the subject.

Displays a grid under the subject.

Select this tool from the drop-down list to change the view perspective (top, 
bottom, left, right, front, back, or perspective view). For examples of the 
views, see Figure 14.35, page 229.

Select this tool from the drop-down list to display the perspective view.

Rotates the 3D reconstruction results in the 3D view window (3D scene). 
Click the + or - key to increase or decrease the rotation speed.To stop the 
rotation, click the 3D scene or the  button.

Displays measurement cursors in the coronal, sagittal, or transaxial views.

Click this button, then select a source or a point in a source to obtain source 
measurements (total flux, volume, center of mass, host organ) in the 3D 
tools (Source tab). For more details, see page 209.

Copies or pastes voxels or a source surface so that DLIT and FLIT 
reconstructions can be displayed on one surface. For more details, see 
page 213.

Enables you to save the 3D view to a graphic file (for example, .jpg).
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Data Preview Window

The Data Preview window shows the image data that the algorithm automatically selects 
for reconstruction. In special cases, you may want to include or exclude particular data 
from this default selection. There are two ways to do this:

�• Change the Threshold % value - Applying a Threshold % value excludes or includes 
some pixels from the reconstruction. The software computes the minimum and 
maximum pixel values of an image based on an histogram of pixel intensities. If 
Threshold % = 0.5%, then pixels with intensity less than 0.5% of the maximum 
intensity value are excluded from the reconstruction. The Threshold % can be edited 
for individual images. The Data Preview window is updated when you change the 
Threshold % value.

�• Region selection - Use the pencil tool to mark particular regions to include in the 
reconstruction. This may be useful for noisy images with high intensity pixels where 
changing the Threshold % value is not helpful. You can also use this method to focus 
on particular sources to reconstruct and ignore others.

To change the Threshold % for a selected image:
1. Click Start in the Analyze tab (Figure 14.7).

The Data Preview window appears.

2. Click an image in the Data Preview window. 

NOTE
Changes to Threshold % are applied to the selected image only. To apply the change to all 
images, choose the Select All option.

3. Click Data Adjustment.

4. In the window that appears, enter a new Threshold % value.

The new Threshold % appears in the Analyze tab.

5. To reset the Threshold % to the default value (for the selected images), click Restore 
Threshold.
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To select particular regions for reconstruction:
1. Open the Data Preview window as shown in Figure 14.7.

2. Click Data Adjustment.

3. In the window that appears, choose the Draw option and put the mouse pointer over 
the image so that the pencil tool  appears.

4. To automatically select all pixels in a source, right-click with the region with the 
pencil tool. 

Alternatively, put the pencil over the image and click the mouse key or press and hold 
the mouse key while moving the pencil over an area of the image.

Figure 14.7  Adjusting the Threshold %

Set the Threshold % here 

Note: Min Counts translates the 
Threshold % to the minimum counts 
required for reconstruction.

Data Preview window

The red outline 
indicates the 
image selected 
for data 
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NOTE
If the pencil tool markings are applied to the image, only the marked pixels are included in 
the analysis. 

Figure 14.8  Selecting regions to include in reconstruction

Table 14.4  Region Selection Tools

Item Description
Draw Choose this option to display the pencil tool . Use this tool to 

apply markings that select regions to include in the reconstruction.

Erase Choose this option to display the eraser tool. Use the eraser to 
remove pencil tool markings (exclude pixels from the image).

Painting size Adjusts the width of the pencil tool mark or the eraser tool.

Segment Colors available for the pencil tool. 

Opacity Adjusts the opacity of the pencil tool markings.

Reset Removes all pencil tool markings.

Use these tools to select particular image data 
to include in the analysis
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14.2  Reconstructing Fluorescent Sources

Image Sequence Requirements

Use the Imaging Wizard to setup the image sequence required for FLIT analysis. (For 
more details on the Imaging Wizard, see page 33.) If you plan to manually set up the 
sequence, Figure 14.9 shows the an example image sequence. Acquire the images using 
transillumination on the IVIS® Spectrum Imaging System using the same excitation and 
emission filters from at least four source locations that form a rectangle.

Steps to Reconstruct Fluorescent Sources

1. Load an image sequence.

2. Generate or load a surface. For details on generating the surface, see page 181.

3. In the Tool Palette, choose FLIT 3D Reconstruction.

The Analyze tab shows the images that the algorithm automatically selects for the 
reconstruction based on an appropriate signal level (Figure 14.2). For more details 
about the Threshold %, see page 198.

Figure 14.9  Example sequence setup for FLIT

Acquire a fluorescent image, 
structured light image, and 
photograph at the first 
transillumination location 

Acquire a fluorescent image 
at the remaining 
transillumination locations.
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4. Select the type of image used in the reconstruction: Radiance or NTF Efficiency 
(Figure 14.10).

5. In the Properties tab, make a selection from the �“Tissue Properties�” and �“Source 
Spectrum�” drop-down lists (Figure 14.3).

Figure 14.10  FLIT 3D Reconstruction tools, Analyze tab

Figure 14.11  FLIT 3D Reconstruction tools, Properties tab

Images selected 
for reconstruction

Type of image used in 
the reconstruction. 
If no NTF data are 
available, only 
Radiance is available.

Select an algorithm 

The selected plot type 
is displayed below.
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6. To view the tissue properties (µa, µeff, µ�’
s) for the tissue you selected, make a selection 

from the Plot drop-down.

7. To include the number of fluorescent molecules/source in the results, select a 
fluorescent calibration database.

For details on generating a luminescent calibration database, see page 185.

8. In the Analyze tab, click Start.

9. The Data Preview window appears and displays the image data that will be included 
in the reconstruction. Usually, no data adjustment is required. However, it is possible 
to exclude or include user-selected pixel data from the analysis. For more details, see 
page 198.

You can also include or exclude image data by adding or removing the check mark 
next to the images listed in the Analyze tab (Figure 14.10).

10. Click Reconstruct.

The reconstruction normally requires less than one minute, depending on the 
reconstruction volume, parameter settings, and computer performance. When the 
analysis is finished:

�• The 3D View window displays the surface and the reconstructed sources

�• In the Tool Palette, the Results tab displays the results data and the algorithm 
parameter values (Figure 14.13).

�• The 3D Tools appear in the Tool Palette. For more details on the 3D Tools, see 
page 220-231.

For details on managing results (for example, save, load, or delete), see page 205.

Figure 14.12  FLIT results: 3D View window and Results tab
For details on the 3D View toolbar, see Table 14.3, page 197.

3D View toolbar
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14.3 3D Reconstruction Results

The Results tab displays information about the photon density, voxels, and algorithm 
parameters.

DLIT or FLIT Results

NOTE
For more details on DLIT, see Appendix H, page 317. Sometimes adjusting the DLIT 
algorithm parameters improves the fit of the simulated photon density to the measured 
photon density data.

Figure 14.13   Example DLIT 3D reconstruction results

Table 14.5  DLIT or FLIT 3D reconstruction results

Item Description
Final voxel size (mm) The voxel size (length of a side, mm) that produces the optimum 

solution to the DLIT or FLIT analysis.

Number of voxels The number of voxels that describe the light source(s).

Reduced Chi2 A measure of the difference between the computed and 
measured photon density maps at the optimum solution. A 
smaller χ2 value indicates a better quality of fit. 

Starting voxel size The voxel size at the start of the analysis. The length of the side 
of the voxel cube in mm units for the coarsest initial grid size in 
the adaptive gridding scheme.

Nsurf (best) The number of surface element data analyzed per wavelengths/
images.

Total surf samples The total number of surface element data analyzed for all 
wavelengths/images.
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Managing 3D Reconstruction Results

Threshold angle The angle that the object surface normal makes with the optical 
axis. The optical axis can be considered to be a line 
perpendicular to the stage. The default setting for this limit is 70° 
for IVIS Spectrum or IVIS 200 data. 

Image Threshold The percentage of the minimum radiance at each wavelength 
(DLIT) or source location (FLIT) is of the maximum radiance. This 
defines the minimum intensity included in the data.

Tissue Properties The tissue properties for modeling the photon propagation.

Source Spectrum The emission spectrum of the type of luminescent source.

Photon Density Maps Click to view the photon density maps. For more details, see 
page 207.

Export Results Opens a dialog box that enables you to save the results (.csv).

Save Results

Name The default name for the active DLIT or FLIT results. Select 
results from this drop-down list.

Delete Click to delete the selected DLIT or FLIT results.

Load Click to load the selected DLIT or FLIT results.

Save Click to save the active DLIT or FLIT results.

Overwrite If you reanalyze saved results, click to save the new results and 
overwrite the previous results.

Table 14.5  DLIT or FLIT 3D reconstruction results (continued)  

Item Description

Figure 14.14  3D analysis results

Results name
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To save 3D results:
1. In the Results tab of the DLIT/FLIT 3D reconstruction tools, confirm the default name 

or enter a new name.

2. Click Save.

The results are saved to the sequence click number folder and are available in the 
Name drop-down list.

To open 3D results:
1. In the Results tab, make a selection from the Name drop-down list.

2. Click Load.

The 3D results appear in the 3D View window.

To copy user-specified results:
1. In the Results tab, select the text of interest. 

2. Right-click the results table and select Copy from the shortcut menu that appears. 

The selected results are copied to the system clipboard.

To copy all results:
1. In the Results tab, right-click the results table and choose Select All from the shortcut 

menu that appears.

2. Right-click the results table again and select Copy from the shortcut menu.

All of the results are copied to the system clipboard.

To export results:
1. In the results tab, right-click the results table and select Export Results from the 

shortcut menu that appears.

2. In the dialog box that appears, choose a folder for the results, enter a file name, and 
click Save.

The exported results are saved in .csv file format.

To delete results:
1. In the Results tab, make a selection from the Name drop-down list.

2. Click Delete.

The results are deleted from the system.
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14.4  Checking the Reconstruction Quality

To check the quality of a 3D reconstruction, it is useful to compare the measured and 
simulated photon density plots. The photon density is closely related to the measured 
radiance. Photon density is the steady state measure of the number of photons in a cubic 
millimeter. Light sources inside the tissue contribute to photon density in other portions 
of the tissue. 

The reconstruction algorithms first convert the luminescent image of surface radiance to 
photon density just below the animal surface because this is what can be observed. Then 
the algorithm solves for point source locations inside the tissue which would produce the 
observed photon density near the surface. 

To view photon density maps:
1. After the reconstruction is finished or results are loaded, click Photon Density Maps 

in the Results tab.

The photon density maps for all wavelengths are displayed (Figure 14.15).

2. To rotate the surface and view it from a different angle, move the thumb wheel to the 
left or right

3. Select a wavelength from the drop-down list

The photon density profiles at the crosshairs location are displayed. In a good 
reconstruction, the simulated (red) photon density curves closely resemble the 
measured (blue) photon density curves.

Figure 14.15  Photon density maps

Use the thumb wheel to rotate the surfaces
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4. To view the photon density profile at another location on the animal surface, drag the 
cross hairs or click a point on the photon density map.

Figure 14.16  Simulated and measured photon density plots

Table 14.6  Photon Density Maps window

Item Description
Image sources A list of images used in the reconstruction. Select all images or a 

particular image number to display.

Angle of View The thumb wheel position. Turn the thumb wheel to rotate the 
surface on the vertical axis.

Log Scale Choose this option to display the photon density using a log scale.

Simulated The photon density computed from DLIT or FLIT source solutions 
which best fit the measured photon density.

Measured The photon density determined from the image measurements of 
surface radiance.

Horizontal Profile The photon density line profile at the horizontal plane through the 
subject at the crosshairs location.

Vertical Profile The photon density line profile at the vertical plane through the 
subject at the crosshairs location.

Position (mm) Horizontal Profile: The y-axis position of the crosshairs horizontal 
line. Vertical Profile: The x-axis position of the crosshairs vertical 
line.

620 nm wavelength 
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14.5 Measuring Sources

This section presents a convenient way to measure the source (total flux or total 
florescence yield, or if calibrated, the abundance in cells or picomoles. The volume, 
center of mass, and depth at the center of mass are also reported in the 3D Tools-Source 
tab. 

NOTE
If the surface contains voxels pasted from other reconstruction results, choose a source in 
the 3D Source tools (Figure 14.17). For more details on pasting voxels, see page 213.

Determine Source Center of Mass

1. Click the  toolbar button and then drawing a box around the source.

2. Click Center of mass in the 3D tools Source tab (Figure 14.17) to obtain measured 
source information:

Quantification �– The integrated intensity within the selected sources.

Volume �– The total volume of the selected sources.

Depth �– The perpendicular distance from the source center of mass to dorsal surface.

Center of Mass �– The weighted average x, y, and z-coordinates of the selected voxels, 
where the weights are the flux of each highlighted voxel.

Host Organ �– The organ in which the selected sources are located. This information is 
available if organs are displayed with the reconstruction. For more details on 
displaying organs, see 3D Tools - Registration, page 225

NOTE
The coronal, sagittal, and transaxial planes intersect at the center of mass of the selected 
source (Figure 14.18).
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Measure Source Depth

1. Select the source by drawing a box around it (see Figure 14.17).

2. Click the  button.

The distance from the center of mass to the surface is measured in the three planes 
(Figure 14.18).

�• Coronal and transaxial planes display the shortest distance from the center of mass 
to the surface

�• The sagittal plane displays the distance from the center of mass to the bottom of the 
subject.

3. To display slice planes through the center of mass, click the  button. For more 
details on planes, see page 212.

Figure 14.17  Select and measure source voxels in the 3D View window

" Click the Measure Source button, 
then draw a box around the source.

$ Click Center of Mass to obtain 
the measured source information.

! If the surface includes voxels pasted from other 
results, select a source from the drop-down list.
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Viewing Coordinates

1. In the Coronal, Sagittal, or Transaxial windowpane, click a location in the 
reconstruction slice. 

The coordinates (mm) of the position are displayed. The coordinates are updated when 
you press and hold the mouse button while you drag the cursor. 

�• Coronal plane - Displays the x-y coordinates.

�• Sagittal plane - Displays the y-z coordinates.

�• Transaxial plane - Displays the x-z coordinates.

Figure 14.18  Slice planes 
This example shows slice planes through a selected source center of mass and distance 
measurements from the source center of mass to the surface.

Figure 14.19  Viewing y,z coordinates in the sagittal plane



212  Living Image Software User’s Manual

Displaying Slices Through a Reconstruction

1. Click a location on a source. Alternatively, click the  toolbar button, draw a box 
around a source, then click Center of mass in the 3D Source tools.

2. Click the  toolbar button. 

The Coronal, Sagittal, and Transaxial windowpanes show a slice through the surface 
taken by the associated plane.

3. To move a plane, put the mouse cursor over a line in the coronal, sagittal, or transaxial 
windowpane. When the cursor becomes a  or  arrow, drag the line.

The view is updated in the windowpanes as you move the line.

Figure 14.20  Planes cutting a reconstruction

Figure 14.21  Moving the coronal plane

Transaxial plane

Coronal plane

Sagittal plane
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14.6  Displaying Luminescent and Fluorescent Sources on One Surface

If an experiment includes luminescent and fluorescent reporters, DLIT and FLIT 
reconstructions can be displayed on one surface. 

NOTE
If the DLIT and FLIT image sequences are acquired during the same session, the generated 
surfaces are nearly identical. 

1. Load a DLIT reconstruction and a FLIT reconstruction.

2. Choose one of the reconstructions, click the  button and select Copy source voxels. 

3. In the other reconstruction, click the  button and choose Paste source voxels.

NOTE
Pasted voxels can be measured. For more details on measuring sources, see page 209.

14.7 Comparing Luminescent and/or Fluorescent Sources

Multiple DLIT and/or FLIT reconstruction results can be viewed side-by-side in the 
Longitudinal Study window. Voxel intensity within the entire surface or a user-selected 
area can be measured in all results in the Longitudinal Study window. The Longitudinal 
Study window provides a convenient way to compare different results, for example, 
results obtained at different time points or results from different types of reporters.

Viewing Results in the Longitudinal Study Window

1. Load the DLIT and/or FLIT sequences with the results that you want to display. Select 
Tools → Longitudinal Study on the menu bar.

The Longitudinal Study window appears. 

Figure 14.22  Longitudinal Study window

Loaded DLIT or 
FLIT sequences

Results saved with the 
sequence selected in 
the upper box. 

Select results to display 
from this box.
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NOTE
After the Longitudinal Study window is open, more sequences can be added to the 
Longitudinal Study window by clicking the Open button  and selecting sequenceinfo.txt 
files (found in the sequence data folder).

2. To show particular results:

a. Select a sequence in the upper box.

b. Select one or more analysis results in the lower box. To choose multiple adjacent 
results, press and hold the Shift key while you click the first and last result. To 
choose non-adjacent results, press and hold the Ctrl key while you click the results.

c. Click Load.

3. To show more results, repeat step 2.

4. To remove results from the Longitudinal Study window, right-click a surface and 
select Remove on the shortcut menu. Alternatively, select a surface, click the Remove 
button  and choose Selected Result.

To remove all results, click the Remove button  and choose All Results.

5. To view a particular image in a sequence:

a. Click the surface.

b. For DLIT results, make a selection from the Wavelength drop-down list. For FLIT 
results, make a selection from the Image drop-down list.

Figure 14.23  DLIT and FLIT results in the Longitudinal Study window

Voxel color scale

If both DLIT and 
FLIT results are 
loaded, two color 
scales are 
displayed.

Click a surface to select it

Choose an image to display 
from the selected results

Use the thumb wheel 
to rotate the surfaces

For more details on 
these display controls, 
see Table 14.7, page 217.
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Measuring Intensity

1. After results are loaded, click the  button.

By default, a selection box appears around each surface (Figure 14.24). This means 
that measurements for the entire surface will be computed.

2. To select a particular region of the surface for measurements, draw a box (by clicking 
and dragging the mouse) around the area. 

The same box is applied to the other surfaces in the Longitudinal Study window. 

3. To clear boxes, click the  button again.

Viewing Plots

In the Plots tab, make a selection from the Analysis Type and Plot drop-down lists (Figure 
14.25). 

The following graphs are available in the Plots tab:

�• Quantification Profile �– Plots the measured intensity within the user-selected area 
on the surface. If no box was drawn on the surface, measures the total intensity for 
the entire surface.

�• Reduced Chi-Squared Profile �– A measure of the difference between the computed 
and measured photon density maps at the optimum solution. A smaller χ2 value 
indicates a better quality of fit. 

�• Voxel Size �– Plots the voxel size at the start of the 3D reconstruction and at the end 
of the 3D reconstruction. 

Figure 14.24  Selection boxes around each surface
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Figure 14.25  Example Quantification plot

0 = First surface 2 = Third surface (and so on)1= Second surface 
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14.8 Exporting a 3D Scene as DICOM

The items in the 3D View comprise a 3D scene. For example, the 3D scene in Figure 14.26 
includes a surface and voxels. The 3D scene can be exported to DICOM format and 
viewed in the Living Image DICOM Viewer or third party software.

Table 14.7  Longitudinal Study window

Item Description
Voxel display controls:

Display Voxels – Choose this option to show voxels 
with the surface.

From the drop-down list, select a color scheme for the 
color scale. Move the sliders to adjust the color scale 
minimum and maximum values.

Reverse – Choose this option to apply the colors of 
the selected color table in reverse order to the photon 
density scale. For example, the Red color table 
represents the source intensity (photons/sec) from 
low to high using a color scale from transparent to 
red. If Reverse is chosen, the source intensity 
(photons/sec) from low to high is represented using 
the color scale from red to transparent.

Log Scale – Applies a log scale to the color scale.

MIP – When this option is chosen, all maximum 
intensity voxels in the view are projected along the 
viewing direction into the viewing plane.

Copies the 3D View tab in the Longitudinal Study 
window to the system clipboard.

Opens a dialog box that enables you to export the 3D 
View tab to a graphic file (for example, .png).

Enables you to select voxels for measurement. 
Measurements are displayed in the Plots tab.

Figure 14.26  3D scene

3D scene
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To export the 3D scene:
1. Load the results that you want to export.

2. Select File → Export → 3D Scene as DICOM on the menu bar.

3. In the dialog box that appears, set the export options, and click Export.

For more details on the 3D Scene Exporter, see Table 14.8.

4. In the Browse For Folder dialog box that appears, choose a folder for the DICOM files 
and click OK.

During the export operation, the 3D View window displays the each slice in the export. 
For example, if Transaxial Slice is selected for export, then the transaxial windowpane 
cycles through a display of each exported slice.

Figure 14.27  3D Scene Exporter dialog box

Table 14.8  3D Scene Exporter dialog box 

Item Description
Save DICOM as: Single-Frame DICOMs - Exports multiple files that contain a single 

frame each.

Multi-Frame DICOM - Exports a single file that contains multiple 
frames.

Note: Choose the Single-Frame or Multi-Frame DICOM option, 
depending on the third party software you will use to import and 
view the 3D scene. Some applications cannot reconstruct multi-
frame DICOM files.

Slice Orientation Choose transaxial, coronal, or sagittal slices for the export.

Export voxels using 
original resolution

Choose this option to export source voxels without any smoothing 
or binning. The original resolution of the source voxels is the 
resolution obtained after DLIT or FLIT reconstruction 
(approximately 1mm resolution). 

Slice Resolution Sets the number of slices required to accommodate the slice 
orientation with good slice sampling/spacing. 

Total Slices

Slice spacing

Pixel spacing

Parameters that determine the number and resolution of the slices 
to export.

Solid mesh If this option is chosen, voxels generated inside the hollow mesh 
are assigned an intensity so that they are displayed as “tissue” 
when loaded into visualization software. If no intensity is associated 
with the voxels, they are considered noise or air and appear hollow.
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Viewing the DICOM Data

The 3D scenes exported to DICOM can be viewed in the Living Image® 3D Browser. 

1. Select File → Browse 3D Volumetric Data on the menu bar.

2. In the dialog box that appears, select the DICOM data (.dcm or .dc3) and click Open.

The 3D Browser window appears.

3. To 

Hollow mesh The intensity of pixels inside the surface is set to zero so that the 
exported surface appears as a hollow empty structure. 

Table 14.8  3D Scene Exporter dialog box  (continued)  

Item Description

Figure 14.28  Living Image 3D Browser

Table 14.9  Living Image 3D Browser DICOM viewing controls

Item Description
Start Index Specifies the first image (slice) for viewing.

Auto Preview Select this option to automatically play back the images.

End Index Specifies the last image (slice) for viewing.

Load Opens the DICOM data in a 3D View window.

Load data in 
new window

If this option is selected, DICOM data are opened in a new 3D View 
window when you click Load. 

If this option is not selected, DICOM data are loaded in the active 3D 
View window.

Move the slider to select a particular slice for viewing or click an image.
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14.9 3D Tools Overview

The Tool Palette includes the 3D Tools after you reconstruct or load a surface or 3D 
sources. The tools are organized by tabs:

14.10 3D Tools - Surface

Use these tools to adjust the appearance of the reconstructed animal surface and photon 
density maps.

3D Tools Functions Page
Surface Tools Adjust the appearance of the reconstructed animal 

surface and photon density maps
See below

Source Tools Adjust the appearance of reconstructed sources, make 
source measurements, export voxel measurements

222

Registration Tools Display organs on the reconstructed surface, adjust the 
location or scale of organs on the surface, import an 
organ atlas

225

Animate Tools Display preset animations of the 3D View scene. Enables 
you to create custom animations and record an animation 
to a movie file.

231

Figure 14.29  Surface tools and example DLIT reconstruction with photon density 
maps
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Table 14.10  Surface tools

Item Description
Display Subject 
Surface

Choose this option to display the surface in the 3D View window.

Drawing styles for the surface.

Shading styles for the surface.

Click to open the color palette from which you can select a display color for 
the surface and the cross section views. 

Opacity Adjusts the surface opacity.

Display Photon 
Density Map

Choose this option to display the photon density on the surface.

Apply Choose measured or simulated photon density maps for display.

Wavelengths 
(DLIT)

Images (FLIT)

Choose the data to display in the photon density map.

Intensity Set the maximum intensity of the photon density map using the slider or by 
entering a value.

Color Table Color scheme for the photon density map.

 Point cloud  Wire frame  Surface face Wire frame & 
surface face 

 Surface face  Smooth surface 
xxxxface 

 Reflect surface 
xxxxface 

Reflect smoot
surface face
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14.11 3D Tools - Source

Use the source tools to:

�• Adjust the appearance of sources in DLIT or FLIT reconstructions

�• Make source measurements (page 209)

�• Export voxel measurements (.csv) 

 

Reverse Choose this option to apply the colors of the selected color table in reverse 
order. For example, the Red color table represents the source intensity 
(photons/sec) from low to high using a color scale from transparent to red. 
If Reverse is chosen, the source intensity (photons/sec) from low to high is 
represented using the color scale from red to transparent.

Log Scale Choose this option to apply a logarithmic scale to the photon density scale.

Table 14.10  Surface tools (continued)  

Item Description

Figure 14.30  Source tools and example DLIT reconstruction

Table 14.11  Source tools

Item Description
Select Source A drop-down list of available sources. 

Original – Results saved with the data.

<sequence name...SourceVoxels> – Pasted voxels. (Click the  button to 
remove pasted voxels from the surface.)

Display Source 
Surface

Choose this option to display the source surfaces reconstructed using 
DLIT or FLIT. A surface will be wrapped around the currently displayed 
voxels. Adjust the voxel display by moving the Threshold slider. 
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Drawing styles for the source surface (see “Display Source Surface”).

Shading styles for the source surface (see “Display Source Surface”).

Click to open the color palette from which you can select a display color 
for the source surface. 

Opacity Adjusts the source surface opacity.

Display Voxels Choose this option to display the sources reconstructed using DLIT.

Maximum 
Intensity 
Projection

Choose this option to project all maximum intensity voxels in the view 
along the viewing direction into the viewing plane.

Threshold 

(DLIT/FLIT only)

Choose this option to apply a minimum threshold intensity to the voxel 
display.

Gradation 

(DLIT/FLIT only)

Use this slider to set a threshold for the percentage voxel intensity above 
which voxels are opaque and below which voxels will gradually face to 
transparent. The percentage voxel intensity is the percentage relative to 
the maximum intensity.

Voxel size The 3D grid-spacing size for interpolation of the reconstructed source.

Smoothing The smoothing box filter size.

Display voxels as The voxel display mode (cubes, spheres, points, or texture).

Table 14.11  Source tools (continued)  

Item Description
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Color Scale 

Min: Use the slider or up/down arrows to set the minimum value of the 
source color scale. Voxels with intensities less than the color scale 
minimum are not displayed in the reconstruction.

Color Table – Color scheme for voxel display. Use the left and right 
sliders to set the minimum and maximum colors.

Reverse – Choose this option to apply the colors of the selected color 
table in reverse order to the photon density scale. For example, the Red 
color table represents the source intensity (photons/sec) from low to high 
using a color scale from transparent to red. If Reverse is chosen, the 
source intensity (photons/sec) from low to high is represented using the 
color scale from red to transparent.

Log scale – Choose this option to apply a logarithmic scale to the color 
table.

Measured 
Sources

Quantification (DLIT) – For uncalibrated sources, the total flux measured 
for the sources selected using the Measure Source tool . For calibrated 
sources, this unit will be in [cell] units. For details on using this tool, see 
page 209.

Quantification (FLIT) – For uncalibrated sources, the fluorescence yield 
measured for the voxels selected using the Measure Source tool . 
Fluorescence yield is expressed in units of [pmol M-1cm-1] here for 
uncalibrated sources. For calibrated sources, this unit will be in either 
[cells] or [pmol]. For details using this tool, see page 209.

Volume – Volume of the selected source (mm3).

Center of Mass (DLIT or FLIT) – The weighted average x, y, and z-
coordinates of the selected voxels, where the weights are the flux of each 
highlighted voxel.

Host Organ – The location of the selected source can be referenced to an 
organ atlas, and the organ from the atlas that is closest to the source will 
be reported here. This information is available if you select and register 
an organ atlas with the reconstruction. For more details, see page 230.

Export Voxels Enables you to export the voxel measurements in their x-, y-, and z-
coordinates and source intensities (.csv file).

Click to compute the center of mass for the source selected with the 
Measure Source tool . For details using this tool, see page 209.

Table 14.11  Source tools (continued)  

Item Description
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14.12  3D Tools - Registration

Use the registration tools to:

�• Display organs in the surface (page 226)

�• Manually adjust the location or scale of organs in the surface (page 227)

�• Check the organ fit  (page 228)

�• Import an organ atlas  (page 230)

You can check the organ fit in the 3D View window  (page 228)

Figure 14.31  3D registration tools and surface with fitted organs (“skin” not 
displayed)

Table 14.12  Registration tools

Item Description
Use this tool to manually adjust the scale of location of organs. For more 
details, see page 227.

Fits the organs to the surface using a linear transformation that keeps the 
shape of the atlas surface.

Fits the organs to the surface using linear transformation and volume 
deformation. 

After fitting organs to the surface using the  or  tool, if necessary, 
you can click this button to restore the default fit.

Display Organs Choose this option to display the organs on the surface. Organs that are 
check marked will be displayed. For more details, see page 226.
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Displaying Organs With the Reconstruction

1. Load reconstruction results and confirm that the surface is in the perspective view 
(click the  toolbar button in the 3D View window or press the R key).

2. In the 3D registration tools, choose the Display Organs option and select an organ 
atlas.

The organs in the selected atlas appear on the surface.

3. To fit the organs to the surface, click a registration tool:

NOTE
For an optimum fit when there is a large difference between the orientation or size of the atlas 
organs and surface, first use the transformation tool to manually register the surface and 
atlas organs, then click a registration tool to automatically fit the organs. (For more details on 
manual registration, see below.)

4. If necessary, adjust the opacity of the organs using the slider or enter a number in the 
box.

The organs are easier to view if you uncheck Skin in the Organs list.

Drawing styles for the organs (see “Display Organs”).

Shading styles for the organs (see “Display Organs”).

Opacity Adjusts the opacity of the organ display.

Organ Atlas Choose a type of organ atlas.

Click to select all organs in the database and display them on the surface.

Click to clear the selected organs and remove all organ diagrams from 
the surface.

Table 14.12  Registration tools (continued)  

Item Description

Rigid registration - Performs linear transformation, but keeps the shape of 
the atlas surface.

Full registration - Performs linear transformation and volume deformation.
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5. To clear all organs from the surface, click the Deselect All button . To hide a 
particular organ, remove the check mark next to the organ name.

6. To display a specific organ(s), choose the organ name. To display all organs on the 
surface, click the Select All button .

NOTE
After fitting organs to the surface using the  or  tool, if necessary, you can click Reset 
button  to restore the default fit.

To manually adjust the scale or location of organs:
1. Load reconstruction results and confirm that the surface is in the perspective view 

(click the  toolbar button in the 3D View window or press the R key).

2. In the 3D registration tools, choose the Display Organs option and select an organ 
atlas.

The organs in the selected atlas appear on the surface. In Figure 14.32, only Skin is 
selected.

3. Click the Transform tool button .

The transform tool appears.

4. To adjust the x,y, or z-position of the organ, drag the transform tool.

5. Press the Tab key to put the transform tool in scale mode.

A red cube  appears at each corner of the transform tool.

Figure 14.32  Displaying the transform tool

Transform tool
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6. To increase or decrease (scale) the size of the organ, drag a red cube at a corner of the 
transform tool. To restrict scaling to a particular axis, press the X, Y, or Z key, then 
drag a red cube.

7. Press the Tab key again to put the transform tool in rotate mode.

A red, green, and blue circle appear around the surface.

8. To rotate the organ on the x,y, or z-axis, click the blue, green, or red circle and drag 
the mouse arrow in the direction of interest.

To return the digital organ to the default position and size, click the Reset button , 
then  button.

9. To turn off the transform tool, click the Transform tool button .

To check the organ fit:
1. Check the fit in the coronal, sagittal, and transaxial windowpanes.

2. Click the Change view toolbar button .

The Top view is displayed.

Figure 14.33  Rotating the organ on the surface

The selected circle line is thicker
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3. Press the V key or the  button to display alternative views of the surface.

Figure 14.34  Skin (pink) fitted to surface (gray)

Figure 14.35  Alternate views of the surface

Top Bottom Front 

Right Left Back 
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Importing an Organ Atlas

An organ atlas (.iv, .dxf, or .stl, one organ per file) consisting of segmented organ surfaces 
derived from an MRI or CT scan can be imported into the Living Image software for 
registration with the animal surfaces derived from IVIS data. Organ files must be 
segmented from MRI or CT 3D volumetric data in third party medical imaging analysis 
software.

NOTE
The imported atlas must include a surface (skin) file which delineates the animal surface. The 
file name must include the word “skin”, for example rat skin.iv.

1. Load a DLIT or FLIT image sequence that is associated with the mouse comprising the 
organ files in *.iv, *.dxf or *.stl format.

2. Select File → Import → Organ Atlas on the menu bar.

3. In the dialog box that appears, click Add Organ Files (Figure 14.36).

Figure 14.36  Import Organ Atlas dialog box
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4. In the next dialog box that appears, select all of the files (.iv, .dxf, .stl) that you want 
to include in the atlas (one file per organ) and click Open. 

5. In the Select Skin Mesh drop-down list, select the skin organ file, which must include 
�‘skin�’ in the file name.

6. Click Generate Mesh Coefficients.

7. Enter a name for the atlas and click Save Organ Atlas.

The organ atlas (.atlas) is created and is added to the Organ Atlas drop-down list (in 
the 3D tools, Registration tab).

14.13 3D Animation

The Living Image software can create an animation from a sequence of 3D views (key 
frames). For example, an animation can depict a rotating 3D scene (Figure 14.37). The 
animation (series of key frames) can be recorded to a movie file (.mov, .mp4, or .avi). Use 
the animation tools to:

�• View a preset animation (generated from a factory-loaded animation setup)  
(page 233)

�• Create a custom animation (created from your custom animation setup) (page 234)

�• Save an animation setup  (page 235)

�• Record an animation to a movie file  (page 235)

�• Edit an animation setup (page 236)

Figure 14.37  Individual 3D views (key frames) in the preset animation “Spin CW on Y-Axis”

Keyframe 1 Keyframe 2 Keyframe 3 Keyframe 4 Keyframe 5

The  box shows the key frames in the current animation setup. Click a key 
frame in this box to display the associated 3D view and time stamp (position in 
the time scale (0-100) at which the frame occurs in the animation).

Click  to view the animation composed of the key frames.
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Table 14.13  3D animation tools

Item Description
Time Scale% The time stamp of a key frame in the animation on a time scale of 0-100. 

For example, if the animation is 10 sec long and includes five key frames:

Key frame 1: Time stamp= 0; first frame of the animation.

Key frame 2: Time stamp = 25%; frame occurs 2.5 seconds after the start 
of animation.

Key frame 3: Time stamp = 50%; frame occurs 5.0 seconds after the start 
of animation.

Key frame 4: Time stamp = 75%; frame occurs 7.5 seconds after the start 
of animation.

Key frame 5: Time stamp = 100%; last frame of the animation.

Presets A drop-down list of predefined animation setups.

Key frame A 3D view. The software interpolates the key frames to create 
intermediate frames in real time, then generates an animated sequence 
from all of the frames. Each successive key frame in a sequence should 
differ slightly from the preceding one, so that motion is smoothly 
depicted when the frames are shown at a proper frame rate (frames/
second). The Living Image software provides preset key frames or you 
can specify the 3D views for the key frames.

Preset Key Frame 
Factor

Determines how many key frames are used to generate one revolution 
in a spinning animation (No. of frames = (4 x Key Frame Factor) + 1). 
Increasing the key frame factor reduces the time period between key 
frames and creates the appearance of finer movement. Decreasing the 
key frame factor increases the time period between key frames and 
creates the appearance of coarser movement.

FPS Frames displayed per second in the animation sequence.

Creates a new key frame from the current 3D view. 

Updates the selected key frame to the current 3D view.

Deletes a selected or all key frames from the key frame box.

Moves a selected key frame up in the key frame box.

Moves the selected key frame down in the key frame box.

Total Duration The total time of the animation sequence.

Play Click to view the animation sequence defined by the current key frames 
and animation parameters.

Record Displays a dialog box that enables you to save the current animation to 
a movie (.mov, .mp4, or .avi, .mpg).

Animation Setup

Load Displays a dialog box that enables you to open an animation setup 
(.xml).

Save Displays a dialog box that enables you to save the current key frames 
and animation parameters to an animation setup (.xkf).
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Viewing a Preset Animation

Preset animations are factory-loaded animation setups. They include predefined key 
frames which are used to generate the animation.

To view a preset animation:
1. Open an image sequence and load 3D reconstruction results.

2. Select properties to display in the 3D View window (for example, organs, sources, 
surface, or photon density maps).

3. Select View → 3D Animation on the menu bar.

4. In the 3D Animation tools that appear:

a. Clear the key frame box if necessary (click the  button and select Delete All).

b. Make a selection from the Presets drop-down list. See Table 14.13, page 232 for a 
description of the preset animations.

After a preset animation is selected, a list of the key frames appears.

NOTE
You can view multiple animations sequentially. For example, if you select Spin CW on X-Axis 
and Spin CW on Y-axis from the Presets drop-down list, the animation shows the 3D 
reconstruction spinning clockwise on the x-axis, then spinning clockwise on the y-axis.

5. To view the animation, click Play. 

Figure 14.38  3D Animation tools
For more details on the animation tools, see Table 14.13, page 232.

Select a preset 
animation

Key frames box 
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Creating a Custom Animation

To create an animation, specify a custom animation setup or edit an existing setup.

1. Open an image sequence and load 3D reconstruction results.

2. Select properties to display in the 3D View window (for example, organs, sources, 
surface, or photon density maps).

3. Select View → 3D Animation on the menu bar.

The 3D Animation tools that appear:

4. Clear the key frame box if necessary (click the  button and select Delete All).

5.

6. To capture the first key frame, click the  button.

The first key frame is added to the key frame box.

7. Adjust the position of the reconstruction in the 3D View using an image tool (for 
example, , or ). For more details on the image tools, see page 197.

8. Click the  button.

The second key frame is added to the key frame box.

Figure 14.39  3D Animation tools
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9. Repeat step 7 to step 8 until all of the key frames are captured. For details on how to 
edit the key frame sequence, see page 236.

Click a key frame to display the associated 3D view and the time stamp (position in 
the time scale (0-100) at which the frame occurs in the animated sequence).

10. Confirm the defaults for FPS (frames per second) and Total Duration (length of 
animation) or enter new values.

FPS x Total Duration = No. of frames generated to create the animation. The number 
of generated frames should be ≥ to the number of key frames. Otherwise, the frames 
may not be properly animated.

11. To view the animation, click Play. To stop the animation, click Stop.

An animation setup (series of key frames) can be saved (.xkf) or recorded to a movie 
(.mov, mp4, .avi, mpg). 

To save an animation setup:
1. Click Save.

2. In the dialog box that appears, select a directory and enter a file name (.xkf)

To record the animation to a movie:
1. Click Record.

2. In the dialog box that appears, choose a directory, enter a file name (.mov, mp4, .avi), 
and click Save.

Figure 14.40  Example key frames for a custom animation

Key Frame 1 Key Frame 2

Key Frame 3 Key Frame 4
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To edit an animation setup:
1. Open an image sequence and load a reconstruction.

2. Open an animation setup. To select a predefined setup, make a selection from the 
Preset drop-down list. 

To select a saved user-defined setup:

a. Click Load. 

b. In the dialog box that appears, select an animation setup (.xkf).

3. To add a key frame:

a. Adjust the position of the reconstruction in the 3D view using an image tool (for 
example, , or ). For more details on the image tools, see page 197.

b. Click the  button.

4. To reorder a key frame in the sequence, select the key frame and click the  or  
arrow.

5. To update a key frame:

a. Select the key frame and adjust the 3D view.

b. Click the  button.

6. To delete a key frame:

a. Select the key frame that you want to remove.

b. Click the  button and select Delete Current.

Figure 14.41  List of key frames in the selected animation
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14.14  DLIT/FLIT Troubleshooting

Issue Solution
No sources in solution �• In DLIT or FLIT, this can occur if the surface is not correct. That is, if 

a surface is imported into the 3D View from another source other than 
from the Structured Light Analysis.

Surfaces are spiky �• The most common source of spiky surfaces are folds in the animal 
skin or fur, which corrupt the desired smooth lines projected on the 
animal from the laser galvanometer.

�– Choose the 'Fur Mouse' option for 'Subject' 

�– Smoothing the surface by using the 'Smooth' feature in the Surface 
Topography tools can help improve the surface

Bad Photon Density fit �• The optical properties or source spectrum may have been chosen 
erroneously. For example, for mice, 'Mouse Tissue' optical property 
is appropriate while 'XPM-2' is only appropriate for the Caliper 
phantom. 
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The Living Image® 3D Multi-Modality tools enable you to co-register 3D reconstructions 
of luminescent or fluorescent sources (optical imaging data) with CT or MRI images (3D 
volumetric data). Registering multi-modal data (optical and volumetric data) provides an 
anatomical context for interpreting biological (functional) information. Figure 15.1 shows 
the steps to register multi-modal data in the Living Image software.

15.1 3D Multi-Modality Tools Requirements

The Living Image 3D Multi-Modality tools require a separate license. Additionally, the 
graphics processing unit (GPU) must meet the minimum specifications shown in Table 15.1. 
If the appropriate license is not installed or the GPU does not meet these specifications, the 
3D Multi-Modality tools will not appear in the Tool Palette.

NOTE
If you do not have the 3D Multi-Modality tools, you can still view DICOM data (see page 258); 
however, the 3D Multi-Modality tools are required to register optical and volumetric data.

*If these specifications are not met, the 3D Multi-Modality tools do not appear in the Tool Palette.

Table 15.1   Minimum graphics card specifications 

Specification Description
OpenGL Version Requirement* OpenGL 2.0 and above

OpenGL Extension Requirement* GL-EXT-texture3D

Graphics Card Memory Minimum: 256MB Dedicated + Shared)
Recommended: 1GB (Dedicated)

Consumer Graphics Cards (Desktop/
Mobile, Windows/Mac)

Supported: 
�– NVIDIA® GeForce® 8 Series and above (8, 9, 100, 200, 300 and 400 

series)
�– ATI Radeon�™ HD 4000 Series and above (4000 and 5000 series)

Recommended:
�– Desktop - NVIDIA GeForce GT 240 and above
�– Mobile - NVIDIA GeForce GT 230M and above

Workstation Graphics Cards (Desktop/
Mobile, Windows/Mac)

Supported:
�– NVIDIA® Quadro® NVS Series and Above (NVS & FX series)
�– ATI FireGL�™ V5600 and Above (FireGL, FirePro & CrossFire series)

Recommended:
�– Desktop - Quadro FX 1800 and above
�– Mobile - Quadro FX 880M and above
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Figure 15.1  Steps to register multi-modal data

! Load the optical data:

�• Bioluminescence or 
fluorescence image sequence 
and structured light surface

�• 3D source reconstruction (DLIT 
or FLIT results) (page 206)

" Load 3D volumetric data (CT or 
MRI) (page 241).

$ Register the 3D source 
reconstruction and the 3D 
volumetric data by performing 
either:

�• Automatic fiducial 
registration�–Available for data 
acquired on the Quantum FX 

CT instrument using the 
Mouse Imaging Shuttle 
(page 245)
or

�• Manual registration�–Match 
animal surface representations 
using the Manual Registration 
tool (page 247)

# Classify the 3D volumetric data to 
help identify and separate objects 
(page 250). Save the color-opacity 
map (optional).

% Save the registered 3D multi-
modality results (page 257).
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15.2  Loading Data for Registration

1. Load a DLIT or FLIT image sequence and the 3D reconstruction results.

NOTE
The 3D Multi-Modality tools appear in the Tool Palette after you load optical image data. If 
the 3D Multi-Modality tools do not appear in the Tool Palette, confirm that the 3D Multi-
Modality Tools license is installed and that the workstation graphics card meets the 
specifications in Table 15.1, page 239.

2. To browse for DICOM or TIFF volumetric data, select File → Browse 3D Volumetric 
Data on the menu bar.

3. In the Browse For Folder box that appears, select a data folder and click OK.

The Living Image 3D Volumetric Browser appears (Figure 15.2). 

NOTE
Only DICOM or TIFF data can be added to the 3D Volumetric browser. For details on loading 
other data types (.raw or .vox files) see page 243.

NOTE
The next time you start the Living Image software and open the Browse For Folder box, the 
software automatically returns to the last folder visited.

The 3D Volumetric Browser automatically previews a playback of the data along with 
other information about the data (Figure 15.3). 

 - DICOM file

 - TIFF file

4. To load volumetric data with the optical data:

a. Confirm that the �“Load in a new window�” option is not selected. (If this option is 
selected, the volumetric data are loaded in a new window.)

b. Double-click the data row in browser. Alternatively, select the data row and click 
Load.

Figure 15.2  Opening the 3D Volumetric Browser

3D Volumetric Browser



242  Living Image Software User’s Manual

The 3D volumetric data appears in the 3D View window of the optical data (Figure 
15.4). The software converts loaded volumetric data into an 8-bit representation to 
reduce memory overhead and for easier color mapping. The 3D Multi-Modality tools 
provide an 8-bit color-opacity map for volume visualization which maps each voxel to 
an RGB color, or a color and opacity value. 

A histogram of voxel intensities appears in the Multi-Modality tools and the software 
sets a default air/noise boundary.

Figure 15.3  3D Volumetric Data Browser 

Click a column header to sort the browser 
contents in ascending alpha numeric order. 
Click the column header again to sort in 
descending alpha numeric order.

To view a particular slice, stop playback, then 
move the slider or enter a slice number.

Click a row to preview data playback.
Double-click a row to load the data.

Starts data playback

Stops data playback

To select a range of slices for playback, 
move the left and right sliders or enter 
the first and last slice numbers.

Table 15.2  3D Volumetric Data Browser

Item Description
Add to List If this option is chosen, the data selected in the Browse for Folder box is 

added to the 3D Volumetric Data Browser. If this option is not chosen, the 
data selected in the Browse for Folder box replaces the contents of the 3D 
Volumetric Data Browser, except for loaded data.

Browse Opens the Browse For Folder box.

Load in a new window If this option is chosen, multiple data sets can be loaded, each in a 
separate window. If this option is not chosen, only one data set can loaded 
at a time.

Load Click to open the data selected in the 3D Volumetric Data Browser.
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Loading RAW Volumetric Data 

1. Drag a single RAW file (*.raw or *.vox) from Windows Explorer to the 3D Multi-
Modality tools (Figure 15.5).

NOTE
Only single *.raw or *.vox files consisting of multiple slices of a 3D volume can be loaded into 
Living Image. 

Figure 15.4  3D optical and 3D volumetric data loaded, but not registered

Histogram of voxel intensities

Color-opacity map

Surface

Figure 15.5  Opening RAW volumetric data
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2. In the Volume Information dialog box that appears (Figure 15.6), enter the:

�• Data width, height, and the number of slices.

�• Slice row, column pixel size, and the slice spacing in millimeters.

3. If loading the data will cause low memory, you are prompted to down-sample the data 
(Figure 15.7). Decrease the slice resolution by moving the Slice Resolution slider to 
the left until the Memory Requirement Status is �“Good�”.

Changing the Orientation of RAW Volumetric Data

Occasionally, RAW files (*.raw or *.vox) may be loaded with the orientation �“flipped�” 
or reversed along the x, y, or z-axis. As a result, the slice views (transaxial, coronal, 
sagittal) may be flipped or rotated so that the actual view that is displayed does not match 
the 3D View windowpane name (for example, the Sagittal windowpane does not display 
a sagittal slice), or the data appears flipped with respect to the surface derived from the 
IVIS® Spectrum.

In such cases, you can:

�• Invert the data along the x, y, or z-axis

�• Manually rotate the data using the Transformation tool (for more details, see 
page 249).

Figure 15.6  Volume information

Figure 15.7  Down-sample 3D volumetric data to improve memory and performance

Select a data type.

Enter the:

�• Width, height, and number of slices

�• Slice row, column pixel spacing, and 
the slice spacing in millimeters
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To invert the subject orientation:
1. Click the Edit Spacing & Orientation button .

2. In the dialog box that appears, choose a �“Subject Orientation�” option and click OK.

15.3 Registering Multi-Modal Data

Two multi-modal registration methods are available:

�• Automatic fiducial registration �– For experiments in which the Mouse Imaging 
Shuttle was used to transfer the animal between the IVIS® Spectrum and the 
Quantum FX µCT instrument. The Living Image® software automatically registers 
the optical surface reconstruction with 3D volumetric data acquired on the Quantum 
FX µCT instrument. 

�• Manual registration�—Use the 3D Multi-Modality tools to register 3D volumetric 
data with a 3D surface reconstruction.

Automatic Fiducial Registration

Automatic fiducial registration is available for CT data acquired on the Quantum FX µCT 
instrument. The subject must be contained in the Mouse Imaging Shuttle during both 
optical and CT imaging, and the CT data must be exported to DICOM format. 

After registration, classify the 3D volumetric data to help you identify and separate 
objects (see page 250).

About the Mouse Imaging Shuttle

The Mouse Imaging Shuttle (Caliper part no. 127744) contains the subject during imaging 
and enables the subject to be transferred between an IVIS® Imaging System and the 
Quantum FX µCT instrument without disrupting the subject�’s position. 

The Mouse Imaging Shuttle must be correctly docked to the docking station in the IVIS 
Imaging System and the Quantum FX µCT instrument. The docking station in the 
Quantum FX µCT system is marked with a triangle-shaped fiducial pattern under the 
plane where the Mouse Imaging Shuttle docks. Automatic fiducial registration is 
available if both sides of the triangle fiducial pattern are included in the CT images. For 
more details on using the Mouse Imaging Shuttle, see the Mouse Imaging Shuttle 
Instructions (Caliper part no. 127820_RevA). 

Figure 15.8  Volume Information dialog box
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To perform automatic fiducial registration:
1. Load the data that you want to register (see page 241).

2. Click the Fiducial Registration button .

The multi-modal data are automatically registered and cropped (Figure 15.9). 

3. To undo the registration, click the Reset Registration button .

To save the registration information:
1. In the Results tab, confirm the default name or enter a name for the results.

2. Click Save.

Figure 15.9  Registered 3D optical and 3D volumetric data

Figure 15.10  3D Multi-Modality Tools, Results 
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NOTE
Registration information is saved with the results for the volumetric data and is specific for a 
particular optical data set.

Manual Registration

To manually register data, use the 3D Multi-Modality tools to translate, scale, or rotate 
the 3D volumetric surface so that features common to both surfaces are matched and 
aligned in the x, y, and z planes. Examine the matched surfaces in the 3D slice views to 
help you fine tune the registration. 

To manually register data:
1. Load the data that you want to register (for more details, see page 241).

The software determines a default air/noise boundary for the 3D volumetric data 
(Figure 15.12).

2. If you need to remove noise from the 3D volumetric data, move the air/noise boundary 
to the right in the histogram tool.

Figure 15.11  Example surfaces before and after registration

Surfaces before regis trati on Regi stered surfaces

3D  volumetric surface 3D  s tructured light sur face
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3. If the volumetric data needs cropping (for example, to remove structures such as the 
stage from the CT view), follow step a to step c below. If cropping is not needed, 
proceed to step 4.

To crop the data:

a. Click the crop tool button .

The crop tool appears and has six control points:

�—Crops the data along the x-axis

�—Crops data along the y-axis

�—Crops data along the z-axis
 

Figure 15.12  Adjusting the air/noise boundary in the histogram tool

Default air/noise 
boundary

Example noise in 
the 3D volumetric 
data

Adjust the air/
noise boundary to 
reduce noise in 
the 3D volumetric 
data

Reduced noise 

Figure 15.13  Crop data along the x, y, or z-axis

No crop tool X-axis crop tool Y-axis crop tool Z-axis crop tool 
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b. Click and hold a control point while you move the crop plane. As you move the 
crop plane, the slice views are updated. Release the mouse button to crop the data. 

c. To reset the crop planes, click the  button. When finished cropping, press the 
Tab key to turn off the crop tool.

4. Click the Manual Registration button .

The transformation tool appears (Figure 15.14). The tool has three modes that enable 
you to translate, scale, or rotate the 3D volumetric data (press the Tab key to change 
the tool mode). The slice views are automatically updated when you use the tool.

NOTE
Make sure that you click the transformation tool so that it is highlighted before you use it. 
Otherwise the dragging operation is applied to the optical data (structured light surface).

5. To return the 3D volumetric data to the default position and size, click the Reset 
Registration button .

6. For details on saving the registration information, see page 246.

NOTE
Registration information is saved with the results for the volumetric data and is specific for a 
particular optical data set.

Figure 15.14  Manual registration tool: transformation modes

Translate�—Moves the volume in the 
x, y, or z-axis. Drag the tool to adjust the 
position of the volume.

Scale�—Increases or decreases (scale 
the size of the volume, drag a red cube at 
a corner of the volume. To restrict scaling 
to a particular axis, press the X, Y, or Z 
key, then drag a red cube.

Rotate�—To rotate the volume on the x, 
y, or z-axis, click the blue, green, or red 
circle and drag the mouse arrow in the 
direction of interest.
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15.4  Classifying 3D Volumetric Data

The 3D Multi-Modality tools provide a histogram-based method to classify the 3D 
volumetric data. The histogram represents the distribution of voxel intensities in the 3D 
volumetric data and their color-opacity values. The goal of classification is to set color 
and opacity values for different intensity ranges so that the color-opacity map shows the 
volume regions you are interested in (opaque in the map) and hides unimportant regions 
(transparent in the map). 

For example, Figure 15.15 shows how the histogram tool designed a color-opacity map that 
shows both the skin and bone. The histogram tool enables you to easily re-design the 
color-opacity map to show just the skin or just the bone. 

The 3D Multi-Modality tools also enable you to classify the volumetric data by specifying 
color and opacity values for different intensity ranges so that you can easily view or hide 
certain parts of the data as needed. A color-opacity map can be saved.

Figure 15.15  Histogram tool specifies the opacity for different voxel intensities

Color-opacity map
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Specifying a Color-Opacity Map

1. After the surface and volume data are loaded, confirm that the Display Volume option 
is selected.

2. To change the color table for the color-opacity map, make a selection from the Color 
table-Opacity Map drop-down list. To apply the reverse color table, select the Reverse 
option.

3. If the histogram intensity range appears narrow or suppressed, choose the Logarithmic 
Histogram option.

Choosing this option enhances the histogram display by magnifying the smaller 
regions of interest in the histogram while keeping noise and air-related intensity peaks 
high. It helps bring out hidden regions visible in the histogram for easier identification 
of interesting intensity ranges.

Figure 15.16  3D Multi-Modality tools

Autofit air/noise boundary. 
Voxels below this threshold 
are not displayed. The color 
table is mapped to voxels 
above threshold. 

O
pa

ci
ty
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Managing Control Points
1. Place a control point on the histogram by clicking anywhere on the histogram between 

the  point (represents the lowest intensity in the volume) and  point (represents 
the highest intensity in the volume). 

During volume rendering, the color-opacity maps are used to map color and opacity to 
the corresponding intensity value as well as interpolate color and opacity for all data 
between adjacent control points.

2. Drag any control point up or down to set the opacity level that is associated with the 
intensity value represented by the point. Drag a user-added control point left or right 
to change the intensity associated with the opacity specified by the point.

When you add, delete, or modify a control point, the color-opacity map and the 
rendering of the volume data are updated in real-time.

NOTE
The minimum and maximum intensity levels associated with the  and  control points 
cannot be changed.The opacity level associated with these points can be changed.

Figure 15.17  Example intensity histograms

Logarithmic intensity scaleLinear intensity scale
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3. To select a color for particular data, double-click a control point. In the color palette 
that appears, choose a color and click OK. The software interpolates the color range 
between adjacent control points.

4. To delete a control point, right-click the point. To delete all control points, click the 
 button.

NOTE
The  and  control points cannot be deleted from the histogram.

Saving a Color-Opacity Map

A color-opacity map can be saved and applied to any volumetric data set.

1. Click the Save button  (Figure 15.19).

2. In the dialog box that appears, select a folder for the file (.tfn) and enter a file name.

3. Click Save.

Loading a Color-Opacity Map
1. Click the Open button  (Figure 15.19).

2. In the dialog box that appears, navigate to the map file (.tfn), and click Open.

Figure 15.18  Histogram tool

Each control point 
specifies a particular 
opacity/intensity/color.

Double-click a control point 
to open the color palette.
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15.5 Volume Display Options

Adjusting the Image Quality

By default, the color-opacity map displays the volumetric data at original (1x) resolution. 
This means, for example, if the volume comprises 512 slices, then all of the 512 slices are 
displayed. You can increase or decrease the resolution of the data display from 0.5x to 
3.0x resolution (for examples, see Table 15.3). 

If you increase the resolution, the software interpolates the data and adds slices to the 
volume. If the processing performance is impacted at the original resolution, you may 
want to reduce the resolution to improve performance. Reducing the resolution down-
samples the data and fewer slices are displayed.

To adjust the image resolution:
1. Move the Level of Detail Slider to the left or right.

The color-opacity map is updated.

2. To return the resolution to 1x, click the Reset button .

Figure 15.19  Save or load a color-opacity map

Click a button to 
save or load a 
color-opacity map
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Maximum Intensity Projection (MIP)

MIP projects all maximum intensity voxels in the view along the viewing direction into 
the viewing plane. 

Gradient Illumination

Gradient Illumination is based on the idea that light is reflected at boundaries between 
different voxel intensities, but is not affected when passing through homogeneous 
regions. Choosing this option illuminates the voxels at boundaries more than voxels 
within a homogeneous region. The boundaries are based on the gradient magnitude 
between heterogeneous regions or the change in intensities between neighboring voxels 
in heterogeneous regions. Choosing this option enhances the variation in tissue properties 
and may be helpful for visualizing the boundaries of different tissues.

Editing Volume Slices

You can modify the pixel and slice spacing of the volume. Changing the pixel or slice 
spacing modifies the volume resolution.

1. In the Volume tab, click the Edit Space and Orientation button .

2. In the dialog box that appears (Figure 15.21), edit the pixel or slice spacing.

Figure 15.20  Level of Detail slider

Table 15.3  Example volume with 512 slices at 1x resolution

Volume Resolution No. of Slices Displayed
0.5x 256

1x (original resolution) 512

1.5x 768

2x 1024

2.5x 1280

3x 1536

Resolution 1x0.5x 3x2x

Figure 15.21  Volume Information dialog box
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15.6 Viewing a Slice

Slice Tab

In the 3D Multi-Modality tools, the Slice tab contains the color table options for the slice 
views.

1. To select a color table for the slice views, choose the Slice Color Table option, then 
make a selection from the Color Table drop-down list (Figure 15.22). To apply the 
reverse of the selected color table, choose the Reverse option.

NOTE
Black areas that appear around the optical sources in the overlay with the CT slices are due 
to the black color level at the low end of the color palette. To correct this, go to Sources tab 
in the 3D Tools, and move the colorbar low end slider up from the black level.

2. To apply the same color table as the color-opacity map, choose the Volume Color 
Table option. The volume color table is selected in the Volume tab. 

Figure 15.22  Perspective view and slice views displayed using different color tables
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15.7  Volume Information and Results

The Results tab displays information about the loaded data taken from the DICOM file 
header (Figure 15.23).

You can save the registered and classified data. This provides a convenient way to share 
data. The software saves the following:

�• Level of detail setting

�• Color tables for the opacity map and slices

�• Histogram tool control settings and the resulting color-opacity map

�• Multi-modal registration settings

�• Crop settings

Managing Results

To save registered results:
1. In the Results tab, confirm the default name in the Name drop-down list or enter a 

name.

2. Click Save.

The registered 3D volumetric data, along with the color-opacity settings, appear in the 
3D View window.

NOTE
The results are saved in XML format in the optical data set location. The results can only be 
accessed from the same optical data set.

Figure 15.23  Volume information
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To load results:
1. Select the results from the Name drop-down list.

2. Click Load.

To delete results:
1. Select the results from the Name drop-down list.

2. Click Delete.

3. Click Yes in the confirmation message that appears.

15.8 Volume Data Viewer

The Living Image software provides a viewer for volumetric data. The 3D Multi-Modality 
tools are not required to view DICOM or TIFF data.

1. Select View → Volume Data Viewer on the menu bar.

The Volume Data Viewer appears.

2. Select volume data by doing either of the following:

�• Drag the data file (DICOM, TIFF) from Windows Explorer to the Volume Data 
Viewer window

or

�• In the Volume Data Viewer, click the Open button , and in the dialog box that 
appears, select a DICOM or TIFF file, and click Open.

3. To clear the Volume Data Viewer, click the  button.

Figure 15.24  Drag volume data from Windows Explorer to the Volume Data Viewer

To view a particular slice, move the 
slider or enter a slice number.

Starts playback of 
the DICOM files

Click to display the 
DICOM file header 
information
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Appendix A   IVIS Acquisition Control Panel
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A.1 Control Panel

The control panel provides the image acquisition functions (Figure A.1).

NOTE
The options available in the IVIS acquisition control panel depend on the selected imaging 
mode, the imaging system, and the filter wheel or lens option that are installed. 

Figure A.1  IVIS acquisition control panel, auto exposure selected

Table A.1  IVIS acquisition control panel

Item Description
Luminescent Choose this option to acquire a luminescent image.

Fluorescent Choose this option to acquire a fluorescent image. 

If the Fluorescent option is selected on the IVIS Spectrum Imaging System, the 
following options also appear in the control panel:

Transillumination - Choose this option to acquire a fluorescent image using 
transillumination (excitation light located below the stage). 

Normalized - This option is selected by default when the Fluorescent and 
Transillumination options are chosen so that NTF Efficiency images can be 
produced.

To acquire an image using auto exposure, 
click the  arrow and select Auto.

Luminescence 
imaging settings

Fluorescence 
imaging settings

Photographic 
imaging settings

Structured light 
imaging settings

X-ray imaging 
settings



260  Living Image Software User’s Manual

Exposure time The length of time that the shutter is open during acquisition of an image. The 
luminescent or fluorescent signal level is directly proportional to the exposure 
time. The goal is to adjust the exposure time to produce a signal that is well 
above the noise (>600 counts recommended), but less than the CCD camera 
saturation of ~60,000 counts. 

Luminescent exposure time is measured in seconds or minutes. The minimum 
calibrated exposure time is 0.5 seconds. The exposure time for fluorescent 
images is limited to 60 seconds to prevent saturation of the CCD. There is no 
limit on the maximum exposure time for luminescent images; however, there is 
little benefit to exposure times greater than five minutes.The signal is linear with 
respect to exposure time over the range from 0.5 to 10 minutes. Integration 
times less than 0.5 seconds are not recommended due to the finite time 
required to open and close the lens shutter. 

Binning Controls the pixel size on the CCD camera. Increasing the binning increases the 
pixel size and the sensitivity, but reduces spatial resolution. Binning a 
luminescent image can significantly improve the signal-to-noise ratio. The loss 
of spatial resolution at high binning is often acceptable for in vivo images where 
light emission is diffuse. For more details on binning, see Appendix C, page 276.

Recommended binning: 1-4 for imaging of cells or tissue sections, 4-8 for in vivo 
imaging of subjects, and 8-16 for in vivo imaging of subjects with very dim 
sources.

F/stop Sets the size of the camera lens aperture.The aperture size controls the amount 
of light detected and the depth of field. A larger f/stop number corresponds to 
a smaller aperture size and results in lower sensitivity because less light is 
collected for the image. However, a smaller aperture usually results in better 
image sharpness and depth of field.

A photographic image is taken with a small aperture (f/8 or f/16) to produce the 
sharpest image and a luminescent image is taken with a large aperture (f/1) to 
maximize sensitivity. For more details on f/stop, see Appendix C, page 275.

Excitation Filter A drop-down list of fluorescence excitation filters. For fluorescent imaging, 
choose the appropriate filter for your application. For luminescent imaging, 
Block is selected by default. If you select Open, no filter is present. For systems 
equipped with spectral imaging capability, choose the appropriate emission 
filter for your application.

Note: On some models with standard filter sets, the excitation filter selection 
automatically sets the emission filter.

Emission Filter A drop-down list of fluorescence emission filters located in front of the CCD 
lens. The emission filter wheel is equipped with filters for fluorescence or 
spectral imaging applications. The number of filter positions (6 to 24) depends 
on the system. For luminescent imaging, the Open position (no filter) is 
automatically selected by default.

Photograph Choose this option to automatically acquire a photograph. The illumination lights 
at the top of the imaging chamber are on during a photographic image so that 
the system can acquire a black and white photograph of the sample(s). 

Note: You can adjust the appearance of the photographic image using the Bright 
and Contrast controls (see Adjusting Image Appearance, page 97).

X-ray Choose this option to acquire an X-ray image.

Table A.1  IVIS acquisition control panel (continued)  

Item Description
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Structure Choose this option to take a structured light image (an image of parallel laser 
lines scanned across the subject) when you click Acquire. The structured light 
image is used to reconstruct the surface topography of the subject which is an 
input to the Diffuse Luminescence Imaging Tomography (DLIT�™) algorithm that 
computes the 3D location and brightness of luminescent sources. 

When this option is chosen, the f/stop and exposure time are automatically set 
to defaults for the structured light image (f/8 and 0.2 sec, respectively). The 
spatial resolution of the computed surface depends on the line spacing of the 
structured light lines. The line spacing and binning are automatically set to the 
optimal values determined by the FOV (stage position) and are not user-
modifiable.

Overlay If this option is chosen, the system automatically displays the overlay after 
acquisition is completed (for example, luminescent image on photograph).

Lights Turns on the lights located at the top of the imaging chamber.

Fluor Lamp 
Level

Sets the illumination intensity level of the excitation lamp used in fluorescent 
imaging (Off, Low, High, and Inspect). The Low setting is approximately 18% of 
the High setting. Inspect turns on the illumination lamp so that you can manually 
inspect the excitation lamp. 

Note: Make sure that the filters of interest are selected in the filter drop-down 
lists before you select Inspect. The Inspect operation automatically positions 
the selected filters in the system before turning on the lamp. Subsequent 
changes to the filter popup menus will have no effect until another Inspect 
operation is performed.

Field of View Sets the size of the stage area to be imaged by adjusting the position of the 
stage and lens. The FOV is the width of the square area (cm) to be imaged. A 
smaller FOV gives a higher sensitivity measurement, so it is best to set the FOV 
no larger than necessary to accommodate the subject or area of interest. The 
FOV also affects the depth of field (range in which the subject is in focus). A 
smaller FOV results in a narrower depth of field. Select the FOV by choosing a 
setting from the drop-down list. For more details on the calibrated FOV positions 
A-E, see Table A.3, page 263. 

Service Moves the stage to a position for cleaning the imaging chamber below the 
stage. Only available on the IVIS Imaging System 200 Series and IVIS Spectrum.

Mouse Imaging 
Shuttle

Choose this option if the subject will be contained in the Mouse Imaging Shuttle 
during image acquisition. Note: The Mouse Imaging Shuttle or the Ventral 
Imaging Chamber can be used with the IVIS Kinetic, but not both at the same 
time.

Load Moves the stage from the cleaning position back to the home position.

XFOV-24 Note: This check box is only available on an IVIS® System that includes the XFO-
24 lens option. When the XFO-24 lens is installed, choose the XFOV-24 option. 
For more details on how to install the XFO-24 lens, see the XFOV-24 Lens 
Instructions.

IMPORTANT!
ALERT!  If you remove the XFO-24 lens from the system, be sure to remove the 
check mark from the XFOV-24 check box.

VIC Select this option when using the Ventral Imaging Chamber to acquire ventral 
kinetic images on the IVIS Kinetic Imaging System. Note: The Mouse Imaging 
Shuttle or the Ventral Imaging Chamber can be used with the IVIS Kinetic, but 
not both at the same time.

Table A.1  IVIS acquisition control panel (continued)  

Item Description
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Zoom Select this option to install and acquire images using the Zoom lens on the IVIS 
Lumina, IVIS Lumina XR, or IVIS Kinetic Imaging System. After the Zoom lens is 
installed, the stage automatically moves to the Z position, adjusted by the 
specified subject height. The Zoom lens is focused to this position.

Subject height 
(cm) 

Sets the position of the focal plane of the lens/CCD system by adjusting the 
stage position. The subject height is the distance above the stage that you are 
interested in imaging. For example, to image a mouse leg joint, set the subject 
height to a few mm. To image the uppermost dorsal side of a mouse, set the 
subject height to the 1.5 - 2.0 cm. The default subject height is 1.5 cm.

IMPORTANT!
ALERT!  The IVIS® System has a protection system to prevent instrument 
damage, however always pay close attention to subject height, particularly on 
the IVIS Imaging System 200 Series. For example, it is possible for a large 
subject (10 cm ventral-dorsal height) to contact the top of the imaging chamber 
if you set the subject height = 0 and choose a small FOV. 

Focus Drop-down list of focusing methods available:

Use subject height - Choose this option to set the focal plane at the specified 
subject height. 

Manual - Choose this option to open the Focus Image window so that you can 
manually adjust the stage position. For more details on manual focusing, see 
page 264.

Batch 
Sequences

Choose this option if you want to specify multiple, separate image sequences 
for batch acquisition (multiple image sequences are automatically acquired, one 
after another, without user intervention). For more details, see page 39.

Temperature The temperature box color indicates the temperature and status of the system:

White box �– System not initialized.
Red box �– System initialized, but the CCD temperature is out of range.
Green box System is initialized and the CCD temperature is at or within 
acceptable range of the demand temperature and locked. The system is ready for 
imaging.

Click the temperature box to display the actual and demand temperature of the 
CCD and stage. For more details, see page 18.

Acquire Click to acquire an image using the settings and options selected in the control 
panel or to acquire an image sequence specified in the Sequential Setup table.

Sequence Setup Click to display the sequence table so that you can specify and manage 
sequence acquisition parameters, or open sequence acquisition parameters 
(xsq). For more details on setting up an image sequence, see page 33.

Image Setup Click to close the sequence table.

Initialize Click to initialize the IVIS Imaging System. For more details on initializing the 
system, see page 17.

Table A.1  IVIS acquisition control panel (continued)  

Item Description
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w

a Position D is not available for X-ray imaging on the Lumina XR.
b Available with removable lens option XFOV-24. Not available on the IVIS Lumina XR.
c Some imaging systems may have the FOV in parentheses. FOV 19.5 and 26 were replaced by FOV 22.5.
d Position Z is available when the Zoom lens is installed on the IVIS Lumina, IVIS Lumina XR, or IVIS Kinetic 

Imaging System.

Table A.2  Additional controls for the IVIS Imaging System 200 Series or IVIS 
Spectrum

Item Description
Alignment grid Choose this option to activate a laser-generated alignment grid on the 

stage when the imaging chamber door is opened. The alignment grid is 
set to the size of the selected FOV. The grid automatically turns off after 
two minutes. If subject alignment is not completed in two minutes, place 
a check mark next to Enable Alignment Grid to turn on the grid. 

Note: The horizontal cross hair of the alignment grid is offset 
appropriately to take into account the height entered in the Subject height 
box.

Focus Scan Mid Image - Choose this option in the Focus drop-down list to set 
the focal plane at the maximum dorso-ventral height of the subject at the 
middle of the animal. This focusing method uses the laser to scan 
horizontally across the middle of the subject to determine the maximum 
subject height along this line. This option is well suited for animal imaging 
because the peak height is clearly identified as the maximum height on 
the dorsal side along the mid-plane of the animal.

Note: This focusing method is not recommended for microplates or 
when using a high magnification field of view (FOV A = 4.0 cm). In these 
situations, Manual or Subject Size focus methods are recommended.

Transillumination Setup

(IVIS Spectrum only)

Choose this option to display the transillumination setup window that 
enables you to select the locations for image acquisition using bottom 
illumination that originates beneath the stage.

Table A.3  Typical field of view (FOV) settings

FOV 
Setting IVIS Imaging System

Lumina Lumina XR 100 Series 200 Series Spectrum Kinetic

FOV (cm)

A 5 5 10 4 4 4

B 7.5 7.5 15 6.5 6.5 7

C 10 10 20 13 13 10

D 12.5 12.5a 25 22.5 (19.5)c 22.5 (19.5)c 12

E 24b N/A N/A 22.5 (26)c 22.5 (26)c 24b

Zd 2.6 2.6 N/A N/A N/A 2.6
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A.2  Manually Setting the Focus

The IVIS Imaging System automatically focuses the image based on subject height. If you 
do not want to use the automatic focus feature, you can manually set the focus.

1. In the control panel, choose Manual Focus in the Focus drop-down list.

The Manual Focus window appears.

2. To mark the center of the camera in the window, put a check mark next to Display 
CCD Center.

3. Select the size of the step increment that the stage moves: Coarse, Normal, or Fine.

4. Click Up or Down to move the stage and change the focus.

5. If necessary, select another F/stop setting from the drop-down list and adjust the light 
level using the  arrows.

6. Click Update to apply the settings.

The resulting focal plane (cm above the stage) is automatically entered in the Subject 
height box.

7. Click OK when the image is focused.

Figure A.2  Opening the Manual Focus window
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You can manage user IDs and specify defaults for some parameters that are associated 
with the user ID selected at the start of a new session. 

To view the user-modifiable preferences after you log on, select Edit → Preferences on 
the menu bar.

NOTE
Any changes made to the Preferences are implemented at the start of the next session. The 
Acquisition tab is only available in the Living Image software that controls the IVIS Imaging 
System.

Figure B.1  Preferences dialog box
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B.1  General Preferences

Figure B.2  General preferences

Table B.1  General preferences

Item Description
Start Up Defaults Dock Tool Palette - Choose this option to set the position of the Tool 

Palette in the application window. Choose left or right. 

Note: To undock the Tool Palette, click on the palette title bar and drag 
it a distance greater than its width. 

Window Size Specifies the dimensions of the main application window.

Width, Height - Sets the dimensions of the image window.

Restore Defaults - Click to apply the default settings.

Apply Individual Color 
Scale for Sequences

Choose this option to apply a separate color scale to each thumbnail of 
a sequence. If this option is not chosen, all of the thumbnails are 
displayed using the same color scale.

Show Transillumination 
Locations

Choose this option to display a cross hair at each transillumination 
location when you load transillumination data. When you mouse over a 
cross hair, a tool tip displays the transillumination coordinates. If this 
option is not chosen, you can choose the Transillumination Location 
option in the sequence view window to display the transillumination 
locations. 

Show Advanced 
Options

If this option is selected, advanced features are available in the menu bar 
and Tool Palette, including:

�• Additional ROI functionality for Auto ROI parameters

�• Additional export and import option for 3D surfaces and voxels

Show Activity Window 
on:

A drop-down list of options for when to display the activity log (Figure 
B.3).
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Some of the general preferences specify how the main application window is organized. 
To undock the Tool Palette, click on the palette title bar and drag it a distance greater than 
its width. To dock the Tool Palette in the main window, drag the palette to the right or left 
side of the window and release.

Save Settings Save float-corrected image - Saves an image after all corrections are 
applied (read bias subtraction, flat field correction, cosmic correction).

Color Selections - Applies the color settings of the active image data to 
subsequently opened image data.

Folder Locations - Sets the default folder path to the current folder path 
setting. Click the Export button  in the image window to view the 
current folder path setting (Figure B.3).

Window Size & Position - Applies the active image window size and 
position settings to subsequently opened image data.

Most Recently Used Dataset History - Applies the active image window 
size and position settings to subsequently opened image data.

Display ROI Label As 
Measurement

Sets the type of measurement in counts, radiance (photons), or 
efficiency to show in the ROI label

Figure B.3  Main application window

Table B.1  General preferences (continued)  

Item Description

Tool palette

Activity window
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B.2  User Preferences

Figure B.4  User preferences

Table B.2  User preferences

Item Description
User�’s Settings Existing User ID - The user ID displayed in the log on dialog box at startup

New User ID - Opens the Add New User box. A new user is added to the 
Existing User ID drop-down list.

Delete User ID - Deletes the user selected from the Existing User ID drop-
down list.

Preferences/Defaults Edit User label Choices - Opens a dialog box that enables you to edit the 
Living Image Universal label set

Default Units - Choose counts or radiance (photons) for image display.
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B.3  Acquisition

Figure B.5  Acquisition preferences, Auto Exposure

Table B.3  Auto exposure settings

Item Description
Luminescent/Fluorescent 
Auto Exposure Preferences

First Preference
Second Preference
Third Preference

During auto exposure, the software acquires a luminescent or 
fluorescent image so that the brightest pixel is approximately 
equal to the user-specified Target Count (Minimum). 

If the target minimum count cannot be closely approximated by 
adjusting the first preference (for example, exposure time), the 
software uses the first and second or first, second and third 
preferences to attempt to reach the target max count during image 
acquisition. 

Target Count (Minimum) A user-specified intensity. 

Range Values

Exp Time (sec)
Binning
F/Stop

The minimum and maximum values define the range of values for 
exposure time, F/Stop, or binning that the software can use to 
attempt to reach the target max count during image acquisition.

Restore Defaults Click to apply default settings.
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B.4 Theme

Figure B.6  Acquisition preferences, Camera Settings

Table B.4  Camera settings

Item Description
Default Image Exposure Sets the default exposure settings that appear in the IVIS acquisition 

control panel.

Default Image Binning Standard - Binning choices include Small, Medium and Large. These are 
predetermined, factory-loaded binning values that depend on the 
imaging system camera.  

Manual - Allows the user to choose a binning value (1,2,4,or 16)

Auto Save Specifies the folder where images are automatically saved. Click the  
button to select a folder.

Restore Defaults Click to apply the default settings.

Figure B.7  Image view preferences

Table B.5  Image view preferences

Item Description
Color Palette Use these controls to select a color table for luminescent and 

fluorescent image data. Choose the Reverse option to reverse the 
min/max colors of the selected color table.
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Use saved color palette 
while loading datasets

If this option is chosen, data are displayed using a user-specified color 
palette. For example, after you load data, specify a color table in the 
Image Adjust tools, and save the data. The user-specified color table 
is automatically applied whenever the data are loaded. 

Background & Text Color Sets the colors for the background and text in the image window 
shown here. To change a color, click the  button that opens the 
color palette.

ROI Color Sets the colors for the ROI outline. To change a color, click the  
button that opens the color palette.

Luminescent - Color of the ROI outline on a luminescent image.

Fluorescent - Color of the ROI outline on a fluorescent image.

Restore Defaults Click to apply the default settings.

Table B.5  Image view preferences (continued)  

Item Description
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Figure B.8  3D view preferences

Table B.6  3D view preferences

Item Description
Color Theme Predefined color schemes available for the 3D View window shown 

here. Click the  button to restore the defaults for the selected color 
theme.

Background Color Settings that modify the appearance of the background in the 3D View 
window.

Solid Color - Choose this option to apply a non-gradient background 
color to the 3D view in the image window.

Gradient Color - Choose this option to apply a gradient background color 
to the 3D view in the image window. Top = the color at the top of the 
window; Bottom = the color at the bottom of the window. 

Surface & Text Color Settings that modify the display of the surface and text in the 3D View 
window.

Color Palette Source voxels - Choose a color table for voxel display.

Reverse - Choose this option to reverse the min/max colors of the 
selected color table.

Restore Defaults Click to apply the default settings.
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B.5 Optical Properties

Figure B.9  Set the default optical properties preferences (left) for the 
Properties tab in the Planar Spectral Imaging, DLIT, or FLIT tools

Table B.7  Tissue properties preferences

Item Description
Tissue Properties Choose a default tissue type that is most representative of the 

area of interest. This tissue type will be used if a Subject Type 
is not selected in the Imaging Wizard and saved during 
acquisition. 

Source Spectrum Choose the default luminescent source. This Source Spectrum 
will be used if a Subject Type is not selected in the Imaging 
Wizard and saved during acquisition for DLIT sequences. 

Plot Tissue Properties - Choose this option to display a graph of the 
absorption coefficient (µa), effective attenuation coefficient 
(µeff), and reduced scattering coefficient (µ�’s or µsp).

Source Spectrum - Choose this option to display the source 
spectrum for DLIT reconstructions.

Bioluminescent Spectrum - Choose this option to display the 
spectrum of the bioluminescent source.

Fluorescent Spectrum - Choose this option to display the 
spectrum of the fluorescent source.

Restore Defaults Click to restore the defaults in the Optical Properties tab.
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The parameters that control the number of photons collected (signal) and the image 
background (noise) determine the sensitivity of low light imaging. To maximize 
sensitivity, the goal is to increase signal and decrease background

Several factors affect the number of photons collected, including the lens f/stop, image 
magnification, size and detection efficiency (quantum efficiency) of the CCD, transport 
efficiency of the imaging optics, and the image exposure time. 

C.1 CCD Detection Efficiency

IVIS Imaging Systems use a back-thinned, back-illuminated CCD cooled to -90° to -105° 
C (depending on the system). This type of CCD provides high quantum efficiency of over 
80% across the visible and near infrared part of the spectrum.

Figure C.1 shows detection efficiencies for several commonly used photon detectors. The 
back-illuminated CCD has the highest efficiency, particularly in the 600-800 nm region 
of the spectrum, the area of greatest interest for in vivo imaging. 

Lens Aperture

IVIS Imaging Systems are equipped with a high-light-collection f/1 lens. The sensitivity 
of the IVIS Imaging System can be adjusted by changing the f/stop setting that controls 
the lens aperture. The detected signal scales approximately as 1/(f/stop)2. For maximum 
sensitivity, select f/1, the largest aperture setting on the IVIS Imaging System (Figure 
C.2). This provides the greatest light collection efficiency, but results in the minimum 
depth of field for the image. The depth of field refers to the depth over which the image 
appears to be in focus and is determined by the f/stop and the field of view (FOV). 

At f/1, the depth of field ranges from ~0.2 cm at FOV= 3.9 cm (IVIS Imaging System 200 
Series only) to ~2 cm at FOV= 25 cm. You can use the manual focus option on the Control 

Figure C.1  Quantum efficiencies

Bialkali photocathode ())
Back-illuminated CCD (*)
Front-illuminated CCD (+). 

IVIS systems use back-illuminated CCDs.
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panel to easily assess the depth of field at any f/stop and FOV setting. For more details on 
manual focusing, see page 264. Generally f/1 is recommended for low light luminescent 
images and f/2 or f/4 is recommended for brighter luminescent or fluorescent images.

Image Exposure Time

The image exposure time also affects sensitivity. The number of photons collected is 
directly proportional to the image exposure time. For example, an image acquired over a 
two minute exposure contains twice as many detected photons as an image acquired over 
a one minute exposure. Longer exposure times are usually beneficial when imaging very 
dim samples. However, this may not always be true because some types of background, 
dark charge in particular, increase with exposure time. (For more details on backgrounds, 
see Appendix E, page 285.) An IVIS Imaging System has extremely low background that 
enables exposures of up to 30 minutes. However, animal anesthesia issues and luciferin 
kinetics limit practical exposure times for in vivo imaging to 5-10 minutes.

Field of View (FOV)

The FOV indirectly affects sensitivity. Changing the FOV without changing the binning 
or the f/stop does not significantly affect sensitivity. However, CCD pixels are effectively 
smaller at a smaller FOV (higher magnification) so that higher levels of binning can be 
applied without loss of spatial resolution. 

For example, an image acquired at binning=4 and FOV=20 cm has the same spatial 
resolution as an image acquired at binning=8 and FOV=10 cm. Due to the increase in 
binning, the latter image has a four-fold increase in sensitivity compared to the former. 

C.2 Binning

A charge coupled device (CCD) is a photosensitive detector constructed in a two-
dimensional array of pixels. After an image is acquired, each pixel contains an electrical 
charge that is proportional to the amount of light that the pixel was exposed to. The 
software measures the electrical charge of each CCD pixel and assigns a numerical value 
(counts). (For more details on counts and other measurement units, see Appendix D, 
page 279.) The resulting image data comprise a two-dimensional array of numbers; each 
pixel contains the counts associated with the amount of light detected. 

IVIS Imaging Systems are equipped with a CCD that ranges from 1024×1024 to 
2048×2048 pixels in size, and thus have a high degree of spatial resolution. At binning=1, 

Figure C.2  Lens f/stop positions.
Left: lens wide open at f/1; right: lens closed down at f/8.
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each pixel is read and the image size (number of pixels) is equal to the physical number 
of CCD pixels (Figure C.3).

At binning=2, four pixels that comprise a 2×2 group on the CCD are summed prior to read 
out and the total number of counts for the group is recorded (Figure C.3). This produces 
a smaller image that contains one fourth the pixels compared to an image at binning=1. 
However, due to summing, the average signal in each pixel is four times higher than at 
binning=1. At binning=4, 16 pixels are summed prior to read out.

Binning significantly affects the sensitivity of the IVIS Imaging System. Binning at 
higher levels (for example, ≥ 4) improves the signal-to-noise ratio for read noise, an 
electronic noise introduced into the pixel measurement at readout. If four pixels are 
summed before readout, the average signal in the summed pixel (super pixel) is four times 
higher than at binning=1. 

The read noise for the super pixel is about the same as it was for the individual pixels. 
Therefore, the signal-to-noise ratio for the read noise component of the image noise is 
improved by a factor of four. Read noise is often the dominant source of noise in in vivo 
images, so a high binning level is a very effective way to improve the signal-to-noise 
ratio.

Unfortunately, binning reduces the spatial resolution in an image. For example, at 
binning=2, a super pixel is twice as wide as a pixel at binning=1. This results in a factor 
of two loss in image spatial resolution. However, for in vivo imaging, the added sensitivity 
is usually more important than the spatial resolution. Further, since in vivo signals are 
often diffuse due to scattering in tissue, little is gained by increasing spatial resolution. 
(For more background on the propagation of light through tissue, see Diffusion Model of 
Light Propagation Through Tissue, page 310.) In such cases, high levels of binning may 
be appropriate (up to 10 or 16, depending on the CCD of the IVIS Imaging System). If 
signal levels are high enough that sensitivity is not an issue, then it is better to image at a 
lower binning level (two or four) in order to maintain a higher degree of spatial resolution. 

NOTE
For application-specific questions regarding the appropriate binning level, please contact 
Caliper Corporation.

The IVIS System Control panel provides several binning options. The actual binning 
numbers associated with these settings depends on the CCD chip and type of image (Table 
C.1). These choices should satisfy most user needs. However, if you want to manually 

Figure C.3  A small segment of the CCD.
At binning = 2, 4 pixels are summed together; at binning = 4, 16 pixels are summed.

Binning = 1

Signal 4 times larger.
Spatial size doubled.

CCD pixel

Binning = 2 Binning = 4

Signal 16 times larger.
Spatial size quadrupled.
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control binning, you can specify Manual Binning in the Living Image Tools-Preference-
Camera Settings box.

1 Some early IVIS 100 Systems with Spectral Instruments SITe cameras, and all Roper and Princeton 
Instrument cameras, are not supported in Windows 7/Living Image 4.2 software.

2 Default setting

You can also apply soft binning after an image is acquired. Conceptually, soft binning is 
the same as hardware binning groups of pixels are summed and a smaller, lower 
resolution image is produced. However, in soft binning the summing is performed 
digitally on the stored image data, not on the electronic charge before readout as in 
hardware binning. 

Although soft binning does not improve the signal-to-noise ratio for read noise, it may 
enhance the signal visibility because it reduces the statistical scatter of nearby pixel 
contents. Usually, hardware binning is preferred, but if it is not possible to take another 
image, applying soft binning to the data may provide a worthwhile solution.

C.3 Smoothing

Smoothing is a filtering method that reduces noise in the image data. To apply smoothing, 
the software replaces the intensity of each pixel with the average intensity of a nearby 
pixel neighborhood that includes the pixel. Figure C.4 shows a 3x3 pixel neighborhood. 

Smoothing does not change the pixel size and helps:

�• Eliminate outlier pixel values that are extremely high or low.

�• Reduce noise (fluctuations) in the image to help reveal small signals.

Table C.1  Binning settings

Binning IVIS® System
100/200/Spectrum1 Lumina Lumina XR Lumina Kinetic

Small (high-resolution) Lumin Bin 4 Bin 2 Bin 2 Bin 2

Medium Lumin2 Bin 8 Bin 4 Bin 4 Bin 4

Large (high-sensitivity) Lumin Bin 16 Bin 8 Bin 8 Bin 8

Small (high-resolution) Photo Bin 2 Bin 1 Bin 1 Bin 1

Medium Photo2 Bin 4 Bin 2 Bin 2 Bin 2

Figure C.4  3x3 pixel neighborhood

Center pixel value = the mean value of 
the nine pixels in the 3x3 neighborhood
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D.1 Image Data

Scientific Image Data

Scientific image data is a two-dimensional array of numbers. Each element of the array 
(pixel) is associated with a number that is proportional to the light intensity on the 
element. A charge coupled device (CCD) camera used for scientific imaging is essentially 
an array of photo-sensitive pixels and each pixel collects photons during an image 
exposure. 

The subsequent electronic readout provides a photon intensity number associated with 
each pixel. In a bright area of the image, more photons are detected and the photon 
intensity number is greater than the number in a dim area of the image.

The image data can be visualized in different ways, including pseudocolor images 
(generated by the Living Image software), contour plots, or isometric displays.

Graphic Image Data

A graphic image is a two-dimensional array of pixels with a color assigned to each pixel. 
There are several schemes for digitally storing the images. For example, a common 
scheme assigns a red-green-blue (RGB) color code to each pixel. The RGB code defines 
how much of each color to apply in order to create the final pixel color. Color photographs 
or color screenshots are examples of RGB images.

An RBG image is also a two-dimensional array of numbers, but unlike a scientific image, 
the numbers are only color codes and are not related to light intensity. A graphic image 
can be exported to a graphic display application.

Pseudocolor Images

An image can be generated from scientific image data by assigning a color to each 
numerical value and plotting the array so that each pixel is filled with the color that 
corresponds to its numerical value. A color table defines the relationship between the 
numerical data and the displayed color. For example, a grayscale color table assigns black 
to the smallest number in the array, white to the largest number, and shades of gray to the 
values in between (Figure D.1). The resulting image is equivalent to a black and white 
photograph. An illuminated photographic image acquired on an IVIS Imaging System is 
an example of a grayscale pseudoimage.

The reverse rainbow color table is also commonly used and assigns violet to the smallest 
number on the array, red to the largest number, and all of the spectral colors of the 
rainbow to the values in between (Figure D.1).
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A pseudocolor scheme is typically used to display the numerical contents of scientific 
image data like the luminescent or fluorescent images acquired on an IVIS Imaging 
System. The pseudocolor scheme makes it easy to see areas of bright light emission. The 
amount of light emission can be quantified using measurement ROIs. (For more details, 
page 120.)

Measurement data is independent of the colors displayed in the pseudocolor image. You 
can change the appearance of the image data without affecting the underlying numeric 
pixel values. For example, you apply a different color table to the data or adjust the range 
of numeric values associated with the color table. Measurements that quantify pixel data 
produce the same results independent of the appearance of the pseudocolor display. 

A pseudocolor image can be converted to an RGB color code and saved as an RGB image. 
The RGB image looks like a pseudocolor image, but does not include the numerical 
information derived from the light detected in each pixel. Therefore, the amount of light 
in an RGB image cannot be quantified.

Overlays

In the overlay display mode, the pseudocolor luminescent or fluorescent image is 
displayed over the associated grayscale photographic image (Figure D.1). Pixels in the 
luminescent or fluorescent image that are less than the minimum color table setting are 
not displayed. As a result, the lowest intensity color in the table is transparent and this 
enables you to view the underlying photographic image in regions where the luminescent 
light emission is low. While the pixels less than the minimum color table setting are not 
displayed, they still exist in the image data.

Figure D.1  Example pseudoimages

A photograph is a gray 
scale pseudoimage

Overlay mode: pseudocolor image of the 
luminescent data is overlaid on a photograph

Color table 
associated 
with the data
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D.2  Quantifying Image Data

The Living Image software can quantify and display scientific image data for several 
types of measurements. 

Counts

When image data is displayed in counts, the image pixel contents are displayed as the 
numerical output of the charge digitizer on the charge coupled device (CCD) (Figure D.2). 
The counts measurement (also known as analog digitizer units (ADU) or relative 
luminescence units (RLU)) is proportional to the number of photons detected in a pixel. 

Counts are uncalibrated units that represent the raw amplitude of the signal detected by 
the CCD camera. A signal measured in counts is related to the photons incident on the 
CCD camera. The signal varies, depending on the camera settings (for example, 
integration time, binning, f/stop, or field of view setting).

All IVIS Imaging Systems include a CCD digitizer that is a 16-bit device, which means 
that the signal count range is from zero to 65,535. Sometimes the displayed signal count 
may appear outside of this range due to corrections applied to the image data (for 
example, background corrections).

Table D.1  Data display units

Data Display Description Recommended For:
Counts An uncalibrated measurement of the 

photons incident on the CCD camera.
Image acquisition to ensure that 
the camera settings are properly 
adjusted. Proper image 
parameter adjustment should 
avoid image saturation and 
ensure sufficient signal (greater 
than a few hundred counts at 
maximum).

Radiance (photons) A calibrated measurement of the photon 
emission from the subject. Radiance is in 
units of "photons/second/cm2/steradian".

Luminescence measurements

Radiant Efficiency

(fluorescence)

Epi-fluorescence - A fluorescence 
emission radiance per incident excitation 
power.

Transillumination fluorescence - 
Fluorescence emission radiance per 
incident excitation power

Fluorescence measurements

Efficiency (epi-
fluorescence)

Fluorescent emission normalized to the 
incident excitation intensity (radiance of 
the subject/illumination intensity)

Epi-fluorescence measurements

NTF Efficiency Fluorescent emission image normalized 
to the transmission image which is 
measured with the same emission filter 
and open excitation filter.

Transillumination fluorescent 
measurements
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Radiance

When image data is displayed in radiance units ('photons' for short), the photon emission 
from the subject is displayed in photons/sec/cm2/sr. Counts are a relative measure of the 
photons incident on the CCD camera and radiance is in absolute physical units that 
measure the photon emission from the subject.

The radiance unit of photons/sec/cm2/sr is the number of photons per second that leave a 
square centimeter of tissue and radiate into a solid angle of one steradian (sr) (Figure D.3).

Figure D.2  ROI measurements (counts mode)

Select Counts, Photons, or 
Efficiency for the image data 

In counts mode, the ROI measurements table includes:

Total Counts �– Sum of all counts for all pixels inside the ROI

Average Counts �– Total Counts/Number of pixels or superpixels 

Quantity ROI Pixels �– Number of binned pixels inside the ROI

Area (CCD pixels) �– Number of unbinned CCD pixels inside the ROI

Figure D.3  Isotropic radiation 
Isotropic radiation from a cell is called photon flux (photons/sec). When cells occur in tissue, 
photon emission from the tissue surface is called surface radiance (photons/sec/cm2/sr).
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A steradian can be thought of as a three-dimensional cone of light emitted from the 
surface that has a unit solid angle. Much like a radian is a unit of arc length for a circle, 
a steradian is a unit of solid angle for a sphere. An entire sphere has 4π steradians. Lens 
systems typically collect light from only a small fraction of the total 4π steradians.

When image data is displayed in radiance mode, the units change to photons/sec/cm2/sr. 
These are units of photon radiance on the surface of the animal. A very important 
distinction between these absolute physical units and the relative units of counts is that 
the radiance units refer to photon emission from the subject animal itself, as opposed to 
counts that refers to a measurement of photons incident on the detector. 

Measurements in units of radiance automatically take into account camera settings (for 
example, integration time, binning, f/stop, and field of view). As a result, images of the 
same subject acquired during the same session have the same signal amplitude regardless 
of the camera settings because the radiance on the animal surface does not change. The 
advantage of working with image data in radiance mode is that camera settings can be 
changed during an experiment without having to adjust the images or the measured ROI 
data. Images or ROI data can be quantitatively compared across different IVIS Imaging 
Systems.

Caliper Life Sciences calibrates the CCD response and lens of each IVIS® Imaging System 
for all the emission wavelengths. The response of the CCD is relatively flat (~10%) over 
the range from 500-700 nm which includes the spectral variation found in bacterial or 
firefly luciferase. Therefore, calibration is accurate over this range. 

Efficiency

The fluorescent signal detected from a sample depends on the amount of fluorophore 
present in the sample and the intensity of the incident excitation light. The excitation light 
incident on the sample stage is not uniform over the field of view (FOV). The profiles for 
all stage locations peak near the center of the FOV. The illumination intensity profile 
varies by up to ±30% across the entire FOV (Figure D.4). 

Figure D.4  Illumination profiles at different FOVs 
Measurements were taken at the center of the FOV on the IVIS® Lumina Series.
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Displaying fluorescent image data in terms of efficiency eliminates the variable excitation 
light from the measurement and enables a more quantitative comparison of fluorescent 
signals. When you select efficiency for the image data (Figure D.2), the software 
normalizes the fluorescent emission image to a reference image and computes:

Efficiency = Radiance of the subject/Illumination intensity

Prior to instrument delivery, Caliper Life Sciences generates a reference image of the 
excitation light intensity (no emission filter) incident on a highly reflective white plate 
for each excitation filter at every FOV and lamp power. The data are stored in the Living 
Image folder.

Image efficiency data does not have units. The efficiency number for each pixel 
represents the fraction of fluorescent photons relative to each incident excitation photon 
and is typically in the range of 10-2 to 10-9. When ROI measurements are made, the total 
efficiency within the ROI is the efficiency per pixel integrated over the ROI area, so the 
resulting units of total efficiency is area or cm2.

D.3 Flat Fielding

Flat fielding refers to the uniformity of light collected across the field of view (FOV). A 
lens usually collects more light from the center of the FOV than at the edges. The Living 
Image software provides a correction algorithm to compensate for the variation in the 
collection efficiency of the lens. This enables uniform quantitation of ROI measurements 
across the entire FOV.

To apply the correction algorithm, choose the Flat Field Correction option in the 
Corrections/Filtering tools. The algorithm multiplies each pixel by a predetermined scale 
factor. The scale factor for each pixel depends on its distance from the center of the image. 
The scale factor near the center of the field of view is one, but can be up to two or three 
near the corners on the IVIS® Imaging Systems and Spectrum.

You may notice an increase in noise near the edges and corners of the FOV when flat field 
correction is applied�– this is normal.

D.4 Cosmic Ray Corrections

Cosmic rays are extraterrestrial high-energy particles that register a false signal on a CCD 
detector. Cosmic rays as well as other sources of ionizing radiation cause infrequent 
interactions (a few per minute) on the CCD. These interactions result in large signals that 
are usually isolated to a single pixel, making them easy to correct.

The Living Image software searches for isolated, high amplitude hot pixels and replaces 
them with a collective average of surrounding pixels. The Cosmic Correction option 
should always be selected for in vivo image data because hot pixels can significantly 
affect an ROI measurement. 

Cosmic ray correction is not recommended when imaging very small objects such as 
individual cells. An individual cell may only light up one or two pixels and can sometimes 
be misinterpreted as a cosmic ray. In this case, clear the Cosmic Correction option in the 
Corrections/Filtering tools to avoid filtering out single-cell images. 
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The background sources of light from luminescent images are inherently very low. This 
appendix discusses sources of background and how to manage them. Due to the extreme 
sensitivity of the IVIS Imaging System, residual electronic background (dark current) and 
luminescent emission from live animals (autoluminescence) are measurable and must be 
taken into account.

For information on fluorescent background, see Appendix F, page 299.

E.1 Electronic Background

The cooled CCD camera used in an IVIS Imaging System has electronic background that 
must be accurately measured and subtracted from the image data before the light intensity 
is quantified. Raw data that is not corrected for electronic background results in erroneous 
ROI measurements. Incorrect background subtraction may also result in serious errors. 
However, it is not necessary to subtract the electronic background when making a simple 
visual inspection of an image.

The types of electronic background include:

�• Read bias - An electronic offset that exists on every pixel. This means that the zero 
photon level in the readout is not actually zero, but is typically a few hundred counts 
per pixel. The read bias offset is reproducible within errors defined by the read 
noise, another quantity that must be determined for quantitative image analysis.

�• Dark current - Electronic background generated by the thermal production of charge 
in the CCD. To minimize dark current, the CCD is cooled during use. 

Read Bias & Drift

Prior to a luminescent image exposure, the Living Image software initiates a series of 
zero-time exposures (image readout) to determine a read bias measurement. 

If a dark charge background is available for the luminescent image, the average bias offset 
for the read bias image stored with the dark charge measurement is compared to the 
average bias offset determined with the read bias measurement made prior to the image. 
The difference, or drift correction, is stored with the luminescent image data, and is later 
used to correct minor drift (typically less than two counts/pixel) that may occur in the bias 
offset since measuring the dark charge background.

If a dark charge background is not available at the time of the luminescent image 
exposure, the software checks to see if the selected image parameters warrant a dark 
charge measurement (large binning and long exposure time). If a dark charge image is not 
required, the read bias will be used. If a dark charge is recommended, the software 
provides the option of using the read bias measurement instead. Since the read bias is by 
far the largest component of background, using a read bias measurement instead of a dark 
charge measurement is often acceptable. If read bias is used instead of a dark charge 
background, the read bias image is stored with the image data rather than the usual 
background information.
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If the amount of dark charge associated with an image is negligible, read bias subtraction 
is an adequate substitute for dark charge background subtraction. Dark charge increases 
with exposure time and is more significant at higher levels of binning. A good rule of 
thumb is that dark charge is negligible if:

τB2 < 1000

where τ is the exposure time (seconds) and B is the binning factor. 

Under these conditions, dark charge contributes less than 0.1 counts/pixel and may be 
ignored.

Dark Charge

Dark charge refers to all types of electronic background, including dark current and read 
bias. Dark charge is a function of the exposure time, binning level, and camera 
temperature. A dark charge measurement should be taken within 48 hours of image 
acquisition and the system should remain stable between dark charge measurement and 
image acquisition. If the power to the system or camera controller (a component of some 
IVIS Imaging Systems) has been cycled or if the camera temperature has changed, a new 
dark charge measurement should be taken.

The dark charge is measured with the camera shutter closed and is usually performed 
automatically overnight by the Living Image software. The software acquires a series of 
zero-time exposures to determine the bias offset and read noise, followed by three dark 
exposures. The dark charge measurement usually takes more than three times as long to 
complete as the equivalent luminescent exposure.

E.2 Background Light On the Sample

An underlying assumption for in vivo imaging is that all of the light detected during a 
luminescent image exposure is emitted by the sample. This is not accurate if there is an 
external light source illuminating the sample. Any reflected light will be detected and is 
indistinguishable from emission from the sample.

The best way to deal with external light is to physically eliminate it. There are two 
potential sources of external light: a light leak through a crack or other mechanical 
imperfection in the imaging chamber or a source of external illumination. 

IVIS Imaging Systems are designed to be extremely light tight and are thoroughly 
checked for light leaks before and after installation. Light leaks are unlikely unless 
mechanical damage has occurred. To ensure that there are no light leaks in the imaging 
chamber, conduct an imaging test using the High Reflectance Hemisphere (Figure E.1). 

A more subtle source of external illumination is the possible presence of light emitting 
materials inside the imaging chamber. In addition to obvious sources such as the light 
emitting diodes (LEDs) of electronic equipment, some materials contain phosphorescent 
compounds.

NOTE
Do not place equipment that contains LEDs in the imaging chamber.

Phosphorescence is a physical process similar to fluorescence, but the light emission 
persists for a longer period. Phosphorescent materials absorb light from an external source 
(for example, room lights) and then re-emit it. Some phosphorescent materials may re-
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emit light for many hours. If this type of material is introduced into the imaging chamber, 
it produces background light even after the chamber door is closed. If the light emitted 
from the phosphorescent material illuminates the sample from outside of the field of view 
during imaging, it may be extremely difficult to distinguish from the light emitted by the 
sample.

IVIS Imaging Systems are designed to eliminate background interference from these 
types of materials. Each system is put through a rigorous quality control process to ensure 
that background levels are acceptably low. However, if you introduce such materials 
inadvertently, problems may arise. 

Problematic materials include plastics, paints, organic compounds, plastic tape, and 
plastic containers. Contaminants such as animal urine can be phosphorescent. To help 
maintain a clean imaging chamber, place animal subjects on black paper (for example, 
Artagain black paper, Strathmore cat. no. 445-109) and change the paper frequently. 
Cleaning the imaging chamber frequently is also helpful. 

IMPORTANT!
ALERT!  Use only cleaning agents approved by Caliper. Many cleaning compounds 
phosphoresce! Contact Caliper technical support for a list of tested and approved cleaning 
compounds.

If it is necessary to introduce suspect materials into the imaging chamber, screen the 
materials by imaging them. Acquire an image of the material alone using the same settings 
(for example, FOV and exposure time) that will be used to image the sample to determine 
if the material is visible in the luminescent image.

Microplates (white, black, or clear plastic) can be screened this way. Screen all three 
types with a test image. White plates appear extremely bright by IVIS Imaging System 
standards and interfere with measurements. Black or clear plastic microplates do not 
phosphoresce, making them better choices.

The High Reflectance Hemisphere provides a more definitive way to determine the 
presence of an undesirable light source (Figure E.1). It is a small white hemisphere that 
is coated with a non-phosphorescent material. A long exposure image of the hemisphere 
should produce a luminescent image in which the hemisphere is not visible. 

If any part of the hemisphere exhibits what appears to be luminescent emission, it is 
actually the light reflected from a source illuminating the hemisphere. Observe the side 
of the hemisphere that is illuminated to help determine the source location.

Figure E.1   High Reflectance Hemisphere and a plastic marker pen
Left: Photographic image. Right: Photograph with luminescent overlay. The 
hemisphere is illuminated by phosphorescence emitted from the pen.
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In Figure E.1, the pen appears very bright due to phosphorescent emission that is also 
illuminating the portion of the hemisphere next to the pen. If the pen had been outside the 
field of view, it would not have been imaged, and the source of the phosphorescence 
would be less obvious. However, the illumination of the hemisphere would still be very 
apparent and indicative of a light pollution problem.

IMPORTANT!
ALERT!  Handle the High Reflectance Hemisphere by its black base plate while wearing 
cotton gloves provided by Caliper. Skin oils can phosphoresce and will contaminate the 
hemisphere. Latex gloves and the powder on them may also phosphoresce. If the 
hemisphere becomes contaminated, contact Caliper technical support for a replacement. 
There are no known agents that can clean the hemisphere. To check the hemisphere for 
contamination, take several images of the hemisphere, rotating it slightly between images. A 
glowing fingerprint, for example, will rotate with the hemisphere, while a glowing spot due to 
external illumination most likely will not.

E.3 Background Light From the Sample

Another source of background is the natural light emitted from a sample that is not due to 
emission from the source of interest in the sample. This type of background may be due 
to a material associated with the experimental setup. For example, the cell culture medium 
may phosphoresce. Materials should be screened so you can identify and eliminate 
problematic materials. If a background source is phosphorescent and the phosphorescent 
lifetime is relatively short, you can try keeping the sample in the dark for a long period 
before imaging to reduce background light emission.

Occasionally there is no way to eliminate the natural light emission of the sample. The 
natural light emission associated with living animals (autoluminescence) is a major area 
of interest in in vivo luminescent imaging. Most animals exhibit a low level of 
autoluminescence. Usually this is only a problem when looking for very low signals at the 
highest levels of sensitivity.

Caliper has conducted tests to try to minimize the source of the background light emission 
in mice.

The sources of autoluminescence are not yet fully understood. No external sources have 
been proven to cause natural light emissions, so it is possible that a chemiluminescent 
process associated with metabolic activity in living animals is the source of animal 
background. This is supported by the observation that the level of background light drops 
significantly in euthanized animals.

In Figure E.2, the background light emission is clearly visible in the images of a control 
white-furred mouse and a nude mouse. The images are five minute, high-sensitivity (high 
binning) exposures. The average emission from a white-furred mouse and a nude mouse 
is approximately 1600 photons/s/cm2/sr and 1000 photons/s/cm2/sr, respectively. Since 

Test Description Observation
Test 1: Subject animals were housed in 
the dark 12 hours prior to imaging.

Background emission levels were not reduced. A 
phosphorescent component in mouse fur or skin is not 
the source of light emission.

Test 2: White-furred animals were 
shaved prior to imaging

No increase or decrease in background emission levels.

Test 3: Alfalfa (known to be 
phosphorescent) was eliminated from 
the animal diet.

An alfalfa-free diet reduced background emission 
slightly, but not significantly.
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these values are well above the lower limit of detection of the IVIS Imaging System (~100 
photons/s/cm2/sr), the background light emission from the mouse determines the limit of 
detection. 

An approximation of this background (determined by making similar measurements on 
either control animals or regions of the subject animal that do not contain the primary 
signal) can be subtracted from ROI measurements. (For more information on ROI 
measurements, see Chapter 8, page 130.) 

Note that the background light emission is not uniform over the entire animal. In Figure 
E.2, images of control animals (mice) show a somewhat higher background component 
originating from the abdominal and thoracic regions. Therefore, care must be taken when 
selecting a representative background area.

Usually only very low signals at the highest level of sensitivity require this type of 
background subtraction. For more information on how best to handle these types of 
measurements, please contact Caliper technical support. 

Figure E.2  Background light emission
Background light emission from a female white furred (Swiss Webster) (left) 
and a female nude (Nu/nu) mouse (right). 

Photograph Luminescent 
overlay

Photograph Luminesce
nt overlay
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F.1 Description and Theory of Operation

System Components

The IVIS® Spectrum, IVIS 200 Series Imaging System, and IVIS Lumina offer built-in 
fluorescence imaging capability as standard equipment (Figure F.1, Figure F.2, Figure 
F.3). The IVIS Imaging System 100 and 50 Series use the XFO-6 or XFO-12 Fluorescence 
Option to perform fluorescence imaging. The fluorescence equipment enables you to 
conveniently change between luminescent and fluorescent imaging applications . For 
more details, see the appropriate hardware manual:

�• IVIS Spectrum System Manual

�• IVIS Imaging System 200 Series System Manual

�• IVIS Lumina System Manual

�• XFO-6 or XFO-12 Fluorescence Option Manual

 

Figure F.1  IVIS Spectrum

Transillumination manifold
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A 150-watt quartz tungsten halogen (QTH) lamp with a dichroic reflector provides light 
for fluorescence excitation. The relative spectral radiance output of the lamp/reflector 
combination provides high emission throughout the 400-950 nm wavelength range 
(Figure F.4). The dichroic reflector reduces infrared coupling (>700 nm) to prevent 
overheating of the fiber-optic bundles, but allows sufficient infrared light throughput to 
enable imaging at these wavelengths. The Living Image software controls the illumination 

Figure F.2  IVIS Imaging System 200 Series

Figure F.3  IVIS Imaging System Lumina, Lumina 100 Series, and Lumina 50 Series
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intensity level (off, low, or high). The illumination intensity at the low setting is 
approximately 18% that of the high setting. 

The lamp output is delivered to the excitation filter wheel assembly located at the back of 
the IVIS Imaging System (Figure F.5). Light from the input fiber-optic bundle passes 
through a collimating lens followed by a 25 mm diameter excitation filter. The IVIS 
Imaging System provides a 12-position excitation filter wheel, allowing you to select 
from up to 11 fluorescent filters (five filters on older systems). A light block is provided 
in one filter slot for use during luminescent imaging to prevent external light from 
entering the imaging chamber. The Living Image software manages the motor control of 
the excitation filter wheel.

Following the excitation filter, a second lens focuses light into a 0.25 inch fused silica 
fiber-optic bundle inside the imaging chamber. Fused silica fibers (core and clad), unlike 
ordinary glass fibers, prevent the generation of autofluorescence.

The fused silica fiber bundle splits into four separate bundles that deliver filtered light to 
four reflectors in the ceiling of the imaging chamber (Figure F.1). The reflectors provide 
a diffuse and relatively uniform illumination of the sample stage. Analyzing image data 
in terms of efficiency corrects for nonuniformity in the illumination profile. When the 
efficiency mode is selected, the measured fluorescent image is normalized to a reference 
illumination image. (For more details on efficiency, see page 283.)

The IVIS Spectrum provides both transmission and epi-illumination. Emitted light from 
the excitation filter wheel feeds through a fiber optic bundle to illuminate the specimen 

Figure F.4  Relative spectral radiance output for the quartz halogen lamp with 
dichroic reflector.

Figure F.5  Excitation filter wheel cross section
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from either the top, in epi-illumination (reflectance) mode, or from underneath the stage, 
by means of an automated bundle switch. Transilluminating the subject from below at 
precise x,y-locations allows for transmission imaging, enabling more sensitive detection 
and accurate quantification of deep sources. Transmission fluorescence imaging also 
reduces the effects of autofluorescence. A computer-controlled imaging switch allows 
you to change between the two imaging modes (using IVIS Acquisition Control Panel or 
the Imaging Wizard). 

The emission filter wheel at the top of the imaging chamber collects the fluorescent 
emission from the target fluorophore and focuses it into the CCD camera. All IVIS 
Imaging Systems require that one filter position on each wheel always be open for 
luminescent imaging.

F.2 Filter Spectra

High quality filters are essential for obtaining good signal-to-background levels 
(contrast) in fluorescence measurements, particularly in highly sensitive instruments such 
as the IVIS Imaging Systems. Figure F.6 shows typical excitation and emission 
fluorophore spectra, along with idealized excitation and emission filter transmission 
curves. The excitation and emission filters are called bandpass filters. Ideally, bandpass 
filters transmit all of the wavelengths within the bandpass region and block (absorb or 
reflect) all wavelengths outside the bandpass region. This spectral band is like a window, 
characterized by its central wavelength and its width at 50% peak transmission, or full 
width half maximum. Figure F.7 shows filter transmission curves of a more realistic 
nature.

Because the filters are not ideal, some leakage (undesirable light not blocked by the filter 
but detected by the camera) may occur outside the bandpass region. The materials used in 
filter construction may also cause the filters to autofluoresce. 

IVIS Imaging System Number of Emission Filter Wheel 
Positions

Number of Available 
Fluorescence Filters

Spectrum 24 (two levels, each with 12 positions) 22 (60 mm diameter)

Lumina 8 7 (4 sets of 7 high resolution 
filter wheels or a wheel with 4 
standard filters)

100 or 50 6 5 (75 mm diameter)
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In Figure F.7, the vertical axis is optical density, defined as OD = -log(T), where T is the 
transmission. An OD=0 indicates 100% transmission and OD=7 indicates a reduction of 
the transmission to 10-7. 

For the high quality interference filters in the IVIS Imaging Systems, transmission in the 
bandpass region is about 0.7 (OD=0.15) and blocking outside of the bandpass region is 
typically in the OD=7 to OD=9 range. The band gap is defined as the gap between the 50% 
transmission points of the excitation and emission filters and is usually 25-50 nm.

There is a slope in the transition region from bandpass to blocking (Figure F.7). A steep 
slope is required to avoid overlap between the two filters. Typically, the slope is steeper 
at shorter wavelengths (400-500 nm), allowing the use of narrow band gaps of 25 nm. The 
slope is less steep at infrared wavelengths (800 nm), so a wider gap of up to 50 nm is 
necessary to avoid cross talk.

Figure F.6  Typical excitation and emission spectra for a fluorescent compound.
The graph shows two idealized bandpass filters that are appropriate for this fluorescent 
compound.

Figure F.7  Typical attenuation curves for excitation 
and emission filters
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Fluorescent Filters and Imaging Wavelengths

The IVIS® Spectrum excitation and emission filters enable spectral scanning over the blue 
to NIR wavelength region and include:

�• 10 narrow band excitation filters: 415 nm �– 760 nm (30 nm bandwidth)

�• 18 narrow band emission filters: 490 nm �– 850 nm (20 nm bandwidth)

Eight excitation and four emission filters come standard with a fluorescence-equipped 
IVIS Imaging System (Table F.1). Custom filter sets are also available. Fluorescent 
imaging on the IVIS Imaging System uses a wavelength range from 400-950 nm, enabling 
a wide range of fluorescent dyes and proteins for fluorescent applications. 

For in vivo applications, it is important to note that wavelengths greater than 600 nm are preferred. At 
wavelengths less than 600 nm, animal tissue absorbs significant amounts of light. This limits the 
depth to which light can penetrate. For example, fluorophores located deeper than a few millimeters 
are not excited. The autofluorescent signal of tissue also increases at wavelengths less than 600 nm. 

Figure F.8  IVIS Spectrum excitation and emission filters

Table F.1  Standard filter sets and fluorescent dyes and proteins used with IVIS Imaging Systems

Name Excitation Passband 
(nm)

Emission Passband 
(nm) Dyes & Passband

GFP 445-490 515-575 GFP, EGFP, FITC

DsRed 500-550 575-650 DsRed2-1, PKH26, CellTracker  Orange

Cy5.5 615-665w 695-770 Cy5.5, Alexa Fluor® 660, Alexa Fluor® 
680

ICG 710-760 810-875 Indocyanine green (ICG)

GFP Background 410-440 Uses same as GFP GFP, EGFP, FITC

DsRed Background 460-490 Uses same as DsRed DsRed2-1, PKH26, CellTracker�™ Orange
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F.3 Working with Fluorescent Samples

There are a number of issues to consider when working with fluorescent samples, 
including the position of the subject on the stage, leakage and autofluorescence, 
background signals, and appropriate signal levels and f/stop settings. 

Tissue Optics Effects

In in vivo fluorescence imaging, the excitation light must be delivered to the fluorophore 
inside the animal for the fluorescent process to begin. Once the excitation light is 
absorbed by the fluorophore, the fluorescence is emitted. However, due to the optical 
characteristics of tissue, the excitation light is scattered and absorbed before it reaches the 
fluorophore as well as after it leaves the fluorophore and is detected at the animal surface 
(Figure F.9). 

The excitation light also causes the tissue to autofluoresce. The amount of 
autofluorescence depends on the intensity and wavelength of the excitation source and the 
type of tissue. Autofluorescence can occur throughout the animal, but is strongest at the 
surface where the excitation light is strongest. 

At 600-900 nm, light transmission through tissue is highest and the generation of 
autofluorescence is lower. Therefore it is important to select fluorophores that are active 
in the 600-900 nm range. Fluorophores such as GFP that are active in the 450-600 nm 
range will still work, but the depth of detection may be limited to within several 
millimeters of the surface.

Specifying Signal Levels and f/stop Settings

Fluorescent signals are usually brighter than luminescent signals, so imaging times are shorter, 
typically from one to 30 seconds. The bright signal enables a lower binning level that produces 
better spatial resolution. Further, the f/stop can often be set to higher values; f/2 or f/4 is 

Cy5.5 Background 580-610 Uses same as Cy5.5 Cy5.5, Alexa Fluor® 660, Alexa Fluor® 
680

ICG Background 665-695 Uses same as ICG Indocyanine green (ICG)

Table F.1  Standard filter sets and fluorescent dyes and proteins used with IVIS Imaging Systems

Name Excitation Passband 
(nm)

Emission Passband 
(nm) Dyes & Passband

Figure F.9  Illustration of the in vivo fluorescence process
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recommended for fluorescence imaging. A higher f/stop improves the depth of field, yielding a 
sharper image. For more details on the f/stop, see Lens Aperture, page 275.

F.4 Image Data Display

Fluorescent image data can be displayed in:

�• Counts

�• Radiance (photons)

�• Radiant efficiency (Efficiency/Illumination Power)

�• Efficiency (calibrated, normalized)

�•
For more details, see Quantifying Image Data, page 281. 

If the image is displayed in any units other than counts, you can compare images with 
different exposure times, f/stop setting, or binning level. When an image is displayed in 
terms of efficiency, the fluorescent image is normalized against a stored reference image 
of the excitation light intensity. Efficiency image data is without units and represents the 
ratio of emitted light to incident light. For more details on efficiency, see page 283.

Fluorescent Efficiency and Radiant Efficiency

The detected fluorescent signal depends on the amount of fluorophore present in the 
sample and the intensity of the incident excitation light. At the sample stage, the incident 
excitation light is not uniform over the FOV. It peaks at the center of the FOV and drops 
of slowly toward the edges (Figure F.10). To eliminate the excitation light as a variable 
from the measurement, the data can be displayed in terms of efficiency (Figure F.11). 

Figure F.10  Illumination profiles for different FOVs on an IVIS® Lumina 
measured from the center of the FOV
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When Radiant Efficiency is selected, the fluorescent image data is normalized (divided) by a 
stored, calibrated reference image of the excitation light intensity incident on a highly reflective 
white plate. The resulting image data is without units, typically in the range of 10-2 to 10-9.

NOTE
On each IVIS Imaging System, a reference image of the excitation light intensity is measured 
for each excitation filter at every FOV and lamp power. The reference images are measured 
and stored in the Living Image folder prior to instrument delivery.

F.5 Fluorescent Background

Autofluorescence

Autofluorescence is a fluorescent signal that originates from substances other than the 
fluorophore of interest and is a source of background. Almost every substance emits some 
level of autofluorescence. Autofluorescence may be generated by the system optics, 
plastic materials such as microplates, and by animal tissue. Filter leakage, which may also 
occur, is another source of background light.

The optical components of the IVIS Imaging Systems are carefully chosen to minimize 
autofluorescence. Pure fused silica is used for all transmissive optics and fiber optics to 
reduce autofluorescence. However, trace background emissions exist and set a lower limit 
for fluorescence detection. 

To distinguish real signals from background emission, it is important to recognize the 
different types of autofluorescence. The following examples illustrate sources of 
autofluorescence, including microplates, other materials, and animal tissue.

Figure F.11  Fluorescent image data displayed in terms of radiant efficiency

Choose Radiant Efficiency to 
enable a more quantitative 
comparison of fluorescent 
signals
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Microplate Autofluorescence

When imaging cultured cells marked with a fluorophore, be aware that there is 
autofluorescence from the microplate as well as native autofluorescence of the cell.

Figure F.12 shows autofluorescence originating from four different plastic microplates. 
The images were taken using a GFP filter set (excitation 445-490nm, emission 515-
575nm).

Two types of autofluorescent effects may occur:

Overall glow of the material - Usually indicates the presence of autofluorescence.

Hot spots - Indicates a specular reflection of the illumination source (Figure F.13). The 
specular reflection is an optical illumination autofluorescence signal reflecting from 
the microplate surface and is not dependent on the microplate material.

Figure F.12  Examples of microplate autofluorescence emission
The black polystyrene plate emits the smallest signal while the white polystyrene 
plate emits the largest signal. (Imaging parameters: GFP filter set, Fluorescence level 
Low, Binning=8, FOV=15, f/1, Exp=4sec.)

Figure F.13  Specular reflection.
The four symmetric hot spots on this black polystyrene well plate illustrate the 
specular reflection of the illumination source. (Imaging parameters: GFP filter 
set, Fluorescence level Low, Binning=8, FOV=15, f/1, Exp=4sec.)

White polystyrene Clear polypropylene

Clear polystyrene Black polystyrene
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Black polystyrene microplates are recommended for in vitro fluorescent measurements. 
Figure F.12 and Figure F.13 show that the black polystyrene microplate emits the smallest 
inherent fluorescent signal, while the white polystyrene microplate emits the largest 
signal. The clear polystyrene microplate has an autofluorescent signal that is slightly 
higher than that of the black microplate, but it is still low enough that this type of 
microplate may be used. 

Control cells are always recommended in any experiment to assess the autofluorescence 
of the native cell.

Miscellaneous Material Autofluorescence

It is recommended that you place a black Lexan® sheet (Caliper part no. 60104) on the 
imaging stage to prevent illumination reflections and to help keep the stage clean. If you 
are working in transillumination mode, do not use the black Lexan sheet; it will block the 
signal.

NOTE
The black paper recommended for luminescent imaging (Swathmore, Artagain, Black, 
9"x12", Caliper part no. 445-109) has a measurable autofluorescent signal, particularly with 
the Cy5.5 filter set.

Figure F.14 shows a fluorescent image of a sheet of black Lexan on the sample stage, as 
seen through a GFP filter set. The image includes optical autofluorescence, light leakage, 
and low level autofluorescence from inside the IVIS® System imaging chamber. The ring-
like structure is a typical background autofluorescence/leakage pattern. The image 
represents the minimum background level that a fluorophore signal of interest must 
exceed in order to be detected.

Other laboratory accessories may exhibit non-negligible autofluorescence. The chart in 
Figure F.15 compares the autofluorescence of miscellaneous laboratory materials to that 
of black Lexan. For example, the autofluorescence of the agar plate with ampicillin is 
more than 180 times that of black Lexan. Such a significant difference in autofluorescence 
levels further supports the recommended use of black polystyrene well plates. 

Figure F.14  Light from black Lexan 
This image shows the typical ring-like structure of light from a sheet of black Lexan, a low 
autofluorescent material that may be placed on the imaging stage to prevent illumination 
reflections. (Imaging parameters: GFP filter set, Fluorescence level High, Binning=16, 
FOV=18.6, f/2, Exp=5sec.)
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NOTE
It is recommended that you take control measurements to characterize all materials used in 
the IVIS Imaging System.

Despite the presence of various background sources, the signal from most fluorophores 
exceeds background emissions. Figure F.16 shows the fluorescent signal from a 96-well 
microplate fluorescent reference standard (TR 613 Red) obtained from Precision 
Dynamics Co. Because the fluorescent signal is significantly bright, the background 
autofluorescent sources are not apparent.

Figure F.15  Comparison of autofluorescence of various laboratory materials to 
that of black Lexan

Figure F.16  96 well plate fluorescent reference standard (TR 613 Red)
The fluorescent signal is strong enough to exceed background emissions. (Imaging 
parameters: DsRed filter set, Fluorescence level Low, Binning=8, FOV=15, f/1, 
Exp=4sec.) Reference standard TR 613 Red is available through Precision 
Dynamics Co, http://www.pdcorp.com/healthcare/frs.html.
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Animal Tissue Autofluorescence

Animal tissue autofluorescence is generally much higher than any other background 
source discussed so far and is likely to be the limiting factor in in vivo fluorescent 
imaging. Figure F.17 shows ventral images of animal tissue autofluorescence for the GFP, 
DsRed, Cy5.5, and ICG filter set in animals fed regular rodent food and alfalfa-free rodent 
food (Harlan Teklad, TD97184). Animals fed the regular rodent diet and imaged using the 
GFP and DsRed filter sets, show uniform autofluorescence, while images taken with the 
Cy5.5 and ICG filter sets show the autofluorescence is concentrated in the intestinal area. 

The chlorophyll in the regular rodent food causes the autofluorescence in the intestinal 
area. When the animal diet is changed to the alfalfa-free rodent food, the autofluorescence 
in the intestinal area is reduced to the levels comparable to the rest of the body. In this 
situation, the best way to minimize autofluorescence is to change the animal diet to 
alfalfa-free rodent food when working with the Cy5.5 and ICG filter sets. Control animals 
should always be used to assess background autofluorescence.

Figure F.18 shows a comparison of fluorescence and luminescence emission in vivo. In 
this example, 3×106 PC3M-luc/DsRed prostate tumor cells were injected subcutaneously 
into the lower back region of the animal. The cell line is stably transfected with the firefly 
luciferase gene and the DsRed2-1 protein, enabling luminescent and fluorescent 
expression. The fluorescence signal level is 110 times brighter than the luminescence 
signal. However, the autofluorescent tissue emission is five orders of magnitude higher. 
In this example, fluorescent imaging requires at least 3.8×105 cells to obtain a signal 
above tissue autofluorescence while luminescent imaging requires only 400 cells.

Figure F.17  Images of animal tissue autofluorescence in control mice (Nu/nu females)
Animals were fed regular rodent food (top) or alfalfa-free rodent food (bottom). Images were 
taken using the GFP, DsRed, Cy5.5, or ICG filter set. The data is plotted in efficiency on the 
same log scale.



304  Living Image Software User’s Manual

NOTE
When you make ROI measurements on fluorescent images, it is important to subtract the 
autofluorescence background. For more details, see Subtracting Tissue Autofluorescence, 
page 153.

F.6 Subtracting Instrument Fluorescent Background

The fluorescence instrumentation on an IVIS Imaging System is carefully designed to 
minimize autofluorescence and background caused by instrumentation. However a 
residual background may be detected by the highly sensitive CCD camera. 
Autofluorescence of the system optics or the experimental setup, or residual light leakage 
through the filters can contribute to autofluorescence background. The Living Image 
software can measure and subtract the background from a fluorescence image.

Fluorescent background subtraction is similar to the dark charge bias subtraction that is 
implemented in luminescent mode. However, fluorescent background changes day-to-
day, depending on the experimental setup. Therefore, fluorescent background is not 
measured during the night, like dark charge background is.

After you acquire a fluorescent image, inspect the signal to determine if a fluorescent 
background should be subtracted (Figure F.19). If background subtraction is needed, 
remove the fluorescent subject from the imaging chamber and measure the fluorescent 
background (select Acquisition → Fluorescent Background → Measure Fluorescent 
Background on the menu bar). In the Living Image software, the Sub Fluor Bkg check 
box appears on the Control panel after a background has been acquired. You can toggle 
the background subtraction on and off using this check box.

NOTE
The fluorescence background also contains the read bias and dark charge. Dark charge 
subtraction is disabled if the Sub Fluor Bkg option is checked.

Figure F.18  Images of stably transfected, dual-tagged PC3M-luc DsRed cells. 
The images show the signal from a subcutaneous injection of 3x106 cells in an 11-week old 
male Nu/nu mouse.
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F.7 Adaptive Background Subtraction

Adaptive background subtraction is a simple way to reduce the "instrument fluorescent 
background" by fitting and removing the background using the existing image (for 
example, the left image in Figure F.19). 

Unlike the method described in section F.6, Subtracting Instrument Fluorescent 
Background, where you acquire an actual instrument fluorescent background image by 
removing the fluorescent subject from the imaging chamber to correct the background, the 
new method uses software correction. To perform adaptive background subtraction:

�• Identify the fluorescent subject in the original image using the photo mask

�• The software automatically fits the instrument background to the whole image using the 
pixels outside of the subject

�• The software subtracts the fitted instrument background from the original image

In most situations, such adaptive software correction works as effectively as the 
traditional method except the following cases:

�• The subject is dark, making it is difficult to mask the subject using the photo (for 
example, experiments that use black well plates)

�• The subject occupies most of the FOV (for example, high magnification or multiple 
mice in the FOV). As a result, there is not enough information outside the subject 
that can be used to help fit the background.

F.8 Subtracting Tissue Autofluorescence Using Background Filters

High levels of tissue autofluorescence can limit the sensitivity of detection of exogenous 
fluorophores, particularly in the visible wavelength range from 400 to 700 nm. Even in 
the near infrared range, there is still a low level of autofluorescence. Therefore, it is 
desirable to be able to subtract the tissue autofluorescence from a fluorescent 
measurement. 

The IVIS Imaging Systems implement a subtraction method based on the use of blue-
shifted background filters that emit light at a shorter wavelength. The objective of the 
background filters is to excite the tissue autofluorescence without exciting the 

Figure F.19  Comparison of dark charge bias subtraction (left) and fluorescent 
background subtraction (right). 
The autofluorescence from the nose cone and filter leakage have been minimized in the image 
on the right by using Sub Fluor Bkg option.
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fluorophore. The background filter image is subtracted from the primary excitation filter 
image using the Image Math tool and the appropriate scale factor, thus reducing the 
autofluorescence signal in the primary image data. (For more details, see Chapter 9, 
page 153.) The assumption here is that the tissue excitation spectrum is much broader than 
the excitation spectrum of the fluorophore of interest and that the spatial distribution of 
autofluorescence does not vary much with small shifts in the excitation wavelength.

Figure F.20 shows an example of this technique using a fluorescent marker. In this 
example, 1×106 HeLa-luc/PKH26 cells were subcutaneously implanted into the left flank 
of a 6-8 week old female Nu/nu mouse. Figure F.21 shows the spectrum for HeLa-luc/
PKH26 cells and the autofluorescent excitation spectrum of mouse tissue. It also shows 
the passbands for the background filter (DsRed Bkg), the primary excitation filter 
(DsRed), and the emission filter (DsRed). Figure F.20 shows the IVIS® images using the 
primary excitation filter, the background excitation filer, as well as the autofluorescent-
corrected image. 

The corrected image was obtained using a background scale factor of 1.4, determined by 
taking the ratio of the autofluorescent signals on the scruff of the animal. The numbers 
shown in the figures are the peak radiance of the animal background within the region of 
interest. In the corrected image, the RMS error is used to quantify the background. The 
signal-to-background ratio of the original fluorescent image (DsRed filter) is 6.5. The 
ratio increases to 150 in the corrected image, an improvement factor of 23. This 
improvement reduces the minimum number of cells necessary for detection from 1.5×105 
to 6.7×103. 

Figure F.20  Example of the autofluorescent subtraction technique using a background excitation 
filter.
a) primary excitation filter (DsRed), b) blue-shifted background excitation filter (DsRed Bkg), and c) corrected data. 
The corrected image was obtained by subtracting the scaled background filter image (multiplied by 0.47) from the 
primary filter image. The 6-week old female Nu/nu mouse was injected subcutaneously with 1×106 HeLa-luc/PKH26 
cells in the left flank.

Signal/Bkg = 6.5
Minimum no. of detected cells = 1.5 x 105

Signal/Bkg = 150
Minimum no. of detected cells = 6.7 x 103
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Figure F.21  Spectral data describing the autofluorescent subtraction technique 
using a background filter.
The graph shows the excitation and emission spectrum of PKH26 and the autofluorescent 
excitation spectrum of mouse tissue. Also included are the spectral passbands for the blue-
shifted background filter (DsRed Bkg), the primary excitation filter (DsRed), and the emission 
filter used with this dye.
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The unique spectral signatures of the luciferase emission spectrum and the optical 
properties of tissue enable the Living Image software to determine the depth and intensity 
of light sources inside a living animal. The planar spectral imaging algorithm relies on a 
diffusion model of light propagation in tissue and assumes a point source of light 
embedded in a flat surface approximation of the mouse. The algorithm is designed to 
provide a fast and robust method to approximate source location and brightness. The 
analysis requires two or more single-view images at wavelengths between 560 and 660 
nm.

The Diffuse Tomography (DLIT) algorithm is a more complete and accurate model. It 
analyzes images of surface light emission to produce a three-dimensional (3D) 
reconstruction of the luminescent light sources in a subject. For more details on DLIT 
analysis, see Chapter 14, page 191 and Appendix H, page 317.

G.1 Planar Spectral Imaging Theory

An image acquired on an IVIS Imaging System is a diffuse projection on the surface of 
the animal from the luminescent sources located deeper inside. Information about the 
depth of the luminescent cells can help quantify the source brightness and provide 
information on the location of the cells. 

The Living Image software uses spectroscopic information from a single-view image to 
estimate the depth of the luminescent cells. The method takes advantage of the fact that 
firefly luciferase bioluminescence is emitted from 500 to 700 nm, a region of the spectrum 
where there are major contrasts in tissue optical properties (Figure G.1).

In this portion of the spectrum, tissue absorption drops off dramatically between 500-580 
nm (green/yellow wavelengths) and 600-750 nm (red wavelengths), due mainly to the 
presence hemoglobin. As a result, the luminescent signal observed on the surface of the 
animal is dependent on both the wavelength and the thickness of the tissue through which 
it travels. 

The depth and absolute photon flux of a single point source can be determined from two 
or more images acquired at different wavelengths using relatively simple analytical 
expressions derived from the diffusion model of the propagation of light through tissue.
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Diffusion Model of Light Propagation Through Tissue

Light propagating through tissue undergoes scattering and absorption. The diffusion 
model assumes that scattering is the predominant phenomenon and the reduced scattering 
coefficient µ's >> absorption coefficient µa. This is valid mostly for wavelengths in the 
red and near infrared part of the spectrum. The model also assumes that the light is 
produced by a single point source and that the tissues are optically homogeneous. 

Under these conditions, if we model the animal surface as flat and infinite in extent and 
integrate the light that is collected over the animal surface, the total integrated intensity 
I(λ) is reduced to a relatively simple expression:

I(λ) = SK(λ) exp(-µeff d) (1)

where S is the absolute total photon flux emitted by the luminescent source and d is the 
source depth. 

The term µeff is the effective attenuation coefficient. It is determined by the tissue 
coefficient of absorption (µa) and reduced scattering (µ's) that quantify the two main 
phenomena light undergoes in tissue. 

The function K(λ) is a more complex expression that is derived from the model and 
includes terms that describe the effect of the tissue-air boundary on the light propagation. 
Both µeff and the function K are dependent on the wavelength, λ. 

Equation 1 shows that if the total integrated intensity (ROI measurement) is measured at 
several wavelengths, it is proportional to an exponential function of the product of the 
depth and the optical property, µeff. Therefore, the steps to planar spectral image analysis 
include:

�• Acquire two or more images at different wavelengths.

�• Measure the total integrated intensity on each image.

�• Fit the measured values to the exponential function of Equation 1. 

The results of the fit are the total flux of the luminescence source S and the source depth d.

Figure G.1  Optical Properties of Mouse Tissue and Firefly Luciferase Spectra
The luminescent signal from firefly luciferase (right) is emitted from wavelengths of 500-700 nm, 
which spans a region of the spectrum where there are major contrasts in the optical properties 
of mouse tissue (left). The firefly spectrum was measured at 37°C using PC3M cells.
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G.2 Optical Properties

Planar spectral image analysis requires prior knowledge of the tissue optical properties at 
the wavelength used at image acquisition. The two main optical parameters are the:

�• Absorption coefficient (µa) that defines the inverse of the mean path before photons 
are absorbed by the tissue.

�• Reduced scattering coefficient (µ's) that defines the inverse of the mean path before 
photons are scattered isotropically in the tissue. 

The effective attenuation coefficient (µeff) is a function of the absorption and reduced 
scattering coefficients:

µeff = (3µa (µ's + µa))1/2 (2)

Calculation of the function K in Equation 1 requires all three coefficients (µa, µ's, and µeff) 
as input. The function K includes a term called the effective reflection coefficient to 
account for the reflection of light at the air-tissue boundary due to a mismatch in the index 
of refraction. The tissue index of refraction is generally assumed to be close to 1.4.

The model assumes that the tissues are optically homogeneous and the Living Image 
software provides several factory set tissue optical property values to choose from.

G.3 Luciferase Spectrum

Analyzing spectrally filtered images requires knowledge of the spectral dependence of 
luminescent light emission. The luciferase luminescence spectrum was measured in vitro 
at 37° C and pH≈7 in various cell lines. This spectrum is used to normalize the photon 
flux values that the software measures at each wavelength. 

Source spectra for several reporters are included in the database, including firefly, click 
beetle, renilla, and bacteria (Figure G.1).

NOTE
The firefly luciferase spectrum is temperature and pH dependent. The luciferase spectra 
included in the software are only valid for measurements performed at 37° C and pH 7.0-7.5. 
If you use other temperature or pH conditions for an experiment, the associated luciferase 
spectral curve is required for planar spectral image analysis. For more information on the pH 
and temperature dependence of the luciferase spectrum, please contact Caliper Corporation.
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G.4  An Example of Planar Spectral Imaging

Melanoma cells were injected intravenously into the tail vein of nude mice. After 13 days, 
metastases developed in the lungs, kidney, and hind limb bone. An image sequence was 
acquired on the IVIS Imaging System 200 Series using filters at six wavelengths from 560 
to 660 nm, in 20 nm intervals. 

NOTE
When using the 560 nm and 580 nm band pass filters, tissue optics result in a larger 
attenuation of light (due mainly to hemoglobin absorption). A longer exposure time is 
recommended at these wavelengths.

Figure G.2 shows the metastasis sites. The signals from the lungs and right kidney are well 
defined in both animals. However, in the lower back area of the left mouse, the signals 
are in close proximity, causing an artifact in the planar spectral analysis.

To perform the planar spectral analysis, draw a measurement ROI that captures the entire 
signal of each site of interest without including a neighboring metastasis (Figure G.3).

After the ROI is defined, start the planar spectral analysis (for more details, see page 157). 
The software:

�• Measures the total flux inside the ROI on each filtered image. 

�• Normalizes the data to the luciferase spectrum (Plot of Intensity vs. Lambda, Figure 
G.4).

�• Fits the normalized data to the analytical expression in Equation 1, page 310 where 
S = absolute total photon flux emitted by the luminescence source and d = source 
depth (Plot of Linear Fit Results, Figure G.4)

Figure G.2  Metastatic sites in nude mice
Mice were imaged 13 days after a tail vein injection of 5x105 B16F10 melanoma cells. Imaging 
parameters: high sensitivity binning, f/stop=1, FOV = C (13 cm), exposure time = 120 seconds 
at 560 and 580 nm, exposure time = 60 seconds at all other wavelengths. This resulted in 
signals of ~2000 counts on each image.
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Figure G.3  Metastatic site 
ROI includes the signal of the right kidney and separates it from other metastatic sites. The 
signal coming from the lower back area is spread out due to the presence of two bright 
spots. The dimmer signal in the lower bottom right of the image likely originates from the 
femoral bone of the animal.

Figure G.4  Planar spectral analysis results

After the analysis is completed, 
click a button to display 
graphical results.
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To estimate the cell count, divide the absolute photon flux by the flux per cell. This is best 
determined by making independent in vitro measurements of the cell line used in the 
experiment.

The Plot of Linear Fit Results is weighted by the uncertainty of the measured images and 
takes into account the uncertainty in the determination of the optical properties. The 
precision of the method is largely determined by the known precision of the optical 
properties. In most cases, the relative uncertainty in the depth determination is equal to 
the relative uncertainty in the optical properties. 

An analysis of the dorsal and ventral views of the mouse left lung in Figure G.5 results 
in total flux values that are very similar. The measured depth values are also close, 
indicating that the cells are distributed about the same distance from the front and back of 
the animal. 

Figure G.5  Planar spectral analysis results
Top: Dorsal view of the left lung, bottom: ventral view of the left lung



Appendix G | Planar Spectral Imaging  315 

G.5  Optimizing the Precision of Planar Spectral Analysis

The accuracy of the planar spectral analysis is highly dependent on the quality of the:

�• Measured data for the firefly luciferase spectrum and the tissue optical properties.

�• Fit of the experimentally measured total flux at each wavelength to µeff (effective 
attentuation coefficient).

In general, more experimental values produce a better fit of the data. It is particularly 
important to be able to extract signals at all wavelengths to optimize the quality of the fit. 
If the software detects no signal above the animal background level at 560 nm and 580 
nm (the wavelengths that absorb the most light), the dynamic range of the optical 
properties is reduced and with it, the precision of the fit.

If a luminescent signal is dim or buried deep in the tissue, it may barely exceed the tissue 
autoluminescence at the shorter, more absorbing wavelengths (560 and 580 nm). In this 
case, it is recommended that you subtract the tissue autoluminescence from the image 
data. (For more details on subtracting tissue autoluminescence, see Appendix E, 
page 288). It is also recommended that you inspect all images in the sequence to confirm 
that the luminescent signal is greater than the tissue autoluminescence. If the luminescent 
signal does not exceed the tissue autoluminescence at a particular wavelength, do not 
include that wavelength in the analysis.
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Diffuse Luminescence Imaging Tomography (DLIT) is a technique that analyzes images 
of the surface light emission from a living subject to generate a three-dimensional (3D) 
reconstruction of luminescent light source distribution inside the subject. 

Fluorescence Imaging Tomography (FLIT) analyzes images of surface light emission to 
generate a 3D reconstruction of fluorescent light source distribution inside the subject.

NOTE
To reconstruct luminescent sources, the Living Image software requires a photograph, a 
structured light image, and luminescent images obtained at two or more wavelength filters 
spanning the luciferase emission spectrum (for example, firefly luciferase 560-660 nm). To 
reconstruct fluorescent sources, the software requires a structured light and fluorescent 
images obtained using the same excitation and emission filters at different transillumination 
source positions on the IVIS Spectrum.

To localize and quantify the light sources in a subject, the software:

�• Reconstructs the subject surface topography (surface) from structured light images. 
The surface is defined by a set of connected polygons or surface elements.

�• Maps the surface radiance (photons/s/cm2/steradian) to the photon density (photons/
mm3) just beneath the surface of each element of the surface. For NTF Efficiency 
data from normalized transmission fluorescence data, the NTF Efficiency 2D data is 
mapped to the 3D surface.

�• Divides the interior of the subject into a solid surface of volume elements or voxels. 
Each voxel is considered to contain a point light source at its center that contributes 
to the photon density at each surface element.

�• Defines equations that relate the source strength of each voxel to the measured data 
(photon density or NTF Efficiency) at each surface element.

�• Determines the optimum approximate solution to the system of linear equations to 
reconstruct the source strength in each voxel.

H.1 Determining Surface Topography

The software determines the surface topography from a structured light image. Parallel 
laser lines are projected onto the subject to produce a structured light image (Figure H.1). 

NOTE
If the Structure option is chosen in the Control panel, a structured light image is automatically 
acquired.
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The surface topography of the subject is determined by analyzing the displacement (∆x) 
or bending of the laser lines as they pass over the subject. The displacement is defined as 
the difference between where the line should fall on the stage in the absence of the subject 
and where it appears in the image due to occlusion by the subject.

The parallel lines are projected onto the surface of the subject at an angle (θ). The angle 
is known by instrument calibrations of the distance between the structured light projector 
and the optical axis (D) and the distance between the stage and the structured light 
projector (l) (Figure H.2). 

D and l form two perpendicular sides of a triangle giving:

tan θ = D/l

Together ∆x and h comprise a smaller version of this triangle. The height (h) can be 
determined from:

h = ∆x/tan θ

by measuring the displacement ∆x.

The software utilizes fast numerical methods to rapidly evaluate ∆x over the entire image 
to determine the surface topography. The surface topography determination is limited to 
the topside of the object facing the lens.

Figure H.1  Parallel laser lines projected onto a subject.
Given knowledge of the angle θ, the height of the subject (h) can be 
determined by analyzing the displacement,  ∆x, of the laser lines as 
they pass over the object.

Figure H.2  Structured light projector and subject
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H.2 Converting Light Emission to a Photon Density Map

The input data to the FLIT algorithm for 3D reconstruction of fluorescent light sources 
includes: 

�• A surface that defines the surface of the subject.

�• A sequence of images acquired at different transillumination source positions using 
the same excitation and emission filter at each position.Use the Imaging Wizard to 
acquire the images.

The input data to the DLIT algorithm for a 3D reconstruction of luminescent light sources 
includes:

�• A surface that defines the surface of the subject.

�• A sequence of two or more images of the light emission from the surface of the 
subject acquired at different filter bandwidths (Table H.1). Use the Imaging Wizard 
to acquire the images.

The IVIS Imaging System 200 Series and the IVIS Spectrum are absolutely calibrated so 
that the electron counts on each CCD pixel can be mapped back to the surface of the object 
to produce an absolute value of the surface radiance (photon/s/cm2/steradian) from each 
imaged surface element (Figure H.3).

The imaging system collects the light emitted from the surface element at an angle (θe) 
(measured with respect to the normal to the surface element) into the solid angle dΩ 
subtended by the entrance pupil. The value of the surface radiance L(θe) is directly related 
to the photon density ρ (photons/mm3) just inside the surface of the element. FLIT 
analysis uses NTF Efficiency data and takes into account the photon density of both the 
fluorescent image and transmission image.

Table H.1  IVIS System filters for luminescence and fluorescence tomography

IVIS Imaging System Filters Bandwidth
200 Series 6 emission filters, 550-670 nm 20 nm

Spectrum 10 excitation filters, 415-760 nm

18 emission filters, 490-850 nm

30 nm

20 nm

Figure H.3  Light emission from a surface element passes through 
the lens entrance pupil and is recorded in the image
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H.3  Defining the Linear Relationship Between a Source and Photon Density or NTF 
Efficiency

The software divides the interior of the subject into a solid mesh of volume elements 
(voxels). Each voxel is considered to contain a point light source at its center. The index 
i enumerates the set of voxels. Si is the value of the strength of the point source inside the 
ith voxel. The solid mesh defines a collection of point sources that approximate the actual 
source distribution. The accuracy of the approximation is improved by increasing the 
density of the solid mesh.

The reconstruction method is based on the principle that there is an approximately linear 
relationship between the source strength in each voxel (Si) and the photon density or NTF 
Efficiency (ρj) at each surface element described by a Green�’s function Gij. The photon 
density at the jth surface element is the sum of the contributions from all the voxels:

(1)

The Green's function contains information about the transport of photons through the 
tissue and the effects of the tissue-air boundary. By using a planar boundary 
approximation, the Green's function can be calculated analytically as a solution to the 
diffusion equation. Having an analytic expression for G allows Equation 1 to be computed 
very rapidly.

H.4 Determining the Best Approximate Solution to the Linear System

Once the Green's functions, Gij, are known, the goal is to solve Equation 1 for the source 
strength Si in each voxel. The DLIT and FLIT algorithms attempt to minimize χ2 
(Equation 2) while requiring that the source strength in each voxel is positive (Equation 
3).

(2)

(3)

A Non-Negative Least Squares algorithm is used to find the approximate solution which 
minimizes χ2. In order to reduce the number of variables in the problem, the code only 
uses surface elements with signal above a certain threshold and only keeps the voxels that 
contribute significantly to these surface elements.

H.5 Source & Tissue Properties

DLIT analysis of spectrally filtered images requires knowledge of the spectral 
dependence of luminescent light emission. Table H.2 shows the factory set source spectra 
provided by the software. 

NOTE
The source spectra is not an input to the 3D reconstruction of fluorescent sources.
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NOTE
The firefly luciferase spectrum is dependent on temperature and pH. The data provided are 
valid only for measurements performed at 37° C and at pH 7.0-7.5. Selecting other 
temperature and pH conditions for a specific experiment requires the use of the associated 
spectral curve for the spectral analysis. For more information about pH and temperature 
dependence of the luciferase spectrum, please contact Caliper Life Sciences technical 
support.

You can view tissue optical property values (µeff, µ�’s, µa) in the Tissue Properties drop-
down list. The tissue properties are plotted as a function of wavelength. Select the optical 
property descriptor most representative of the imaged subject. �“Mouse Tissue�” is a good 
choice for general reconstructions in vivo.

NOTE
Default tissue optical properties and source spectra are specified in the Preferences box. For 
more details, see Appendix B, page 273.

Figure H.4  DLIT 3D reconstruction tools, Properties tab

Table H.2  Source spectra 

Source Spectrum Description
Bacteria Bacterial luciferase

CB Green Click beetle green luciferase

CB Red Click beetle red luciferase

Firefly Firefly luciferase

hRenilla Sea pansy (Renilla reniformis) luciferase

Tritium Bead 5 Phosphor-coated glass bead containing tritium gas. 
Spectrum for bead #5.

XPM-2-LED LED in the XPM-2 mouse phantom.

Select Mouse Tissue or 
XPM-2 (mouse phantom) 
from the drop-down list. 

Select a luminescent 
source spectrum

Choose �“Source Spectrum�” 
from the Plot drop-down list to 
display the selected spectrum. 
This is required for DLIT.

Browse for a 3D 
Quantification Database 
For more details on the 
database, see page 185.
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The IVIS Syringe Injection system is designed for use with the IVIS Kinetic Imaging 
System. You can control the infusion pump in the Living Image software or manually. 

For more details on the setup and manual control of the infusion pump, see the IVIS 
Syringe Injection System instructions from Caliper or the PHD 22/2000 Syringe Pump 
Series User�’s manual from Harvard Apparatus. Both are included on the Living Image 
installation CDROM. 

The IVIS Syringe Injection system can be used during kinetic or still image acquisition; 
however, subjects must remain immobile.

I.1 Controlling the Infusion Pump

After the IVIS Kinetic Imaging System is initialized and locked, you can access the 
infusion pump controls.

1. Select Acquisition → Infusion Pump Setup on the menu bar.

�— The Infusion Pump control panel appears above the IVIS acquisition control panel.

NOTE
If you are going to acquire kinetic data, open the infusion pump control panel before you open 
the kinetic acquisition control panel. When the kinetic control panel is open, the Acquisition 
menu is unavailable.

2. Set the volume and flow rate. 

Figure I.1  Display the Infusion Pump control panel
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3. Make a selection from the Syringe Type drop-down list (the associated syringe 
diameter is automatically entered).

To enter a custom syringe:

a. Select Custom from the drop-down list.

b. Click OK in the dialog box that appears.

c. Enter the syringe diameter in the infusion pump control panel. 

NOTE
Custom syringe information that is entered in the infusion pump control panel is not 
saved to the system.

4. To automatically start the infusion pump after data acquisition begins, choose 
Auto Start After and enter the amount of seconds. For example, enter 10 to 
start infusion 10 seconds after acquisition begins.

To manually start infusion, click Start Now.

5. To automatically stop infusion, choose Auto Stop After Acquisition. To 
manually stop infusion at any time, click Stop Now.

If the auto stop option is not chosen and you do not manually stop the pump, 
the pump continues to run after acquisition ends until the specified infusion 
volume is reached.

NOTE
The information in the infusion pump control panel is saved in the click info file. 
During acquisition, if you start infusion, then manually stop and restart the infusion, 
only the last actual start and stop is saved to the click info file, not the start/stop 
settings in the panel.

Figure I.2  Volume & flow rate settings

Figure I.3  Confirmation message for a custom syringe
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I.2  Tracking Infusion in the Maximum vs. Time Graph

During kinetic acquisition, the blue shaded region in the Max vs. Time graph indicates the 
infusion period. During acquisition, if you start infusion, then manually stop and restart 
infusion, only the last actual start and stop is recorded in the Maximum vs. Time graph. 
The graph stops recording infusion when acquisition stops (even though the pump may 
not be stopped).

I.3 Closing the Infusion Pump Control Panel
1. Close the kinetic control panel.

2. Click Acquisition → Infusion Pump Setup on the menu bar.

�— The check mark is removed and the panel closes. 

Figure I.4  Tracking infusion
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Appendix J   Menu Commands, Tool Bar, & Shortcuts

Figure J.1  Living Image toolbar

Table J.1  Menu bar commands and toolbar buttons

Menu Bar Command Toolbar 
Button Description

File ' Open Displays the Open box so that you can select and open an image data file.

File ' Browse Displays the Browse For Folder box so that you can select and an image 
data folder. The selected folder is displayed in the Living Image Browser.

File ' Browse 3D Volumetric 
Data

Displays the Browse For Folder box so that you can select and a volumetric 
data folder (for example, DICOM format, TIF data). The selected folder is 
displayed in the 3D Browser.

File ' Save Saves (overwrites) the AnalyzedClickInfo text file to update the analysis 
parameters, but the original image data files are not altered.

File ' Save As Displays the Browse For Folder box so that you can specify a folder in 
which to save the image data. The original data is not overwritten.

File ' Import ' 3D Surface Opens a dialog box that enables you to import a surface. Note: This menu 
item is only available if �“Show Advanced Options�” is selected in the 
Preferences (see page 266).

File ' Import ' 3D Voxels Opens a dialog box that enables you to import a source volume. Note: This 
menu item is only available if �“Show Advanced Options�” is selected in the 
Preferences (see page 266).

File ' Import 'Organ Atlas Opens a dialog box that enables you to import an organ atlas (.iv, .dxf, .stl).

File ' Export ' Image/
Sequence as DICOM

Opens the Browse for Folder dialog box that enables you to export the 
active image data to DICOM format (.dcm).

File ' Export ' 3D Surface Opens a dialog box that enables you to save the 3D surface of the active 
data to a file such as Open Inventor format (.iv).

File ' Export ' 3D Voxels Opens a dialog box that enables you to save the voxels from the active data. 

File ' Export ' 3D Scene as 
DICOM

Opens a dialog box that enables you to save a 3D reconstruction and/or 
surface in DICOM format. The Multi-Frame DICOM option supports 3D CT 
reconstruction in third party software.

File ' Print Displays the Print box.

File ' Print Preview Displays the Print Preview box that shows what will be printed.

File ' Recent Files Shows recently opened data sets. Note: The number of files displayed can 
be set in the Preferences box (select Edit 'Preferences and click the 
General tab).

File' Exit Closes the Living Image software.

Edit ' Copy Copies the active image window to the system clipboard.

Edit ' Image Labels Opens the Edit Image Labels dialog box that enables you to edit the label 
set information for the active data.

Edit ' Preferences Opens the Preferences box.
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View ' Tool Bar Choose this option to display the toolbar.

View ' Status Bar Choose this option to display the status bar at the bottom of the main 
window.

View ' Tool Palette Choose this option to display the Tool Palette.

View ' Activity Window Displays the Activity window at the bottom of the main application window. 
The Activity window shows a log of the system activity.

View ' Image Information Displays the Image Information box that shows the label set and image 
acquisition information for the active data.

View ' ROI Properties Displays the ROI Properties dialog box.

View ' ROI Measurements Displays the ROI Measurements table.

View ' Volume Data Viewer Enables you to open and view DICOM data.

View ' Image Layout 
Window

Opens the Image Layout window that enables you to paste an image of the 
active data in the window. 

Tools ' 3D Animation Opens the 3D Animation window that enables you to view a preset 
animation or create an animation.

Tools ' Longitudinal Study Opens the Longitudinal Study window for side-by-side comparisons of DLIT 
or FLIT results.

Tools ' Well Plate 
Quantification for ...

Opens the Well Plate Quantification window.

Tools ' Image Overlay for... Opens the Image Overlay window for the active data.

Tools ' Colorize Opens the Colorized View tab for the active sequence.

Tools ' Image Math for... Opens the Image Math window for the active data.

Acquisition ' Background 
' Measure Dark Charge

Opens a dialog box that enables you to acquire a dark charge measurement.

Acquisition ' Background 
' Add or Replace Dark 
Charge

Opens a dialog box that enables you to select an instrument luminescent 
background. This background measurement is subtracted from 
luminescent images.

Acquisition ' Background 
' Measure and Replace Dark 
Charge

Measures the dark charge under the same conditions as the currently 
selected image. When the measurement is complete, the newly acquired 
dark charge image will be included in the dataset of the current image, 
replacing any existing dark charge image that may be present in the 
dataset.

Acquisition ' Background 
' View Available Dark 
Charge

Opens a dialog box that enables you to view the dark charge measurements 
for the system.

Acquisition ' Background 
' Clear Available Dark 
Charge

Clears all dark charge images from the system.

Acquisition ' Background 
' Auto Background Setup

Opens a dialog box that enables you to acquire background images, or 
schedule or disable automatic background acquisition.

Acquisition ' Fluorescent 
Background ' Measure 
Fluorescent Background

Starts a measurement of the instrument fluorescent background.

Acquisition ' Fluorescent 
Background ' Add or 
Replace Fluorescent 
Background

Opens a dialog box that enables you to select an instrument fluorescent 
background measurement for the active image data. If the �“Fluorescent 
Background�” Subtraction option is chosen in the Corrections/Filtering tool 
palette, the background measurement is subtracted from the image data.

Table J.1  Menu bar commands and toolbar buttons (continued)  

Menu Bar Command Toolbar 
Button Description
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Acquisition ' Fluorescent 
Background ' Measure and 
Replace Fluorescent 
Background

Measures fluorescent background under the same conditions as the 
currently selected image. When the measurement is complete, the newly 
acquired background image will be included in the data set of the current 
image, replacing any existing background image that may be present in the 
data set.

Acquisition ' Fluorescent 
Background ' View 
Available Fluorescent 
Background

Opens a dialog box that displays the fluorescent background 
measurements for the system. If a fluorescent background is selected, the 
�“Fluorescent Background Subtraction�” option appears in the Corrections/
Filtering tool palette. Choose the �“Fluorescent Background Subtraction�” 
option to subtract the user-specified background measurement from the 
image data.

Acquisition ' Fluorescent 
Background ' Clear 
Available Fluorescent 
Background

Opens a dialog box that enables you to remove the fluorescent background 
measurements from the system.

Acquisition ' Auto-Save If Auto-Save is selected, all images are automatically saved to a user-
selected folder.

Acquisition ' Auto-Save To Opens a dialog box that enables you to select a folder where images will 
be saved to automatically. 

Window ' Close Closes the active image window.

Window ' Close All Closes all image windows.

Window ' Cascade Organizes the open image windows in a cascade arrangement (see 
page 88).

Window ' Tile Organizes the open image windows in a tiled arrangement (see page 88).

Window ' 1. <Image or 
Sequence name>

Window ' 2. <Image or 
Sequence name>

Window ' etc.

A list of the open image windows. Click a window in the list to make it the 
active window (indicated by a check mark).

Window ' Other Windows 
' <window name>

Lists other windows that are open. For example, If the Living Image 
Browser is open, use these commands to make the browser the active 
window and display it on top of all other open windows.

Help ' User Guide Displays the Living Image User Manual.

Help ' License information Displays the license information.

Help ' Plug-in Information Displays a list of tool plug-ins and Tool Palette plug-ins.

Help ' IVIS Reagents Opens the Caliper LS web page for In Vivo Imaging Reagents.

Help ' About Living Image Displays information about the Living Image software and Caliper technical 
support contact information.

Click this button, then click an item in the user interface to display 
information about the item.

Table J.1  Menu bar commands and toolbar buttons (continued)  

Menu Bar Command Toolbar 
Button Description
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NOTE
Macintosh users use the Cmd key (apple key) instead of the Ctrl key.

Table J.2  Keyboard shortcuts

Keys Shortcut Description
Ctrl + B Opens the Living Image Browser.

Ctrl + C Copies the active image to the system clipboard.

Ctrl + D Arranges open windows in a cascade.

Ctrl + O Displays a dialog box that enables you to open data.

Ctrl + P Open the Print dialog box.

Ctrl + S Saves the active file or window.

Ctrl + T Tiles the open windows.

Ctrl + W Closes the active window.

Shift + F1 Changes the mouse pointer to the �“What�’s This�” tool . 

Click this button, then click an item in the user-interface to display information about the item.
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Index
Numerics
3D intensity signal 106
3D Multi-Modality tools

adjusting image resolution 254
classifying 3D volumetric data 250

color-opacity map 251
control points 252

fiducial registration 245
gradient illumination 255
loading data 241�–243
manual registration 247�–249
maximum intensity projection 255
requirements 239
volume display options 254

3D quantification database 185�–190
create 186�–189
manage results 189
samples 185

3D reconstruction
fluorescent sources 201�–203
luminescent sources 193�–200
reconstruct particular regions 199

3D reconstruction results
DLIT or FLIT 204�–205

3D surface 177�–183
3D tools 220�–236

Animate tab 231�–236
Registration 225�–231
Source tab 222�–224
Surface tab 220�–222

3D Volumetric Browser 241
3Dsurface

export or import 183
generate 178�–179
manage 182
view perspective 181�–182

A
accumulate signal 72, 73
acquire

image sequence using Imaging Wizard 33�–36
image sequence with X-ray images 54�–61
kinetic data 69
sequences in batch mode 39�–40
single fluorescent image (epi-illumination) 

25�–28
single fluorescent image (transillumination) 

28�–32
single luminescent image 21�–25
single X-ray image 49�–54

activity window 19
adaptive fluorescent background subtraction 305
adjusting image appearance 97
animation 231�–236

custom 234�–235
edit an animation setup 236
preset 233

animation tools 231�–236
auto exposure feature 19
autofluorescence 130, 299

miscellaneous material 301�–302
See tissue autofluorescence.
subtract using background filters 305�–307
well plate 300�–301

autoluminescence 130
automatically draw ROIs 127�–129
average background ROI 120, 130

B
background

adaptive fluorescent background subtraction 
305

fluorescent 299�–305
light on sample 286�–288
tissue autofluorescence 305�–307

background light
from sample 288�–289
on sample 286�–288

background-corrected signal 130�–132
band gap 295
bandpass filter 294
batch mode 39�–40
binning 100, 276�–278
browse optical image data 83�–87
browser

optical image data 86
volumetric data 241

C
Caliper Corporation

technical support 3
cascade images 88
classifying 3D volumetric data 250

control points 252
color table 279
colorize data 113�–114
color-opacity map 251
composite image 151�–153
control panel 19, 259�–263
conventions 2
copy
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ROI measurements 147
correction/filtering tools

binning 100
cosmic correction 100
dark background subtraction 99
flat field correction 100
smoothing 100

cosmic correction 100
cosmic ray corrections 284
counts 281
crop box 108

D
dark background subtraction 99
dark charge 286
dark current 285
data

graphic image 279
scientific image 279

Data Preview window 198�–200
detection efficiency 275
detection sensitivity

adjusting the lens aperture 275
exposure time 276
field of view 276

DICOM file
size limit 77

DICOM Viewer 219, 258
diffusion model 310
display units

counts 281
efficiency 283
photons 282

DLIT
sequence requirements 193

DLIT results 204�–205
manage 205

DLIT/FLIT troubleshooting 237
drift correction 285

E
edit image label 94
edit image sequence 116�–117
efficiency 283, 293, 298�–299
electronic background

dark charge 286
dark current 285
drift 285
read bias 285

EM gain 72
export

image data 47
surface 183

export image data 47
export images 114�–116
exposure time 276

F
f/stop 275, 276

fluorescent imaging 297
fiducial registration 245, 247�–249
field of view 276
filter

bandpass 294
fluorescent 296

filter spectra 294
flat field correction 100
flat fielding 284
FLIT

sequence requirements 201
FLIT results 204�–205

manage 205
fluorescence

adaptive background subtraction 305
reconstruct 3D sources 201�–203

fluorescence efficiency 298�–299
fluorescence imaging components 291�–294
fluorescent filters 296
fluorescent imaging

efficiency 293
f/stop 297
normalization 293
single image (epi-illumination) 25�–28

focus manually 264

G
gradient illumination 255
graphic image data 279

H
help 20
High Reflectance Hemisphere 287
high resolution imaging

kinetic imaging 74�–75
luminescent or fluorescent imaging 45�–46
X-ray imaging 63�–64

histogram 103

I
image

adjusting appearance 97
cascade 88
correct or filter 99�–100
correcting/filtering tools 99�–100
export 114�–116
histogram 103
information 93
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line profile 104
magnify or pan 98
measurements 107
pixel data 102
print 114�–116
tag 96
tile 88

image data
colorize 113�–114
export 47
open 87
save manually 46

image layout window 115�–116
image math 151�–153
image overlay tool 110�–112
image sequence

application-specific 10
create from individual images 117�–118
edit 116�–117
include X-ray images 54�–61
manual setup 41�–45

image window 89
imaging modes 7�–9
imaging system capabilities 10
Imaging Wizard 33�–36
import

organ atlas 230
surface 183

information about an image 93
infusion pump 323
infusion syringe injection system

control panel 324
infusion pump 323

initialization
See system initialization.

instrument fluorescent background
background

instrument fluorescent background 304
IVIS Imaging System

fluorescence imaging components 291�–294

K
kinetic

acquisition settings 71
acquisition window 70

kinetic data
acquire 69
save 77, 78
view and edit 75�–76

kinetic ROI
plot 134

kinetic ROI
draw 133

kinetic ROI
draw 132

L
lens aperture 275
line profile 104
Living Image browser 86
Living Image software

starting 15
Longitudinal Study window 213
luciferase spectrum 311
luminescence

reconstruct 3D sources 193�–200
luminescent imaging (single image) 21�–25

M
magnify image 98
manual

focusing 264
save data 46

manual conventions 2
manual sequence setup 41�–45
maximum intensity projection 255
maximum vs time graph

tracking infusion 325
maximum vs. time graph 70
measurement ROI

automatically draw 127�–129
measurement ROIs 120, 125�–129

free draw 129
measurements 107
measuring relative density 65�–67
menu commands 327
miscellaneous material autofluorescence 301�–302
Mouse Imaging Shuttle 245
multiple reporters per photograph 110�–112

N
normalization 293
NTF Efficiency 28, 146, 259, 281, 320

O
open image data 87
optical density 295
optical image data

browse 83�–87
optical properties for planar spectral imaging 311
organ atlas - import 230
organ display 226�–229
organ registration tools 225�–231
overlay 280
overlaying images 110�–112

P
pan image 98
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PCA biplot 176
PCA explained variance 175
photon density 207
photon density map

measured 208
simulated 208

photon density maps 207
photon radiance 283
photons 282
pixel 279
pixel data 102
planar spectral analysis

optimizing precision 315
planar spectral image analysis 157�–159
planar spectral imaging 309�–315

diffusion model 310
intensity graph 161
linear fit graph 161
luciferase spectrum 311
optical properties 311
sequence requirements 157
tools 159�–160

preferences 265�–273
print images 114�–116
pseudocolor image 279

Q
quantification database 185�–190

create 186�–189
manage results 189
samples 185

R
radiance

photon 283
radiance units 282
read bias 285
reconstruct 3D fluorescent sources 201�–203
reconstruct 3D luminescent sources 193�–200
reconstruct particular pixels 199
reduced Chi2 204
registering multi-modal data

fiducial registration 245
loading data 241�–243
manual registration 247�–249

ROI 119
3D signal 106
automatically draw 127�–129
background-corrected signal 130�–132
delete 143
edit dimensions 139
free draw 129
managing 135

manually draw 125�–126
measurement ROI

free draw 129
measurement ROIs 125�–129
Measurements table 122
move 138
move or edit label 142
quick guide 120
ROI line 141
save 142
subject 129
tools 123�–124

ROI (kinetic)
quick guide 132, 133

ROI Measurements table 145�–147
configure 147�–149
copy or export 149

ROI properties 135�–138
ROI types

average background 120, 130
measurement 120
subject 120

S
save

data manually 46
ROI 142

save
kinetic data 78

save
kinetic data 77

scientific image data 279
segment 43
sequence requirements

DLIT 193
FLIT 201
planar spectral imaging 157
spectral unmixing 165

smoothing 100, 278
software help 20
source depth 210
source spectrum 205
Spectra window 171�–172
spectral imaging

See planar spectral imaging.
spectral unmixing 165�–176

options 174�–175
parameters 173�–174
PCA biplot 176
PCA explained variance 175
results 169
sequence requirements 165

starting the software 15
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starting the system
See system initialization.

steradian 283
subject ROI 120, 129
surface 177�–183

export or import 183
generate 178�–179
manage 182
view perspective 181�–182

syringe injection system 323�–325
system

initialization 17
optics autofluorescence 304
temperature 18

system activity 19

T
tag an image 96
technical support 3
temperature 18
threshold angle 205
tile images 88
tissue autofluorescence 305�–307

eliminate by spectral unmixing 165�–176
subtracting with background filters 153�–156

tissue properties 205
tool palette 92

3D tools 220�–236
correcting/filtering 99�–100
ROI tools 123

toolbar 327
transillumination overview 109
troubleshooting DLIT/FLIT 237

U
units

See display units.
user activity 19
user preferences 265�–273

V
ventral imaging chamber 69
volume slices

information and results 257
volumetric data

classify 250, 252
color-opacity map 251
display options 254
information and results 257

voxel 320
vsize

starting 204

W
well plate autofluorescence 300�–301

X
X-ray

acquire image 49�–54
acquire sequence 54�–61

Z
Zoom Lens attachment 45�–46, 63�–64, 74�–75
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